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1
Before Using the 
Device

This chapter describes how to use this guide, as well as safety notes and legal notice you should read 
before using the Device.

Preface
Thank you for selecting the DocuCentre SC2020, referred to as the Device.

This guide describes how to operate the device and the precautions you should follow during operation. To 
get the most out of the device and to use it effectively, be sure to read this guide before use.

This guide assumes that you have a basic knowledge of the operating environment of the personal 
computer in use and networking environments. For information on the environment of the personal 
computer in use and the basic knowledge and operations of networking environments, refer to the 
manuals provided with the personal computer, operating system, and network system.

After reading this guide, be sure to keep it handy for quick reference. It will be useful in case you forget how 
to perform operations or if a problem occurs with the device.

Notes:

• When you use this device, we recommend that you change the system administrator's 
passcode immediately after installing the device.

• For more information on changing the passcode, refer to Executing Calibration on page 214.

Types of Manuals
The following guides are provided with the device.
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Before Using the Device
Accompanying Manuals

User Guide (Driver CD Kit)

The guide describes how to use the copy, print, fax and scan features as well as how to set the paper, 
perform everyday maintenance, make device status settings, perform troubleshooting, and set up a 
network. You can access this guide on the Driver CD Kit.

Basic Operation Guide

The guide describes a quick reference for the basic operations, daily maintenance, and problem solving for 
this device. You can access this guide on the Drive CD Kit.

• Manual (HTML)

The manual describes installation and configuration procedures for print drivers and the printer 
environment. This manual is included in the Driver CD Kit.

• Print Driver Help

The help describes print features and operations.

• Guides for Optional Components

Optional components are available for this device. Optional components come with an installation 
procedure guide that provides information on how to set up the product and other details.

Using This Guide
This guide is intended for first-time users of the device. It describes the basic operations for the copy, fax, 
scan, and print features.

Organization of This Guide

This guide consists of the following chapters:

• Before Using the Device: Describes how to use this guide and provides license information.

• Environment Settings: Describes the environment required to operate the device.

• Product Overview: Describes the names of the device parts as well as basic operations, such as how to 
turn the device on and off and how to use the Power Saver feature.

• Loading Paper: Describes the types of paper and other media that you can use on the device and how 
to load paper in a tray.

• Copy: Describes the basic operation and features of the copy feature.

• Fax: Describes the basic operations and features of the fax feature.

• Scan: Describes the basic operations and features of the scan feature.

• Print: Describes the basic printing operations.

• Tools: Describes how to change the default settings.
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Before Using the Device
• Machine Status: Describes how to check the faults that occurred in the device and to print various 
reports.

• Job Status: Describes how to check job status and how to delete jobs.

• Maintenance: Describes how to replace consumables and to clean the device.

• Problem Solving: Describes troubleshooting procedures to solve the problems with the device.

• Appendix: Describes the specifications of the device, optional accessories, and cautions/restrictions.

Conventions
• The screen shots and illustrations used in this guide vary depending on the device configuration and 

optional components installed. Some of the items in the screen shots may not be displayed or 
available depending on your device configuration.

• The procedures in this guide may vary depending on the driver and utility software being used due to 
the upgrades.

• In this guide, the term Computer refers to a personal computer or workstation.

• The following terms are used in this guide:

• The following symbols are used in this guide:

• Orientation of documents or paper is described in this guide as follows:

Important : Important information that you should read.

Note : Additional information on operations or features.

"            " : • A cross-reference included in this guide.

• Names of CD-ROM, features, and screen messages and input text.

[             ] : • Folders, files, applications, button or menu names displayed on the screen.

• Names of menus, commands, windows, or dialog boxes displayed on the 
computer screen and their buttons and menu names.

<            > button : • Hardware buttons on the control panel.

<            > key : • Keys on the keyboard of the computer.

> : • Path to a certain item within a procedure on the control panel.
For example: When you see the procedure "select [Tools] > [Default Settings] 
> [Copy]", this means that you need to select [Tools], select [Default 
Settings], and then select [Copy].

• Path to a certain item within a procedure on a computer.
For example: When you see the procedure "to search for files and folders, 
click [Start] > [Search] > [For Files or Folders]", this means that you need to 
click [Start], click [Search], and then click [For Files or Folders] to search for 
files and folders.

,Portrait (P) • Loading the document or paper in portrait orientation when viewed from 
the front of the device.

,Landscape (L) • Loading the document or paper in landscape orientation when viewed from 
the front of the device.
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Before Using the Device
Safety Notes
Before using this product, read the Safety Notes carefully for safety use.

This product and recommended supplies have been tested and found to comply with strict safety 
requirements including safety agency approvals and compliance with environmental standards. Follow the 
following instructions for safety use.

CAUTION: Any unauthorized alteration including an addition of new functions or connection to external 
devices may not be covered by the product warranty. Contact your local Xerox representative for more 
information.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

Used for item that if not followed strictly, can lead death or severe or fatal 
injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal injuries.

Used for items that if not followed strictly, can cause injuries to user or damages 
to device.

: A symbol for items to pay attention to when handling device. Follow 
instructions carefully to use device safely.

: A symbol for prohibited items. Follow instructions carefully to avoid any 
dangerous acts.

Portrait Orientation

feed direction

Landscape Orientation

feed direction

Caution Flammable Explosive Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Prohibited Do not expose 
to fire

Do not 
touch

Do not use 
in bathroom

Do not tear 
down

Keep away 
from liquid

Never touch 
with wet hand
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Before Using the Device
Electrical Safety
WARNINGS:

This product shall be operated by the power source as indicated on the product's data plate. Consult your 
local power company to check if your power source meets the requirements.

: A symbol for items that must be performed. Follow instructions carefully to 
carry out these essential tasks.

WARNING:  Connect this product to a protective earth circuit only.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an 
earthed electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an 
electrician to replace the outlet to avoid risk of electric shock. Never use an earthed adapter 
plug to connect the product to the electrical outlet that has no earth connection terminal.
Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult 
your local Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated 
ampere and voltage of this product. See the data plate on the rear panel of this product for its 
rated ampere and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring 
about minute electric current in a connector. It may generate heat and eventually cause a fire 
accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Xerox.
The power cord is exclusive use for this product. Do not use it for any other product.
Do not damage or alter the power cord. Damage and alteration may generate heat and 
eventually cause electric shock or a fire accident.
If the power cord is damaged or insulated wires are exposed, contact your local Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk 
of electric shock and a fire accident.

Instructions Unplug Ground to 
Earth
Xerox® DocuCentre® SC2020
User Guide

12



Before Using the Device
CAUTIONS:

Device Installation

WARNING:

CAUTIONS:

When cleaning this product, always switch off and unplug it. Access to a live device interior may 
cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live 
connector may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.

Switch off and unplug the product when it (i.e., fax function) is not used over weekends or long 
holidays.2/22/16Please note that it cannot receive fax message during switch-off.

Once a month, switch off this product and check if
• the power cord is plugged firmly into an electrical outlet;
• the plug is not excessively heated, rusted or bent;
• the plug and electrical outlet are free of dust; and
• the power cord is not cracked or worn down.
Once you notice any unusual condition, switch off and unplug this product first and contact 
your local Xerox representative.

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:
• Near radiators or any other heat sources
• Near volatile flammable materials such as curtains
• In the hot, humid, dusty or poorly ventilated environment
• In the place receiving direct sunlight
• Near cookers or humidifiers

Locate this product on a level and sturdy surface that can withstand a weight of 85 kg. 
Otherwise, if tilted, the product may fall over and cause injuries.
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Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the 
product.
Keep the minimum clearance as follows for ventilation and an access to the power plug. Unplug 
the product if an abnormal condition is noted.

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Xerox supplies. 
Otherwise, it may cause some defects.
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Others

To keep this product in a good performance and condition, always use it in the following 
environment:
Temperature: 10–32°C
Humidity: 15–85%
When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.
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Before Using the Device
Operational Safety
WARNINGS:

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in 
the documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To 
prevent electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product 
promptly in the following conditions, then contact your local Xerox representative.

• The product emits smoke or its surface is unusually hot.

• The product emits unusual noise or odor.

• The power cord is cracked or worn down.

• A circuit breaker, fuse or any other safety device becomes activated.

• Any liquid is spilled into the product.

• The product is soaked in water.

• Any part of the product is damaged.

Do not insert any object into slots or openings of this product.

Do not put any of the followings on the product:

• Liquid container such as flower vases or coffee cups

• Metal parts such as staples or clips

• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or 
a fire accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated 
paper. When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other 
cleaning materials may result in poor performance of the product. Never use aerosol cleaners to 
avoid catching fire and explosion.

If an optional Stand (Cabinet) is fitted, do not pull out two or more paper trays at a time. If 
somebody accidentally pushes the product with multiple trays open, it may incline and fall over. 
This may cause injuries. 2/22/16When you need to open paper trays, do it one after the other.

If you need to pull out a tray to remove paper jam, contact your local Xerox representative. Do 
not pull out a tray, otherwise it may cause injuries.

When you play the CD-ROM or DVD that is supplied with the product, always use said media-
enabled device. Otherwise, large sound may damage its speakers or your ears.
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User Guide

16



Before Using the Device
CAUTIONS:

Always follow all warning instructions marked on or supplied with this product. To avoid the risk 
of burn injuries and electric shock, never touch the areas marked with High Temperature or 
High Voltage.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause 
injuries or electric shock.

Do not attempt to remove any paper deeply jammed inside the product, particularly paper 
wrapped around the fuser or the heat roller. Otherwise, it may cause injuries or burns. Switch off 
the product immediately and contact your local Xerox representative.

Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.

To move this product to another location, contact your local Xerox representative.

Ventilate well during extended operation or mass copying. It may affect the office air 
environment due to odor such as ozone in a poorly ventilated room. 
Provide proper ventilation to ensure the comfortable and safe environment.
Xerox® DocuCentre® SC2020
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Consumables
WARNINGS:

CAUTIONS:

Location of Warning and Caution Labels

Store all consumables in accordance with the instructions given on its package or container.

Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge 
or toner bottle.
It may catch fire by electric sparks inside a vacuum cleaner and cause explosion.
Use a broom or a wet cloth to wipe off spill. If you spill a large volume of toner, contact your 
local Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch 
fire and cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Xerox representative for 
its disposal.

Never throw a waste toner bottle into an open flame. Toner may catch fire and cause burn 
injuries or explosion.
If you have a used waste toner bottle no longer needed, contact your local Xerox representative 
for its disposal.

Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water 
and consult a physician immediately.

When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be 
careful not to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and 
mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.
If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes 
until irritation is gone. Consult a physician if necessary.
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately. 

Always follow all warning instructions marked on or supplied with this product. To avoid the risk 
of burn injuries and electric shock, never touch the areas marked with High Temperature or 
High Voltage.
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Regulation

Radio Frequency Emissions (Class A)

This product has been tested and found to comply with the limits for a class A digital device, pursuant to 
International Standard for Electromagnetic Interference (CISPR Publ. 22) and Radio communication Act 
1992 in Australia/New Zealand. These limits are designed to provide reasonable protection against 
harmful interference when the product is operated in a commercial environment. This product generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
customer documentation, may cause harmful interference to radio communications. Operation of this 
product in a residential area is likely to cause harmful interference in which case the user is required to 
correct the interference at their own expense.

Changes and modifications to this product not specifically approved by Xerox may void the user's 
authority to operate this equipment.
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Environment
• For environmental protection and efficient use of resources, Xerox reuses returned toner cartridges, 

waste toner bottles and drum cartridges to make recycle parts, recycle materials or energy recovery.

• Proper disposal is required for toner cartridges, waste toner bottles and drum cartridges no longer 
needed. Do not open toner cartridges, waste toner bottles and drum cartridges. Return them to your 
local Xerox representative.

About License
This section describes information about licenses. Be sure to read through it.

JPEG Code

Our printer software uses some of the codes defined by the Independent JPEG Group.

Libcurl

COPYRIGHT AND PERMISSION NOTICE

Copyright© 1996–2006, Daniel Stenberg, <daniel@haxx.se>.

All rights reserved.

Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby 
granted, provided that the above copyright notice and this permission notice appear in all copies.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or 
otherwise to promote the sale, use or other dealings in this Software without prior written authorization of 
the copyright holder.

FreeBSD

This product contains the part of FreeBSD codes.

The FreeBSD Copyright 

Copyright 1994-2006 The FreeBSD Project. All rights reserved. 
Xerox® DocuCentre® SC2020
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Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

THIS SOFTWARE IS PROVIDED BY THE FREEBSD PROJECT "AS IS" AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FREEBSD 
PROJECT OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The views and conclusions contained in the software and documentation are those of the authors and 
should not be interpreted as representing official policies, either expressed or implied, of the FreeBSD 
Project.

WIDE DHCP Client

WIDE Project DHCP Implementation, Copyright© 1995 Akihiro Tominaga. Copyright© 1995 WIDE Project, 
All rights reserved.

Permission to use, copy, modify and distribute this software and its documentation is hereby granted, 
provided only with the following conditions are satisfied:

1. Both the copyright notice and this permission notice appear in all copies of the software, derivative 
works or modified versions, and any portions thereof, and that both notices appear in supporting 
documentation.

2. All advertising materials mentioning features or use of this software must display the following 
acknowledgment: 

This product includes software developed by WIDE Project and its contributors.

3. Neither the name of WIDE Project nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE DEVELOPER ''AS IS'' AND WIDE PROJECT DISCLAIMS ANY 
LIABILITY OF ANY KIND FOR ANY DAMAGES WHATSOEVER RESULTING FROM THE USE OF THIS 
SOFTWARE. ALSO, THERE IS NO WARRANTY IMPLIED OR OTHERWISE, NOR IS SUPPORT PROVIDED.

Feedback of the results generated from any improvements or extensions made to this software would be 
much appreciated.

Any such feedback should be sent to:

Akihiro Tominaga
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WIDE Project

Keio University, Endo 5322, Kanagawa, Japan

(Email: dhcp-dist@wide.ad.jp)

WIDE project has the rights to redistribute these changes.

MD5

Copyright© 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

License to copy and use this software is granted provided that it is identified as the RSA Data Security, Inc. 
MD5 Message-Digest Algorithm in all material mentioning or referencing this software or this function.

License is also granted to make and use derivative works provided that such works are identified as derived 
from the RSA Data Security, Inc. MD5 Message-Digest Algorithm in all material mentioning or referencing 
the derived work.

RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or 
the suitability of this software for any particular purpose.

It is provided as is without express or implied warranty of any kind.

These notices must be retained in any copies of any part of this documentation and/or software.

ICC Profile Header

Copyright© 1994-1996 SunSoft, Inc. Rights Reserved

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish distribute, sub-license, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following 
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions 
of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NON-INFRINGEMENT. IN NO EVENT SHALL SUNSOFT, INC. OR ITS PARENT 
COMPANY BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE 
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of SunSoft, Inc. shall not be used in advertising or otherwise to 
promote the sale, use or other dealings in this Software without written authorization from SunSoft Inc.
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JPEG Library

Independent JPEG Group's free JPEG software

This package contains C software to implement JPEG image encoding, decoding, and trans-coding. JPEG is 
a standardized compression method for full-color and gray-scale images.

The distributed programs provide conversion between JPEG "JFIF" format and image files in PBMPLUS 
PPM/PGM, GIF, BMP, and Targa file formats. The core compression and decompression library can easily be 
reused in other programs, such as image viewers. The package is highly portable C code; we have tested it 
on many devices ranging from PCs to Crays.

We are releasing this software for both noncommercial and commercial use. Companies are welcome to 
use it as the basis for JPEG-related products. We do not ask a royalty, although we do ask for an 
acknowledgement in product literature (see the README file in the distribution for details). We hope to 
make this software industrial-quality --- although, as with anything that's free, we offer no warranty and 
accept no liability. For more information, contact jpeg-info@jpegclub.org.

Contents of this directory

jpegsrc.vN.tar.gz contains source code, documentation, and test files for release N in Unix format. 
jpegsrN.zip contains source code, documentation, and test files for release N in Windows format. 
jpegaltui.vN.tar.gz contains source code for an alternate user interface for cjpeg/djpeg in Unix format. 
jpegaltuiN.zip contains source code for an alternate user interface for cjpeg/djpeg in Windows format. 
wallace.ps.gz is a PostScript file of Greg Wallace's introductory article about JPEG. This is an update of the 
article that appeared in the April 1991 Communications of the ACM. jpeg.documents.gz tells where to 
obtain the JPEG standard and documents about JPEG-related file formats. jfif.ps.gz is a PostScript file of 
the JFIF (JPEG File Interchange Format) format specification. jfif.txt.gz is a plain text transcription of the 
JFIF specification; it's missing a figure, so use the PostScript version if you can. TIFFTechNote2.txt.gz is a 
draft of the proposed revisions to TIFF 6.0's JPEG support. pm.errata.gz is the errata list for the first 
printing of the textbook "JPEG Still Image Data Compression Standard" by Pennebaker and Mitchell.

jdosaobj.zip contains pre-assembled object files for JMEMDOSA.ASM. If you want to compile the IJG code 
for MS-DOS, but don't have an assembler, these files may be helpful.

Math Library

Copyright© 1993 by Sun Microsystems, Inc. All rights reserved Developed at SunPro, a Sun Microsystems, 
Inc. business. Permission to use, copy, modify, and distribute this software is freely granted, provided that 
this notice is preserved.

• copysignf.c: * Copyright© 1993 by Sun Microsystems, Inc. All rights reserved. 

• math_private.h: * Copyright© 1993 by Sun Microsystems, Inc. All rights reserved. 

• powf.c: * Copyright© 1993 by Sun Microsystems, Inc. All rights reserved. 

• scalbnf.c: * Copyright© 1993 by Sun Microsystems, Inc. All rights reserved.
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Legal Notice
Copying or printing certain documents may be illegal in your country. Penalties of fines or imprisonment 
may be imposed on those found guilty. The following are examples of items that may be illegal to copy or 
print in your country. 

• Currency

• Banknotes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, 
contact your legal counsel.
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2
Environment 
Settings

This chapter describes the device operating environment.

Note: For information on optional components required to make some settings in this chapter, contact 
our Customer Support Center.

Supported Environment
This section describes the environment settings needed to use the device print, scan, and fax features.

Print Feature

The device can be connected directly to a computer for use as a local printer, or can be connected to a 
network for use as a network printer.

• Use as a Local Printer

Connect the device to a computer with a USB cable.

• Use as a Network Printer

Print from network-connected computers using the TCP/IP protocol.

To use the device as a network printer, you need to activate the port to use for printing.

– LPD: Activate this setting when using the LPD port.

– Port9100: Activate this setting when using the Port9100 port.

Network Connection 
LPD/Port9100

Local Connection 
USB
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Environment Settings
For information on how to set TCP/IP, refer to Setting the Network Environment on page 30.

For information on how to activate a communication port, refer to Activating the Communication Port To 
Use on page 36.

Scan Feature

The device supports the following Scan functions:

Using the USB connection

Scan with PC application

Uses the USB connection to import scan data in a computer. To use this function, install the scan driver 
from the Driver CD Kit CD-ROM.

Note: To install the scan driver, follow the instructions provided in the manual (HTML file) included on 
the CD-ROM. For details, refer to Scanning to a Computer on page 128.

Using the Network connection

Scan to Email

Uses the SMTP protocol to send the document scanned by the device as an Email attachment. For 
information on how to use this feature, refer to Sending an Email With the Scanned File on page 143.

Scan to PC (Network)

Uses the FTP or SMB protocol to save the document scanned by the device in a common folder created on 
a network PC. For information on how to use this feature, refer to Using a Scanner on the Network on 
page 131.

Fax Feature

The device supports the following communication networks for fax transmissions:

• Public switched telephone network (PSTN)

• Private branch exchanges (PBX)

You must also make settings in [Region] and [Date & Time] to use the Fax functions on this device.
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Additionally, in most regions, you are required by law to indicate your fax number on any fax you send.

Notes:

• This option is available when the Fax Kit (optional) is installed.

• For information on how to make the region setting, refer to Region on page 165.

• For information on how to make the date and time settings, refer to Date & Time on 
page 175.

• For information on how to make the fax number settings, refer to Fax Number on page 165.

Interface Cables
When connecting the device directly to a computer, use a USB interface. When connecting the device to a 
network, use an Ethernet interface. 

Using the USB Interface

The device supports the USB 2.0 interface.

To connect the USB interface:

1. Press the power switch to the [ ] position to turn the power OFF.

Note: Ensure that the display is turned off.

2. Connect a USB cable to the USB port.

3. Connect the other end of the USB cable to the computer.
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4. Press the power switch to the [ | ] position to turn the power ON.

Using the Ethernet Interface

The device supports 100BASE-TX and 10BASE-T Ethernet interfaces. 

To connect the Ethernet interface:

1. Press the power switch to the [ ] position to turn the power OFF. 

Note: Ensure that the display is turned off.

2. Connect a network cable to the Ethernet port.

Note: Prepare a network cable suitable for your network connection. When you replace the network 
cable, contact our Customer Support Center.
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3. Press the power switch to the [ | ] position to turn the power ON.

Setting the Network Environment

This section describes how to make the settings needed to use the TCP/IP protocol.

Note: The device supports IPv6 addresses in an IPv6 network environment. For more information, refer 
to Setting the Device IP Address (IPv6) on page 32.

Configuration on the Device
• IP addresses are managed for the entire system. Configure the settings only after consulting your 

network administrator.

• The setting of subnet mask and gateway addresses may be required depending on the network 
environment. Consult your network administrator and configure the required settings.

Configuration on the Computer
• IP addresses are managed for the entire system. Configure the settings only after consulting your 

network administrator.

• When setting the network such as IP addresses with a host used under the Network Information 
Service (NIS), consult your NIS administrator.

Setting the Device IP Address (IPv4)

To use the TCP/IP protocol, you must set the device's IP address. By default, the device is set to obtain its IP 
address automatically.

This setting automatically sets the device IP address when the device is connected to a network containing 
a DHCP server.

Print the System Settings Report to check whether the device IP address has already been set.

You can also check the IP address in the following methods:

• On the message field of the touch screen

• On the [About This MFP] screen
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• Using CentreWare Internet Services

Notes:

• For information on how to print the System Settings Report, refer to Printing Reports/Lists on 
page 232.

• For information on the message field of the touch screen, refer to Touch Screen - Services 
Home Screen on page 50.

• For information on how to check on the [About This MFP] screen, refer to Checking the 
Device IP Address on page 230.

• For information on how to check using CentreWare Internet Services, refer to the online Help 
of CentreWare Internet Services.
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If the device IP address has not been set, set the IP address by using the Printer Setup Utility for Setting IP 
Address included in the Driver CD Kit, using the control panel to change the [Get IP Address] setting to 
[Panel], or using CentreWare Internet Services.

Notes:

• If the network has a DHCP server, the device's IP address may be changed, so check the 
address periodically.

• The device can acquire address information automatically by using a BOOTP or RARP server. 
To use a BOOTP or RARP server to acquire the device's IP address, use the control panel to 
change the [Get IP Address] setting to [BOOTP] or [RARP].

• For information on how to use the Printer Setup Utility for Setting IP Address, refer to When 
Using the Printer Setup Utility for Setting the IP Address on page 33.

• For information on how to set the IP address from the control panel, refer to TCP/IP on 
page 161.

• For information on how to set the IP address using CentreWare Internet Services, refer to the 
online Help of CentreWare Internet Services.

Setting the Device IP Address (IPv6)

The device supports IPv6 addresses in an IPv6 network environment.

Printer Setup Utility for Setting IP Address Control Panel

CentreWare Internet Services
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The device IP address type is set to IPv4 by factory default. To use the device in an IPv6 network 
environment, set the IP address type to IPv6 or both types. The IPv6 address is set automatically when the 
device is restarted. 

Print the System Settings Report to check the IPv6 address.

You can also check the IP address in the following methods:

• On the [About This MFP] screen

• Using CentreWare Internet Services

Notes:

• For information on how to print the System Settings Report, refer to Printing Reports/Lists on 
page 232.

• For information on how to check on the [About This MFP] screen, refer to Checking the 
Device IP Address on page 230.

• For information on how to check using CentreWare Internet Services, refer to the online Help 
of CentreWare Internet Services.

You can set a fixed IPv6 address for the device using either of the following methods:

• Use the Printer Setup Utility for Setting IP Address.

• Use the control panel to make the setting manually. Press the <Machine Status> button. From the 
[Tools] tab, select [Admin Settings] > [Network] > [Ethernet] > [IP Mode]. Set the [IP Mode] to [IPv6 
Mode] or [Dual Stack].

• Use CentreWare Internet Services to make the setting manually. Print the System Settings Report to 
check the address set automatically, and then use the address to access CentreWare Internet 
Services.2/22/16From the [Properties] tab, select [Protocol Settings] > [TCP/IP] > [IP Mode]. Set the [IP 
Mode] to [IPv6] or [Dual Stack]. The IPv6 address can be entered manually if the [Get IP Address] is 
set to [Manual].

Notes:

• For information on how to use the Printer Setup Utility for Setting IP Address, refer to When 
Using the Printer Setup Utility for Setting the IP Address on page 33.

• For information on how to set the IP address from the control panel, refer to TCP/IP on 
page 161.

• For information on how to make settings from CentreWare Internet Services, refer to the 
online Help of CentreWare Internet Services.

When Using the Printer Setup Utility for Setting the IP Address

This section describes how to set the IP address using the Printer Setup Utility for Setting IP Address 
included in the Driver CD Kit CD-ROM.

When using the Printer Setup Utility for Setting IP Address, make sure that the device is not in use.

1. Insert the Driver CD Kit CD-ROM into your computer.

The Launcher runs automatically. 
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2. In the [Admin Tools] tab, select [Start Printer Setup Utility for setting IP address] from the 
Administration Tools, and then click [Start].

The Printer Setup Utility for Setting IP Address is started.

3. Ensure that the network cable is connected to the device, and then click [Next].

4. As a list of available IP addresses and Mac addresses appears, select the device and click [Next].

If you already have the IP address of the device, click [Enter IP Address] and directly enter the IP 
address on the displayed window.
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5. Make advanced settings as needed, and then click [Next].

6. After confirming information displayed, click [Apply].

The specified settings are applied.

7. Click [Finish] to exit the Printer Setup Utility for Setting IP Address.

When the settings are properly configured, the device reboots automatically.

8. Confirm the assigned IP address after completing the setting process by one of the following 
methods.

• For information on how to print the System Settings Report, refer to Printing Reports/Lists on 
page 232.

• For information on how to check on the About This MFP screen, refer to Checking the Device IP 
Address on page 230.

• For information on how to check using CentreWare Internet Services, refer to the online Help of 
CentreWare Internet Services.
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Activating the Communication Port To Use

Use CentreWare Internet Services to activate the communication port you want to use. You can activate 
the following ports:

WSD stands for Web Services on Devices.

Note: For information on how to make settings from CentreWare Internet Services, refer to the online 
Help of CentreWare Internet Services.

Using CentreWare Internet Services

CentreWare Internet Services

CentreWare Internet Services provides services such as changing settings using a web browser on a 
computer connected to a TCP/IP network environment.

Port Description

LPD Select [Enabled] to use the LPD port.

Port9100 Select [Enabled] to use the Port9100 port.

IPP Select [Enabled] to use the IPP port.

WSD* Print Select [Enabled] to use the WSD* Print port.

WSD* Scan Select [Enabled] to use the WSD* Scan port.

FTP Select [Enabled] to use the FTP port.

Bonjour Select [Enabled] to use Bonjour.

Telnet Select [Enabled] to use Telnet.

SNMP Select [Enabled] to use SNMP.

Update Address Book Select [Enabled] to use Update Address Book.

StatusMessenger Select [Enabled] to use StatusMessenger.

SNTP Select [Enabled] to use SNTP.
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For more information on how to use CentreWare Internet Services, refer to the online Help of CentreWare 
Internet Services.

Notes:

• The IP address of the device also needs to be set. For information on how to set the IP 
address, refer to Setting the Network Environment on page 30.

• When changing any settings using CentreWare Internet Services, the device should be in 
standby status or Power Saver mode. 

Supported Environments and Settings

Operating Systems and Web Browsers

The operation of CentreWare Internet Services has been verified for the following web browsers:

Web Browser Settings

Specifying the device's address in the web browser is recommended.

Note: If you specify the device address using a proxy server, the service response time may be slow or 
the screens may not appear. If these problems occur, you will need to set the device's IP address in 
the web browser and choose not to use a proxy server. See your web browser's manual for how to 
make the setting.

You will also need to make other web browser settings to make CentreWare Internet Services work properly.

Operating System Web Browsers

Windows® 8.1/10 Windows® Internet Explorer® 11

Windows® 8 Windows® Internet Explorer® 10

Windows® 7 Windows® Internet Explorer® 8

Windows Vista® Windows® Internet Explorer® 7
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The following procedure is based on the Internet Explorer 6.0.

1. From the [Tools] menu, select [Internet Options].

2. In the [General] tab, click [Settings] under [Temporary Internet Files].

3. In the [Settings] dialog box, select [Check for newer versions of stored pages:].

4. Select [Every visit to the page] or [Every time you start Internet Explorer].

5. Click [OK].

6. Click [OK] in the [Internet Options] dialog box.

Starting CentreWare Internet Services

To start CentreWare Internet Services:

1. Start your computer and a web browser.

2. In your web browser's address bar, enter the device IP address or URL, and then press the <Enter> key.

The top page of CentreWare Internet Services is displayed.

• Example IP address (IPv4) 

• Example IP address (IPv6)

• Example URL

Notes:

• If your network uses DNS (Domain Name System) and the device host name is registered on 
the domain name server, you can access the device using the Internet address combining 
the host name and the domain name. For example, if the host name is myhost, and the 
domain name is example.com then the Internet address is myhost.example.com.

• When specifying a port number, add ":" and the port number after the IP address or the 
Internet address.

• The IPv6 address cannot be entered manually in some cases depending on the web browser 
that you use.

• HTTPS is not supported.
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Installing the Print Driver/Scan Driver

Installing the Print Driver

To enable the device to print, you must first install a print driver from the Driver CD Kit CD-ROM.

The CD-ROM contains the following print driver.

To install the print driver, follow the instructions by clicking the CD-ROM Documentation (HTML) on the 
[Documentation] tab in the Driver CD Kit included in the CD-ROM.

Installing the Scan Driver

A direct USB connection to a computer lets you load scanned data from the device directly to the 
computer.

The Driver CD Kit CD-ROM comes with the TWAIN-compatible and WIA (Windows Image Acquisition)-
compatible scan driver.

To install the scan driver, follow the instructions by clicking the CD-ROM Documentation (HTML) on the 
[Documentation] tab in the Driver CD Kit included in the CD-ROM.

Print Driver Name Description

DocuCentre SC2020 Click [Print/Fax Driver] in the [Main] menu of the Driver CD Kit to start 
installation. The standard print driver converts the data created by the 
application software to images before sending them to the printer. 

Application Description

TWAIN-compatible and 
WIA (Windows Image 
Acquisition)-compatible 
Scan Driver

Click [Scan Driver] in the [Main] menu on the Driver CD Kit to start the 
installation.
For more information, refer to Scanning to a Computer on page 128.

Address Book Editor Select [Install Fax Utility] in the [User Tools] menu of the Driver CD Kit, 
and click the [Start] button to start the installation.
Use to register recipient for sending document by fax. You can select a 
recipient if you register the information to Address Book Editor and 
save it to the device.
You can also retrieve the fax recipient phone numbers registered on a 
printer or using CentreWare Internet Services.
For more information on settings items, see the Address Book Editor's 
Help information.
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Be sure to restart the computer immediately after installing the scan driver.

Note: This function is not available on a network environment.

Uninstalling

Uninstalling the Print Driver

To uninstall the print driver, use the uninstallation tool on the Driver CD Kit CD-ROM. Follow the instructions 
provided in the CD-ROM Documentation (HTML) included on the CD-ROM.

Uninstalling Other Software

To uninstall other software installed from the Driver CD Kit CD-ROM, see the application Readme file. 
Readme files can be displayed from the Product Information (HTML) on the CD-ROM.
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3
Product Overview

This chapter lists the name of each device component, and describes basic operations such as how to turn 
the power ON/OFF and use the control panel.

Device Components
This section describes the device components and their functions.

Front, Left Side

No. Component Description

1 Document glass cover Holds document in place.

2 Document glass Place document here.

3 Control panel Contains the buttons, the LED indicators, and the touch screen 
used for operations.
For more information, refer to Control Panel on page 48.

2

4

1

3

5

79    

8    

6

10
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Right Side, Rear

4 Right top tray Copies and prints are delivered here, facing down.

5 Front cover Open this cover to replace consumables.

6 Tray 1 (standard tray) Load paper here.

7 Tray 2
(One Tray Module)
(Optional)

Optional tray. Load paper here.

8 Left side cover [B] Open this cover to remove any jammed paper from Tray 2.

9 Tray 5 (bypass) Load paper here. The tray can be extended.

10 Left side cover [A] Open this cover to remove any jammed paper.

Note: When the device works properly, this cover is locked. To open 
this cover, make sure to exit Sleep mode and turn the device's 
power OFF.

No. Component Description

1 Ethernet Port Connect a network cable.

2 USB Port Connect a USB 2.0 cable.

3 Power switch Switches the power of the device on and off.
For more information, refer to Power Source on page 45.

No. Component Description

2

1

6

5

3
4
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Note: LINE 1 and the TEL connectors are available when the Fax Kit (optional) is installed.

Inside

4 Power cord connector Connects the power cord.

5 TEL Connects to a telephone device. Do not connect any device (fax 
system) other than a telephone.

6 LINE 1 Connects to a telephone line.

No. Component Description

1 Yellow toner [Y] cartridge Contains yellow toner (the powder used to form the image).

2 Magenta toner [M] 
cartridge

Contains magenta toner (the powder used to form the image).

3 Cyan toner [C] cartridge Contains cyan toner (the powder used to form the image).

4 Black toner [K] cartridge Contains black toner (the powder used to form the image).

5 Yellow drum cartridge 
[R4]

Contains the photo conductor for yellow toner.

6 Magenta drum cartridge 
[R3]

Contains the photo conductor for magenta toner.

7 Cyan drum cartridge [R2] Contains the photo conductor for cyan toner.

8 Black drum cartridge [R1] Contains the photo conductor for black toner.

No. Component Description

1
2
3
4

9

10

5
6
7 
8
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Duplex Automatic Document Feeder

Note: In this guide, the duplex automatic document feeder is referred to as the document feeder.

Power Source

Turning the Power On

The following describes how to switch the power on.

9 Waste toner container 
[R5]

Collects waste toner.

10 Fusing unit Fuses toner on paper. 
Do not touch this unit as it is extremely hot.

No. Component Description

1 Document feeder top 
cover

Open this cover to remove any jammed paper.

2 Inner cover Open this cover to remove any jammed paper.

3 Document guides Aligns the edges of documents.

4 Document feeder tray Load documents here.

5 Document stopper Prevents outputs from falling off.

6 Document output tray Outputs are delivered here.

7 Narrow glass strip Scans the loaded documents.

No. Component Description

5

6

7 

1 3 42
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The device takes approximately 39 seconds or less to warm up and to be ready to copy, print, or fax after 
the power is turned on. It may take slightly longer than normal depending on the device configuration.

Switch the power off at the end of the day or when not using the device for an extended period of time.

1. Press the power switch to the [ | ] position to switch the power on.

Notes:

• The Power up sequence in progress message indicates that the device is warming up. The 
device is not accessible while warming up.

• Ensure that the power cable is connected to the device and the wall outlet properly.

Turning the Power Off

The following describes how to switch the power off.

Do not switch the power off in the following situations. If the power is switched off, the processing data 
may be erased.

• While data is being received

• While a job is being printed

• While a job is being copied

• While a job is being scanned

• When switching the power off, wait 10 seconds after outputs have been delivered and the device has 
stopped.

Note: When powering the device on after it has been switched off, wait 15 seconds after the display 
goes off.

1. Before switching the power off, make sure that the device has completed all copy or print jobs. Then, 
make sure that the <Data> LED does not light up.
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2. Press the power switch to the [ ] position to switch the power off.

Power Saver Modes
The device is installed with the Power Saver function that will automatically cut off the electricity to the 
device if no copy or print data is received for a certain duration.

There are two Power Saver modes: Low Power mode and Sleep mode.

3. Low Power Mode: The device's power is not turned OFF completely in Low Power mode. Instead, this 
mode creates a balance between low power consumption and short warm-up time by controlling the 
temperature of the fusing unit to a level midway between the power OFF temperature and the Ready 
temperature.

4. Sleep Mode: Sleep mode minimizes power consumption by shutting off the power to all components 
except the controller. Warm-up time in Sleep mode is longer than in Low Power mode. 

Entering Power Saver Modes

The display goes off, and the <Power Saver> button of the control panel lights up when the device is in an 
Power Saver mode.

You can set the length of time to wait until the device enters Low Power/Sleep mode.

Low Power mode is set to 1 minutes and Sleep mode to 0 minutes as default.

You can set the amount of time the device waits before entering Low Power mode from 1 to 150 minutes, 
and the amount of time the device waits before entering Sleep mode from 0 to 60 minutes.

The fusing unit life is largely influenced by power distribution time on the device. Setting the amount of 
time the device waits before activating the Power Saver function to a long value will keep the device's 

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Power Saver> button
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power on longer, and the fusing unit may have to be replaced more often. It may cause an early 
replacement of the fusing unit of the device. For more information, contact our Customer Support Center.

For more information on how to set the time interval for Low Power mode and/or Sleep mode, refer to 
Power Saver on page 175.

Exiting Power Saver Modes

The following describes how to deactivate Power Saver mode.

The device exits Power Saver mode in the following conditions:

Note: After exiting Power Saver mode in some conditions, the device keeps the touch screen turned off 
to save power. The touch screen lights up when the condition with an asterisk is met.

• Pressing the <Power Saver> button*

• Pop-up on the touch screen by pulling out and putting in Tray 1 (for Low Power mode)*

• Detecting a device error*

• Rebooting the device

• Receiving a job

Control Panel
The names and functions of the control panel's components are described below.

No. Component Function

1 Touch Screen Displays the operation menu items and the device status 
messages.

2 Numeric keypad Press these buttons to enter numbers (such as number of copies) 
or text.

Power SaverRedial/Pause
Services Home

Job Status

Machine Status

Data Error

Clear All Stop

Start

1 2 3 4 5 6

78910111213
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3 <Redial/Pause> button Press this button to re-dial a fax number.
Press this button to insert a pause between numbers when 
entering a recipient's number.

4 <Clear All> button Press this button to reset the displayed settings of each feature to 
default values or clear the entered numbers. The setting is 
returned to the same condition as the device is powered on.

5 <Power Saver> button Lights up when the device enters Power Saver mode to conserve 
power when the device is left idle for a while. You can also press 
this button to enter or exit Power Saver mode.

6 <Stop> button Press this button to cancel a current job or failed job.

7 <Start> button Press this button to start scanning documents or confirm the value 
of each setting.

8 <Error> LED Blinks if a system error occurs.
This indicator lights up when a problem other than a system error 
occurs with the device, including paper jams and running out of 
paper.

9 <Data> LED Blinks when the device is sending or receiving data to or from a 
client. This indicator lights up when data is stored in the device's 
memory or when the device receives faxes waiting to be printed.

10 <C> (Clear) button Press this button to delete one numerical value that you have 
entered.

11 <Machine Status> button Press this button to print reports and check the device information 
such as the status of consumables and the device IP address.

12 <Job Status> button Press this button to check/cancel a current job or pending job.

13 <Services Home> button Press this button to display the Services Home screen.

No. Component Function
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Touch Screen - Services Home Screen

This section describes the fields and buttons on the Services Home screen which is displayed by pressing 
the <Services Home> button.

• Message Field

Displays the printer status, error message, and IP address assigned to the printer.

• Toner Status Icon

Displays the condition of toner in six levels (The toner level for each color: 100%, 80%, 60%, 40%, 
20%, 0%). Selecting this icon displays the [Supplies] tab.

• Function Buttons

• Allows you to set the features for functions such as [Copy], [Email], [Scan To], [Fax], and [ID Card 
Copy].

Note: If the [Service Lock] setting for a function is set to [Enabled], the function is disabled and the 
menu for the function does not appear on the screen. For more information, refer to Limiting Access to 
Copy, Fax, and Scan on page 220.

Auditron
Auditron contains an authentication function that can set limits on what processes can be used, as well as 
an account management that can be used to control usage based on authentication.

The following illustration shows how the device works with Print Auditron.

You can also limit the copy function by using Copy Auditron.

Notes:

• For more information on Copy Auditron, refer to Copy Auditron on page 183.

• For more information on Print Auditron, refer to Print Auditron on page 183.

Message Field

Function Buttons

Toner Status Icon
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Notes:

• You can configure the device Auditron settings with CentreWare Internet Services. For more 
information, refer to the online Help of CentreWare Internet Services.

• To print using Auditron, you need to set the print driver. For more information, refer to the 
Help of the driver.

Entering Characters
This section describes how to use the keyboard displayed on the control panel and the number pad.

Using the Keyboard Displayed on the Control Panel

During operations, a screen for entering text sometimes appears. The following describes how to enter text.

Note: You can select the keyboard layout from QWERTY, AZERTY, and QWERTZ. For information on 
how to select the keyboard layout, refer to Keyboard Layout on page 213.

Registered user A
Registered user B

Can print up to 
10,000 pages in 
black and white

Can print up to 
9,000 pages in 
color or black 
and white

Cannot print if not a 
registered user, or if the 
printed pages exceeds 
the limit

Reference account 
report for each 
registered user

Print account 
report

Normal user D System administrator C
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You can enter the following characters: numerals, alphabets, and symbols.

Using the Number Pad

As you perform various tasks, you may need to enter numbers. For example, when you specify the quantity 
of copies or when you enter fax number directly.

Available Characters

You can enter the characters as follows by using the number pad: 0 to 9, * and #.

Item Description

Entering alphabets 
and numerals

To enter uppercase letters, select . To return to the lowercase letters, select 
 again.

Entering symbols Select .

Entering a space Select .

Deleting characters Select  to delete one character at a time.

QWERTY AZERTY

QWERTZ

Power SaverRedial/Pause

Data Error

Clear All Stop

Start
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Changing Numbers

If you make a mistake while entering a number, press the <Clear All> button to delete the last digit or 
character. Then enter the correct number.

Setting the Options Configuration
You can retrieve the information of device configuration into the print driver. Update the information of 
device configuration when any optional component is changed.

When using the Ethernet interface

You can load the device option configuration to the print driver by following the steps below.

Notes:

• When using this function, activate the SNMP port. (Default: Enabled)

• If you failed to retrieve information of device configuration or are using the USB interface 
connection, set the information of device configuration manually. For more information, 
click [Help] on the screen to display Help Information.

The following procedure uses Windows 7 and PCL 6 driver as an example. The procedure differs depending 
on the OS and the print driver.

1. Select [Start] > [Devices and Printers].

2. Right-click the printer icon of the DocuCentre SC2020 and select [Printer properties].

3. Click the [Configuration] tab.
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4. Click [Bi-Directional Setup]. 

5. Click [Get Information from Printer]. 

If [Printer Searching Method] is displayed

The device information is not loaded onto the print driver. Complete the following operations.

1. Select [Specify Address], and click [Next].
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2. Enter the printer name or IP Address in the [Printer Name or IP Address] field.

3. Click [Finish].

4. Click [OK].

Cooling Mode
The device enters the Cooling mode if its internal temperature rises too high. During this mode, either of 
the following screen is displayed on the touch screen.

This screen disappears when the internal temperature has cooled down. Wait until the screen disappears.

If the room temperature is high, lower the room temperature because it may take longer time for the 
device to cool down.

Notes:

• For screen A: During the Cooling mode, the fan inside the device is working to release heat. 
Do not open the front cover or switch off the device during the mode.

• For screen B: During the Cooling mode, open the cover illustrated on the screen to reduce the 
time for cooling.

Screen A Screen B
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Loading Paper

This chapter describes the paper that can be used with the device, precautions when handling paper, and 
how to load paper in trays.

Paper Types
This section describes the paper types supported by the device.

Use of non-recommended paper types may result in paper jams, lower print quality, malfunctions, or 
damage to the device. To achieve optimum device performance, use only paper types recommended by 
Xerox.

If you desire to use paper other than the paper recommended by Xerox, contact our Customer Support 
Center.

CAUTIONS:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.

• Moisture generated by water, rain, or vapor may cause the printed images to fade. For more 
information, contact our Customer Support Center.
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Supported Paper Weights and Sheet Counts

1. When using 80 g/m2 paper

2. When using Xerox standard paper

Notes:

• Paper jams may result if you attempt to print on a different paper type or size than the type 
or size selected in the print driver, or from a tray that does not support the loaded paper. 
Select the correct paper size, type, and tray to ensure successful printing.

Basis weight is the weight of one sheet of paper of 1 m2 in size.

• Ream weight is the weight of 1,000 sheets of duodecimal size (788 x 1,091 mm) paper.

Supported paper sizes:
• Maximum: A3, 11 x 17" (Non-standard size: 297 × 432 mm)

• Minimum: A5 (Non-standard size: 89 × 98 mm)

2-sided printing

The following paper types support automatic 2-sided printing:

Paper Trays
Basis Weight/Ream 
Weight

Loadable 

Quantity* Paper Types

Tray 1 (Standard) 60-90 g/m2

Ream Weight: 51.6–77.4 
kg

250 sheets*1 

(Up to 27 mm)
Plain (60-90 g/m2)

Tray 2
 (One Tray Module)
 (Optional)

60-256 g/m2

Ream Weight: 51.6–
220.1 kg

500 sheets*1

 (Up to 54 mm)
Plain (60-90 g/m2)

Bond (90-105 g/m2)
Heavyweight (106-169 

g/m2)
Extra-HW (170-256 

g/m2)

Tray 5 (Bypass) 60-216 g/m2

Ream Weight: 51.6–
185.7 kg

100 sheets*2

(Up to 10 mm)

Paper Type (Quality)

Plain (60–90 g/m2)

Bond (90–105 g/m2)

Heavyweight (106–169 g/m2)
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Supported Paper Type

Standard Paper

When printing or copying on commonly used paper (plain paper), use paper meeting the standards 
described below. To copy or print as clear as possible, we recommend the following standard paper.

Semi-Standard Paper

In addition to the standard paper, the following paper also can be used.

Paper Name
Basis Weight 

(g/m2)
Paper 
Type

Notes/Countermeasure

Paper 64 Plain Tough plain paper suitable for internal 
documents at the office.

Colortech + 90 Bond Before copying or printing, fan the stack of 
paper well and reload it in the tray.

A-paper 75 Plain Before copying or printing, fan the stack of 
paper well and reload it in the tray.

Diplomat 80 Plain Do not keep the paper unsealed in a high-
humidity condition.

Paper Name
Basis Weight 

(g/m2)
Paper 
Type

Notes/Countermeasure

Performer + 70 Plain -

80 Plain -

Business + 70 Plain Before copying or printing, fan the stack of 
paper well and reload it in the tray.

75 Plain -

80 Plain Before copying or printing, fan the stack of 
paper well and reload it in the tray.

Professional 70 Plain Do not keep the paper unsealed in a high-
humidity condition.

80 Plain Before copying or printing, fan the stack of 
paper well and reload it in the tray.

H-paper 80  Plain Before copying or printing, fan the stack of 
paper well and reload it in the tray.
Xerox® DocuCentre® SC2020
User Guide

58



Loading Paper
Usable Paper

In addition to the standard/semi-standard paper, the following paper also can be used.

PAPER ONE COPIER 
PAPER

70 Plain -

LQ-PAPER  80 Plain -

Paper Name
Basis Weight 

(g/m2)
Paper Type Notes/Countermeasure

Copy Pilot 70 Plain -

80 Plain -

Kool Print 80 Plain -

Le Copy 70 Plain -

80 Plain -

DocuPaper Black 70 Plain -

DocuPaper 80 Plain Before copying or printing, fan the stack 
of paper well and reload it in the tray.

White Label 80 Plain -

Xerox Green Label 70 Plain -

K-paper 75 Plain -

80 Plain -

J Paper 82 Plain -

JD Paper 98 Bond -

PAPER ONE All Purpose 80 Plain -

DOUBLE A 80 Plain -

XEROX ONE 80 Plain -

WARRIOR 70 Plain -

Van Hawk paper 70 Plain Before copying or printing, fan the stack 
of paper well and reload it in the tray.

80 Plain -

Paper Name
Basis Weight 

(g/m2)
Paper 
Type

Notes/Countermeasure
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Unusable Paper
Using paper not recommended by Xerox may cause a paper jam or device malfunction. Use paper 
recommended by Xerox.

• Damp or wet paper

• Paper preprinted with other printer or copying device

• Wrinkled, creased, or ripped paper

• Envelopes that are not flat, or that have clasps

• Color paper with surface treatments

• Paper with rough surface, such as pulp paper or fibrous paper

• Punched paper

• Transparency film

Storing and Handling Paper
• Please keep the following points in mind when storing paper

• Store paper inside a cabinet or other dry place. Paper that has absorbed moisture may result in paper 
jams and lower image quality.

• After opening a package of paper, wrap and store any remaining paper. We recommend that you 
store remaining paper in moisture prevention packets.

• Store paper on a flat surface to prevent bends or warping.

• Please keep the following points in mind when loading paper in a tray

• Align the stack of paper neatly before loading it in a tray.

• Do not use creased or wrinkled paper.

• Do not use warped or curled paper.

• Do not load paper of mixed sizes together into a tray.

J Paper 82 Plain -

JD Paper 98 Bond -

Quality 70 Plain -

Double A 80 Plain -

Roxy Paper 80 Plain -

Colotech + 120 Heavyweight -

160 Heavyweight -

Paper Name
Basis Weight 

(g/m2)
Paper Type Notes/Countermeasure
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• Take care not to touch the print side. Oils from your skin may adhere to the print media, which may 
affect printing quality. If unavoidable, be sure to use a finger cot, gloves, or other means to cover your 
fingers before touching the print media. 

• Portrait orientation is recommended for heavyweight media fed from the Tray 5 (bypass). If a misfeed 
occurs, please apply an intentional upper curl to the leading edge of the paper.

• Do not load paper above the maximum fill line in the Tray 1 to 5. It may cause paper jams.

• When Heavyweight Paper/Extra-HW Paper is supplied to the Tray 5 and causes paper jams, reduce the 
paper quantity or turn over the paper in the Tray 5.

Loading Paper
This section describes how to load paper in a paper tray.

• Types of paper loaded in trays

The device automatically detects the size and orientation of paper loaded in a tray, but the paper 
type must be set manually. Each tray's default paper type setting is Plain paper. Change the paper 
type setting when loading a different type of paper. You can also set a non-standard paper size as 
[Custom Size] paper in the Tray 5 (Bypass) and Tray 2 (optional).

Note: For information on how to change the paper type setting, refer to Changing the Paper Settings 
on page 66.

• Automatic Paper Selection

When processing a print job, specify the settings in the print driver's screen by selecting 
[Automatically Select] for [Select By Tray] under [Paper] in the [Paper/Output] tab. The device 
automatically selects a tray to match the specified document size and orientation. This function is 
called as Automatic Paper Selection.

To activate Automatic Paper Selection when copying, set [Select Tray] to [Auto].

This Automatic Paper Selection function selects the trays in order from Tray 5 (Bypass) > Tray 1 >Tray 
2 if there is more than one paper tray that matches. You can change the tray priority by setting [Tray 
Priority].

Notes:

• Tray2 is available only when the One Tray Module (optional) is installed. 

• When using Tray 5 (Bypass), the paper size cannot be automatically detected. Specify the 
paper settings from the touch screen. For information on how to make the settings, refer to 
Tray 5 (Bypass) on page 206.

• For more information on setting [Tray Priority], refer to Tray Priority on page 212.

Loading Paper in Trays 1 and 2

The following describes the procedure for loading paper in Trays 1 and 2.
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When the device runs out of paper during copying or printing and an error code is displayed on the screen, 
add paper in the tray. Copying or printing automatically resumes when paper is added.

Notes:

• Fan the stack of paper well before loading paper in a tray. It prevents paper from sticking to 
each other and reduces paper jams.

• For information on how to change the paper size and orientation in a tray, refer to Changing 
the Paper Size for Trays 1 and 2 on page 65.

1. Pull out the tray until it stops.

While the device is copying or printing, do not pull out the tray that the job uses.

Notes:

• To prevent paper jams or loading errors, do not load different sizes or types of paper on top 
of any remaining paper in a tray.

• Pulling out all the trays at once may cause the device to tilt or fall, causing injury.

2. For Tray 1, push down the metal plate.
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3. Load paper with the side to copy or print on facing up. Align the leading edge of paper with the left 
side of the tray.

Notes:

• Do not load paper above the maximum fill line . It may cause paper jams or device 
malfunctions.

• Do not place any paper or objects in the empty space on the right side of Trays 1 and 2. It 
may cause paper jams or device malfunction.

4. Push the tray in gently until it stops.

When pushing the tray in, do it slowly. If the tray is pushed with too much force, it may cause device 
malfunctions.

Loading Paper in Tray 5 (bypass)

When printing or copying on paper that cannot be set in Trays 1 and 2, use the Tray 5 (bypass). The 
following describes the procedure for loading paper into the Tray 5 (bypass). For printing, specify the 
settings on the [Paper/Output] tab using the print driver. Also specify the type of paper to be loaded.

To prevent paper jams or loading errors, do not remove paper from its packaging until needed.

Note: Fan the stack of paper well before loading paper in a tray. It prevents paper from sticking to 
each other and reduces paper jams.

1. Open the Tray 5 (bypass).

Note: If necessary, pull out the extension tray. Pull out the extension tray gently.
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2. Load paper with the side to be copied or printed on facing down, inserting paper until its edge lightly 
touches against the paper feed entrance.

Notes:

• Do not load mixed paper types in a tray.

• Do not load paper above the maximum fill line. It may cause paper jams or device 
malfunctions.

• The device may not be able to feed or create the desired print quality for some types of 
heavyweight paper.

3. Gently align the paper guides to paper loaded .

4. Execute the copy or print operation.

Changing Paper Size
This section describes how to change paper size in Trays 1 and 2.

Do not load mixed paper sizes into a tray.

Note: A paper type is preset for Trays 1 and 2. Normally, [Plain] is set for the trays. When changing it 
to a different paper type, change the paper quality settings to match the type of paper to be loaded 
so that you can maintain high quality printing. For more information on how to set the paper quality, 
refer to Changing the Paper Settings on page 66.
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Changing the Paper Size for Trays 1 and 2

The following describes the procedure for changing paper size in Trays 1 and 2.

1. Pull out the tray until it stops.

While the device is copying or printing, do not pull out the tray that the job uses.

To prevent paper jams or loading errors, do not load different sizes or types of paper on top of any 
remaining paper in a tray.

2. Remove any paper loaded in the tray.

3. For Tray 1, push down the metal plate.

4. While pinching the levers of the two paper guides, move them to the edges of paper.
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5. Load paper with the side to copy or print on facing up. Align the leading edge of paper with the left 
side of the tray.

Note: Do not load paper above the maximum fill line. It may cause paper jams or device malfunctions.

6. Push the tray in gently until it stops.

When pushing the tray in, do it slowly. If the tray is pushed with too much force, it may cause device 
malfunctions.

Note: Affix the paper size label to the front of the tray.

Changing the Paper Settings
This section describes how to change the paper type setting for a tray.

A paper type is preset for Trays 1 and 2. Normally, [Plain] is set for the trays. To maintain the same print 
quality after changing paper in a different quality in the same tray, you need to change the paper quality 
setting for the tray that matches new paper loaded.

Notes:

• For more information, refer to Supported Paper Type on page 58. 

• For information on the paper size setting for Tray 5, refer to Tray 5 (Bypass) on page 206.

1. Press the <Machine Status> button.

Services Home

Job Status

Machine Status

<Machine Status> button
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2. Select the [Tools] tab.

3. Select [Tray Management] > [Tray Settings].

4. Select the desired paper tray.

5. Select [Type], and then select the desired paper type.

Notes:

• If you select Tray 5 (bypass), [Size] and [Type] are displayed. To change the paper size, select 
[Size]. To use a non-standard document size, set [Size] to [Custom Size], and then specify the 
paper size

• When using a non-standard size envelope, specify the size without the flap in [Custom Size].

6. Select the desired paper type.

7. Select [OK].
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Copy

This chapter describes the Copy functions and operations.

Overview of Copy Operations
This section describes the basic flow of copy operations including placing document in the device and 
making advanced settings.

Notes:

• This device reads documents using a CIS sensor. The focus depth of the CIS sensor is 
shallow, resulting in differences in image quality depending on the type of document and 
the position in which the document is set. Take note of the following.

• If image quality is a priority, use the document glass instead of the document feeder.

• Set the curled documents, 3D objects, books, etc., closely against the document glass.

Placing Document

The following two methods are available to place document:

• Document feeder

• Single sheet

• Multiple sheets

• Document glass

• Single sheet

• Bound documents, such as books

Document Feeder

Supported document sizes

You can place standard size documents in the document feeder.
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When document is placed in the document feeder, the device detects the document size automatically. 

The following standard size documents are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 *, 

A5 , 11 × 17" , 8.5 × 14" *, 8.5 × 13" *, 8.5 × 11" , 8.5 × 11" , 8K , 16K , and 16K *.

Note: The document sizes with an asterisk can be automatically detected depending on the settings. 
You can select one of the following alternative document sizes. For more information, refer to Original 
Size Detected on page 176.

– B5 (default) or 16K

– 8.5 × 14" (default) or 8.5 × 13"

Note: When using 2-sided document placed in the document feeder, make sure to set [Binding of 
Original] properly.

Supported document types (weights)

Documents with weights from 38-128 g/m2 (50-128 g/m2 for 2-Sided documents) can be placed in the 
document feeder and scanned. 

The document feeder accepts the following number of sheets.

Note: To avoid paper jams, use the document glass for mixed size, folded, wrinkled, cut-and-pasted 
documents, curled paper, or carbon-backed paper. If you can flatten the curled document, you can use 
the document.

Follow the steps below to place document in the document feeder.

You can place a single or multiple pages of a document.

1. Remove any paper clips or staples from document before placing it in the document feeder.

2. Place the document in the center of the document feeder, with the side to be scanned (or the front 
surface of a 2 sided document) facing up.

Document Type (g/m2) Number of Sheets

Lightweight (38-80 g/m2) 110 sheets

Heavyweight (81-128 g/m2) 75 sheets
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3. Align the document guides to each side of document.

4. Open the document stopper. 

Document Glass

Document sizes supporting automatic detection

The document size is detected automatically when [Original Size] is set to [Auto].

The following document sizes are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 , A5 , 11 × 

17" , 8.5 × 11" , 8K , 16K , and 16K .

Notes:

• When copying multiple pages of a document, the document size of the first document page 
is set to copy the rest of the document.

• The device automatically determines the tray holding the appropriate paper, based on the 
document size and the specified zoom ratio.

Supported document sizes

You can select one of the following document sizes from [Original Size].
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A3 , B4 , A4 , A4 , B5 , B5 , A5 , 11 × 17" , 8.5 × 14" , 8.5 × 13" , 8.5 × 11" , 8.5 × 11" , 

8K , 16K  and 16K .

Note: You can select a custom paper size specified for Tray 5 (bypass) using the Tray Settings. For 
more information, refer to Tray 5 (Bypass) on page 206.

WARNING: Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.

Follow the steps below to place document on the document glass.

You can place a single sheet document or bound document such as book on the document glass.

1. Open the document glass cover.

When using the document glass, make sure to close the document glass cover after finishing your 
copy job.

2. Place the document face down, and align it against the top left corner of the document glass.

3. Close the document glass cover. 
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Making Advanced Settings
Note: You may need to enter a passcode to use the copy feature. Ask your system administrator for 
the passcode.

1. Press the <Services Home> button.

2. Select [Copy]. 

3. Make advanced settings as needed.

For details, refer to Advanced Copy Settings on page 77.

Entering the Number of Copies

You can enter a value between 1 and 999 for the number of copies.

1. Use the numeric keypad to enter the desired number of copies. 

Services Home

Job Status

Machine Status

<Services Home> button

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

Numeric keypad
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The entered value appears in the display.

Note: If you make a mistake, press the <C> (Clear) button, and then re-enter the setting.

Starting the Copy Job
1. Press the <Start> button. 

If document is placed in the document feeder, do not press down on the document while it is being 
fed through the device.

Note: If a problem occurs, an error code appears on the screen. For information on error codes, refer to 
Error Code on page 277.

Placing document on the document glass
• Copying multiple sets of documents

You can continue copying multiple sets of documents using any of the following settings:

• Collation: Collated

• 2-Sided Copying: 1  2-Sided/2  2-Sided

• Pages Per Side: 2-Up

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<C> (Clear) button

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Start> button
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• ID Card Copy

When the document is placed on the document glass, the display prompts you for another page. If you 
want to place a new document, replace the document with a new document, and then select [Scan 
Another Page]. When you have finished loading documents, select [Done. Print Now].

About Auto Rotation

The copy feature supports the Auto Rotation function that the device automatically prints a scanned page 
to fit onto a page of paper by rotating the scanned image although the orientation of the document is 
different from the paper loaded in the tray.

You can set this feature in the following cases:

• The tray selection is set to automatic.

• The zoom ratio is set to automatic.

• The zoom ratio is set to 100% and both document and paper are the same size.

• The Pages Per Side function is used.

If none of the above conditions applied when copying, the device does not perform Auto Rotation, which 
may result in a part of the image to be missing.

Operations Performed While Copying
While the device is copying, you can cancel the currently executing job, and check or cancel pending jobs.

Canceling the Current Copy Job

To cancel the currently executing copy job:

1. Press the <Stop> button. 

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Stop> button
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Checking Job Status

Follow the steps below to check the status of the copy job being executed, or the status of a copy job 
waiting to start (a pending job).

Note: You can cancel the currently executing copy job or a pending copy job. 

For more information on operation in job screen, refer to Canceling the Current Job on page 235.

1. Press the <Job Status> button.

2. Check the job status.

ID Card Copy
You can copy both sides of an ID card (name card, employee card, etc.) on one side of paper.

Select [ID Card Copy] to use this feature.

Place an ID card in the upright position. 

Services Home

Job Status

Machine Status

<Job Status> button

Original document

Front side

Back side

Front side

Original orientation Copied output

Back side
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Follow the steps below to use the ID Card Copy feature.

1. Place an ID card face down at least 5 mm away from the top left corner of the document glass, and 
then close the document glass cover.

Placing the ID card too close to the corner of the document glass may not copy the edge of the ID 
card properly.

2. Press the <Services Home> button.

Note: For your assistance, follow the guidance of ID Card Copy displayed on the screen.

3. Select [ID Card Copy].

4. Make advanced settings as needed.

• [ID Card Copy] tab

– Output Color

– Select Tray

• [Quality] tab

– Lighten/Darken

– Sharpness

– Saturation

– Auto Background Suppression

For more information, refer to the Advanced Copy Settings on page 77.
Xerox® DocuCentre® SC2020
User Guide

76



Copy
5. Press the <Start> button.

6. To continue scanning the other side of the ID card, place the other side of the ID card face down 
slightly away from the top left corner of the document glass, and then close the document glass cover. 

7. Select [Scan Side 2].

Advanced Copy Settings
This section describes the advanced functions available for Copy feature.

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Start> button
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Note: For more information on defaults that can be changed, and how to change them, refer to Copy 
Defaults on page 191.

1. Press the <Services Home> button.

Tab Setting Item Purpose
See 
Page:

Copy Output Color To select the mode for color or black and white 
copying.

page 79

Select Tray To select a tray. page 80

Reduce/Enlarge To reduce or enlarge the size of a copied image. page 81

2-Sided Copying To make 2-sided copies with the specified binding 
position.

page 83

Quality Lighten/Darken To adjust the contrast to make the copy lighter or 
darker than the original.

page 84

Original Type To select the copy image quality. page 85

Sharpness To adjust the sharpness to make the copy image 
sharper or softer than the original.

page 85

Saturation To adjust the amount of colors of the copy to make 
the colors darker or lighter than the original.

page 86

Auto Background 
Suppression

To suppress the background of the original to 
enhance text on the copy.

page 87

Output Collation To sort the copy output. page 87

Original Size To select the default document size. page 88

Pages Per Side To print two original images to fit onto one sheet 
of paper.

page 90

Edge Erase To specify the top and bottom margins of the 
copy.

page 91

Services Home

Job Status

Machine Status

<Services Home> button
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2. Select [Copy].

3. Select the desired setting item as needed.

Output Color

To select the mode for color or black and white copying.

1. Select [Output Color] on the [Copy] tab.

2. Select [Full Color] or [Black & White], and then select [OK].

Note: Color copy is secured with a passcode if the [Service Lock] setting for [Copy] is set to [On] (Color 
Password Locked). If you set [Output Color] to [Full Color] and the [Service Lock] setting for [Copy] to 
[On] (Color Password Locked), you will need to enter the four digit passcode after pressing the <Start> 
button.
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Select Tray

To select a tray.

1. Select [Select Tray] on the [Copy] tab.

2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

Note: [Tray 2] is only available when the One Tray Module (Optional) is installed. When [Any] is 
displayed as the paper size and type in Tray 5 (bypass), you can select the paper size and type from 
this menu.

Auto The paper is fed from an automatically selected tray.

Tray5 (Bypass) The paper is fed from the Tray 5 (bypass).

Tray 1 The paper is fed from Tray 1.

Tray 2 The paper is fed from Tray 2.
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Reduce/Enlarge

To reduce or enlarge the size of a copied image from 25 to 400% when you copy original documents from 
the document glass or the document feeder.

Note: When you make a reduced copy, black lines may appear at the bottom of your copy.

1. Select [Reduce/Enlarge] on the [Copy] tab.

2. Select the desired setting, and then select [OK].

mm series

Note: Bold values are the factory default menu settings.

100%

Auto%

50%
A3  A5

70%
A3  A4, B4  B5

81%
B4  A4, B5  A5

86%
A3  B4, A4  B5

115%
B4  A3, B5  A4
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inch series

Note: You can also specify the value in increments of 1% from 25 to 400 by selecting [ ] or [ ] or 
entering a value using the number pad. See the following table for specific zoom ratios.

122%
A4  B4, A5  B5

141%
A4  A3, B5  B4

200%
A5  A3

100%

Auto%

64%
8.5 x 11"  5.5 x 8.5"

70%
A3  A4, B4  B5

78%
8.5 x 14"  8.5 x 11"

94%
A3  11 x 17", A4  8.5 × 
11"

129%
8.5 x 11"  11 x 17"

141%
A4  A3, B5  B4

180%
4 x 6"  8.5 x 11"

200%
A5  A3

Copy
Original

A5 B5 A4 B4 A3

A5 100% 122% 141% 172% 200%

B5 81% 100% 115% 141% 163%
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2-Sided Copying

To make 2-sided copies with the specified binding position.

1. Select [2-Sided Copying] on the [Copy] tab.

2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

When you are using the document glass and it is set to [12-Sided] or [22-Sided], the display prompts 
you for another page after pressing the <Start> button.

1. If you want to place a new document, replace the document with a new document, and then select 
[Continue] or press the <Start> button.

A4 70% 86% 100% 122% 141%

B4 57% 70% 81% 100% 115%

A3 50% 61% 70% 86% 100%

1  1-Sided Select 1-sided or 2-sided and specify 
binding position for the 2-sided copy.

12-Sided Binding of Output Long Edge Binding

Short Edge 
Binding

21-Sided Binding of Original Long Edge Binding

22-Sided Short Edge 
Binding
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2. If you finish copying, select [Print Now].

Note: When you use the document feeder to copy both sides of a document, the printed position of 
the front and back of the document may differ if the size in the document size setting and the size of 
the document do not match. In this case, set [Original Size] to the same size as the document.

Lighten/Darken

To adjust the contrast to make the copy lighter or darker than the original.

1. Select the [Quality] tab, and then select [Lighten/Darken].

2. Select the desired level on the [Lighten/Darken] bar, and then select [OK].

You can select a contrast level from seven levels between [Darken] and [Lighten].

Selecting a cell on the left side of the bar makes the document contrast darker, and selecting a cell on the 
right side of the bar makes the document contrast lighter.

Note: Bold values are the factory default menu settings.

Darken +3 Works well with light documents or faint pencil markings.

Darken +2

Darken +1

Normal Works well with normal typed or printed documents.

Lighten +1 Works well with dark documents.

Lighten +2

Lighten +3
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Original Type

To select the copy image quality.

1. Select the [Quality] tab, and then select [Original Type].

2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

Sharpness

To adjust the sharpness to make the copy image sharper or softer than the original.

1. Select the [Quality] tab, and then select [Sharpness].

Photo & Text Used for documents with photos and text.

Text Used for documents with text.

Photo Used for documents with photos.
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2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

Saturation

To adjust the amount of colors of the copy to make the colors darker or lighter than the original.

1. Select the [Quality] tab, and then select [Saturation].

2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

Sharpen Makes the copy image sharper than the original.

Normal The color clarity of the image is the same as the 
original.

Soften Makes the copy image softer than the original.

Vivid Makes the copy image sharper than the original.

Normal The color clarity of the image is the same as the 
original.
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Auto Background Suppression

To suppress the background of the original to enhance text on the copy.

1. Select the [Quality] tab, and then select [Auto Background Suppression].

2. Select [On], and then select [OK].

Collation

To sort the copy output. For example, if you make two copies of three page documents, one complete three 
page document will be printed followed by the second complete document.

1. Select the [Output] tab, and then select [Collation].

Pastel Makes the copy image softer than the original.
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2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

When you are using the document glass and it is set to [Collated], the display prompts you for another 
page after pressing the <Start> button.

1. If you want to place a new document, replace the document with a new document, and then select 
[Continue] or press the <Start> button.

2. If you finish copying, select [Print Now].

Original Size

To select the default document size.

1. Select the [Output] tab, and then select [Original Size].

2. Select the desired setting, and then select [OK].

Auto Only the documents loaded from the document feeder are copied in 
collated order.

Collated Copies in collated order.

Uncollated Does not copy in collated order.
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mm series

Note: Bold values are the factory default menu settings.

inch series

Auto

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

Auto

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)
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Pages Per Side

To print two original images to fit onto one sheet of paper.

1. Select the [Output] tab, and then select [Pages Per Side].

2. Select the desired setting, and then select [OK].

Note: Bold values are the factory default menu settings.

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)

Off Does not perform Pages Per Side printing.

2-Up Automatically reduces the original pages to fit onto 
one sheet of paper.
Xerox® DocuCentre® SC2020
User Guide

90



Copy
Edge Erase

To specify the top and bottom margins of the copy.

Note: Bold values are the factory default menu settings.

1. Select the [Output] tab, and then select [Edge Erase].

2. Select [ ] or [ ], or use the number pad to enter the desired value.

Top/Bottom 2 mm (0.1")
0  50 mm (0.0  2.0")

Specify the value in increments of 1 mm (0.1 inch).

Left/Right 2 mm (0.1")
0  50 mm (0.0  2.0")

Specify the value in increments of 1 mm (0.1 inch).

Middle 0 mm (0")
0  50 mm (0.0  2.0")

Specify the value in increments of 1 mm (0.1 inch).
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Fax

This chapter describes the Fax functions.

Note: This feature is available when the Fax Kit is (optional) installed.

Overview of Fax Operations
This section describes the basic flow of fax operations including placing document in the device, setting 
the recipient address, and making advanced settings.

You must set the [Region] and [Date & Time] items to use the Fax feature. For more information, refer to 
Region on page 165 and Date & Time on page 175.

Placing Document

The following two methods are available to place document:

• Document feeder

• Single sheet

• Multiple sheets

• Document glass

• Single sheet

• Bound documents, such as books

Document Feeder

Supported document sizes

You can place standard size document in the document feeder.

When document is placed in the document feeder, the device detects the document size automatically. 

The following standard size documents are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 *, 

A5 , 11 × 17" , 8.5 × 14" *, 8.5 × 13" *, 8.5 × 11" , 8.5 × 11" , 8K , 16K , and 16K *.
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The maximum supported document size is 297 x 431.8 mm (long).

Note: The document sizes with an asterisk can be automatically detected depending on the settings. 
You can select one of the following alternative document sizes. For more information, refer to Original 
Size Detected on page 176.

– B5 (default) or 16K

– 8.5 × 14" (default) or 8.5 × 13"

When document containing pages of different sizes is placed in the device, the device uses the 
largest document size to scan the document.

The paper size for fax transmissions is different from the document sizes supporting automatic 
detection. For more information, refer to Original Size on page 105.

– Supported documents types (weights)

Documents with weights from 38-128 g/m2 (50-128 g/m2 for 2-Sided documents) can be placed in the 
document feeder and scanned. 

The document feeder accepts the following number of sheets.

To avoid paper jams, use the document glass for mixed size, folded, wrinkled, cut-and-pasted documents, 
curled paper, or carbon-backed paper. If you can flatten the curled document, you can use the document.

Follow the steps below to place document in the document feeder.

You can place a single or multiple pages of a document.

1. Remove any paper clips or staples from document before placing it in the document feeder.

2. Place the document in the center of the document feeder, with the side to be scanned (or the front 
surface of a 2-Sided document) facing up.

Document Type (g/m2) Number of Sheets

Lightweight (38-80 g/m2) 110 sheets

Heavyweight (81-128 g/m2) 75 sheets
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3. Align the document guides to each side of document.

4. Open the document stopper. 

Document Glass

Document sizes supporting automatic detection

The document size is detected automatically when [Original Size] is set to [Auto].

The following document sizes are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 , A5 , 11 × 

17" , 8.5 × 11" , 8K , 16K , and 16K .

You can select one of the following document sizes from [Original Size].

A3 , B4 , A4 , B5 , A5 , 8K , 11 × 17" , 8.5 × 14" ,8.5 × 13" , and 8.5 × 11 .

The paper size for fax transmissions is different from the document sizes supporting automatic detection. 
For more information, refer to Original Size on page 105.

WARNING: Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.

Follow the steps below to place a document on the document glass.
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You can place a single sheet document or bound document such as book on the document glass.

1. Open the document glass cover.

When using the document glass, make sure to close the document glass cover after finishing your copy job.

2. Place document face down, and align it against the top left corner of the document glass.

3. Close the document glass cover. 

Specifying the Recipient

Follow the steps below to specify the fax recipient.
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Check the recipient before sending a fax.

1. Press the <Services Home> button.

2. Select [Fax].

Notes:

• You must enter the [Region] setting to use the Fax feature. If a message asking you to set 
the region appears when you select [Fax], set your region.

• For information on how to make the setting, refer to Region on page 165.

Using the numeric keypad

To enter the fax recipient's number directly:

1. Use the numeric keypad to enter the fax recipient's number.

Notes:

• To delete the entered numbers, press the <C> (Clear) button.

• You can enter fax numbers of up to 50 digits in length.

Services Home

Job Status

Machine Status

<Services Home> button
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Using the Speed Dial function

To specify the fax recipient by entering a Speed Dial number (001 to 200) registered in the address book:

1. Select the [ ] button.

2. Use the numeric keypad to enter the Speed Dial number.

Note: To delete the entered numbers, press the <C> (Clear) button.

Using the Address Book

To select a fax number, select the [ ] button, and then select one of the following.

• Device Address Book - Individuals: Select an individual fax number and then select [OK].

• Device Address Book - Groups: Select a group dial number and then select [OK].

• Search Network Address Book - Groups: Search and select a fax number from the LDAP server and then 
select [OK].

Notes:

• The fax number needs to be registered before you can select address book.

• Of you are using the LDAP server address book, [Fax Server Address Book] must be set to 
[On]. For more information, refer to Fax Server Address Book on page 179.

Making Advanced Settings
Note: You may need to enter a passcode to use the copy feature. Ask your system administrator for 
the passcode.

1. Make advanced settings as needed. 

Example: Settings in the [Options] tab

For more information on advanced settings, refer to Advanced Fax Settings on page 100.
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Starting the Fax Job
1. Press the <Start> button.

If the document is placed in the document feeder, do not press down on the document while it is 
being fed through the device.

Notes:

• If the memory becomes full when document is being scanned, the device stops scanning 
and sending the document, and the fax job is canceled.

• The maximum number of pages that can be scanned for a single scan command is 100 
pages from the document glass, 165 pages from the document feeder for 1-Sided 
documents, and 330 pages from the document feeder for 2-Sided documents.

Notes:

• The numbers are limited when the memory for accumulating fax jobs has reached its limit.

• If a problem occurs, an error message appears in the display. Follow the instructions in the 
message to solve the problem.

When sending faxes of multiple sets of documents

When the document is placed on the document glass, the display prompts you for another page. If you 
want to place a new document, replace the document with a new document, and then select [Scan 
Another Page]. When you have finished loading documents, select [Done. Fax Now].

Operations during Faxing (Sending)
You can cancel the fax currently being sent, and check or cancel pending jobs.

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Start> button
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Canceling the Fax Being Sent

To cancel the fax currently being sent:

1. Press the <Stop> button.

Checking Job Status

Follow the steps below to check the status of the fax job currently being executed, or the status of a 
pending fax job waiting to start.

Notes:

• You can cancel the fax job currently being executed, or pending fax jobs.

• For more information on operation in job screen, refer to Canceling the Current Job on 
page 235

1. Press the <Job Status> button.

2. Select a fax job.

3. Check the job status. 

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Stop> button

Services Home

Job Status

Machine Status

<Job Status> button
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Operations during Faxing (Receiving)
You can cancel the fax currently being received.

Canceling the Fax Being Received

To cancel the fax currently being received.

1. Press the <Stop> button.

2. Select the fax job that you want to cancel, and then select [Delete].

– Select [Cancel] when you want to cancel printing and save the received data.

– Select [Delete Job] when you want to cancel printing and delete the received data.

Note: You can also cancel the received fax from the Active Jobs screen.

For more information on the Active Jobs screen, refer to Canceling the Current Job on page 235.

Advanced Fax Settings
This section describes the advanced functions available for Fax feature.

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Stop> button
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Note: For more information on defaults that can be changed, and how to change them, refer to Fax 
Defaults on page 204).

1. Press the <Services Home> button.

2. Select [Fax].

Tab Setting Item Purpose See Page:

Fax Lighten/Darken To adjust the contrast to make the copy lighter or 
darker than the original.

Page 102

Resolution To set the scan resolution. Page 103

OnHook To send or receive faxes manually. Page 104

2-Sided Scanning To make 2-sided copies with the specified binding 
position.

Page 104

Options Original Size To set the document size. Page 105

Delayed Send To send a fax at a specified time. Page 106

Polling Receive To send a command to a remote device to receive 
a document saved on it.

Page 107

Cover Page To attach a cover page to faxes. Page 107

Services Home

Job Status

Machine Status

<Services Home> button
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3. Make advanced settings as needed.

Lighten/Darken

You can set the density from seven levels.

1. Select [Lighten/Darken] on the [Fax] tab. 

2. Select the density level, and then click [OK]. 

Darken +1, +2, and +3

Creates copies with a dark density. Use this setting to scan document containing light objects.

Normal

Creates copies with the same density as document.

Lighten +1, +2, and +3

Creates copies with a light density. Use this setting to scan document containing dark objects.
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Resolution

Sets the scan resolution.

1. Select [Resolution] on the [Fax] tab.

2. Select the resolution, and then select [OK]. 

Standard

Suitable for documents with normal sized characters.

Fine

Suitable for documents containing small characters or thin lines or documents printed using a dot-matrix 
printer.

Superfine

Suitable for documents containing extremely fine detail. The Super Fine mode is enabled only if the 
remote device also supports the Super Fine resolution.

Note: Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the 
receiving device.

Photo

Suitable for documents containing photographic images.
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OnHook

Use this function to send or receive faxes manually.

Notes:

• For information on how to send a fax manually, refer to Sending a Fax Manually on 
page 108.

• For information on how to receive a fax manually, refer to Receiving a Fax Manually in the 
TEL Mode on page 114 or Receiving a Fax Manually Using an External Telephone on 
page 115.

2-Sided Scanning

You can set to scan a 1-Sided or 2-Sided.

1. Select [2-Sided Scanning] on the [Fax] tab.

2. Select the copy method, and then select [OK]. 

– 1-Sided

Select [1-Sided] for a one-sided document.

– 2-Sided

Select [2-Sided] for a two-sided document.

You can select the edge to be bound from the following.
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– Long Edge Binding

– Short Edge Binding

Original Size

Sets the size of document for fax transmission. The transmission size is automatically specified by the 
document size.

1. Select the [Options] tab, and then select [Original Size]. 

2. Select the document size, and then select [OK]. 

– Auto

If document is a standard size, the device detects the document size automatically. The paper 
size used for sending the fax is determined by the detected document size.

Document Size Paper Size

Fax is Sent AsSize placed on the document glass Size placed in the document feeder

A5 , B5 , A4 *, A4 , 8.5 × 

11" *, 8.5 × 11" , 16K , 16K

A5 , B5 , B5 , A4 *, A4 , 8.5 × 

11" *, 8.5 × 11" , 16K

               A4

B4 , B5 B4                B4
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The image of A4  and 8.5 x 11  documents is rotated by 90 degrees and sent as A4  
documents.

Notes:

• The document size selection screen appears if the device cannot detect the size of a 
document placed on the document glass. Select the desired document size. Depending on 
the selected document size, the printout may be too large for the paper or may have 
shadows at the edges.

• The document feeder does not support the non-standard document sizes.

– Fixed document size (Preset)

You can set the document size of the placed document by selecting from the preset document 
sizes.

Delayed Send

Used to send a document stored in the device at a specified time. 

Notes:

• You can specify a time between 00:00 and 23:59 (or between 1:00 and 12:59 AM/PM when 
the 12-hour clock has been set).

• You cannot specify a date.

1. Select the [Options] tab, and then select [Delayed Send].

2. Select [On].

Note: Select [Off] to disable this function.

A3 , 11 × 17" , 8K A3 , 11 × 17" , 8K , 16K                A3

Document Size Paper Size

Fax is Sent AsSize placed on the document glass Size placed in the document feeder
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3. Use the numeric keypad to enter the time, and then select [OK]. 

Polling Receive

You can receive faxes from the remote fax device when you want to receive it.

1. Select the [Options] tab, and then select [Polling Receive].

2. Select [On], and then select [OK]. 

Cover Page

You can attach a cover page to faxes.

1. Select the [Options] tab, and then select [Cover Page].
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2. Select [On], and then select [OK].

Sending a Fax Manually
This section describes how to send a fax manually.

1. Place document in the device.

2. Press the <Services Home> button.

3. Select [Fax].

4. Adjust the document resolution to suit your fax needs.

Notes:

• For more information, refer to Resolution on page 103.

• For more information, refer to Lighten/Darken on page 102.

5. Select [OnHook], and then select [Manual Send].

Note: [OnHook] can be selected when [Original Size] is set to other than [Auto].

6. Enter the remote fax device's fax number using the number pad.

Services Home

Job Status

Machine Status

<Services Home> button
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You can also select the recipient by using speed dial number or address book.

Notes:

• You can enter a fax number using the ten key, *, and #.

• Pressing the <Redial/Pause> button enables you to enter a pause in the fax number.

• Entering "=" in the fax number enables dial tone detection.

• Entering ":" enables you to switch dialing type from dial pulse (DP) to push button (PB).

7. Press the <Start> button to begin sending the fax.

Note: By pressing the <Stop> button, you can cancel the fax job at any time while sending the fax.

Sending a Delayed Fax
The Delayed Start mode can be used to save scanned documents for transmission at a specified time to 
take advantage of lower long distance rates.

1. Place document in the device.

2. Press the <Services Home> button.

3. Select [Fax].

Services Home

Job Status

Machine Status

<Services Home> button
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4. Adjust the document resolution to suit your fax needs.

Notes:

• For more information, refer to Resolution on page 103.

• For more information, refer to Lighten/Darken on page 102.

5. Select the [Options] tab, and then select [Delayed Send].

6. Select [On].

7. Enter the start time using the number pad, and then select [OK].
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8. Select the [Fax] tab.

9. Enter the fax number of the recipient using the number pad.

You can also use speed or group dial numbers.

10. Press the <Start> button to scan data.

Once Delayed Start mode is activated, the device stores all of the documents to be faxed into its 
memory and sends them at the specified time. After faxing in the Delayed Start mode is complete, the 
data in the memory is cleared.

Note: If you turn off and on the device, the stored documents are sent as soon as the device is 
activated.

Sending a Fax from the Driver (Direct Fax)
You can send a fax directly from the computer running a Microsoft® Windows® operating system or Mac 
OSX by using the driver.

Note: Only black and white faxes can be sent using Direct Fax.

• The names of the dialog boxes and the buttons may be different from those given in the following 
procedure depending on the application you are using.

• For Windows, the fax driver is installed with the PCL 6 driver.

• For Mac OS X, to use this feature, you must install the fax driver. To install the fax driver, run the Driver 
CD Kit on the Mac OS X, and then open the [MacOSX] folder. Open either the [10.5-] folder depending 
on the version of Mac OS X you are running. Double-click [FX DocuCentre SC2020.dmg], and then 
follow the on-screen instructions to install the fax driver.

1. Open the file you want to send by fax.

2. Open the print dialog box from the application, and then select your printer name.

3. Click [Preferences] in Windows, or select [FAX Setting] in Mac OS X.
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For Windows

For Mac OS X:

4. Specify the fax settings. For more information, refer to the Help of the driver.

Notes:

• For Windows, make sure to set [Job Type] to [Fax].

• The settings done here are only applied to a single fax job.

For Windows:
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For Mac OS X:

5. For Windows, click [OK] to close the [Printing Preferences] dialog box, and then click [Print].

The [Recipient Setting] dialog box appears.

For Mac OS X, click [Print]. The [Set/Check Fax Transmission] dialog box appears.

For Windows:

For Mac OS X:

6. Specify the destination for the recipient in one of the following ways. For more information on how to 
specify the destination, refer to the Help of the driver.

7. Enter the name and fax number directly.

8. Select a fax number from the address book.

– Look Up Address Book: Displays a list of fax numbers that are saved in the file specified for [My 
Address Book file].
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– Import and add file (Windows only): Allows you to select a source file such as a CSV file, WAB file, 
MAPI, or a LDAP server. (For more information on LDAP server, refer to Fax Server Address Book on 
page 179.

Note: Enter the password in [Passcode] in Windows or [Password] in Mac OS X in the [Authorization] 
area before sending a fax if the Fax service is locked with a password.

Receiving a Fax
This section describes the fax receiving modes and the other ways to receive a fax.

About Receiving Modes
Note: To use the device in the TEL/FAX Mode or Ans/FAX Mode, connect an external telephone to the 
TEL connector at the rear of the device.

When the memory is full, you cannot receive a fax automatically. Use an external telephone to receive a 
fax manually.

For more information, refer to Receiving a Fax Manually Using an External Telephone on page 115.

Loading Paper for Receiving Faxes

The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or 
copying, except that faxes can only be printed on Letter-sized, A4-sized, or Legal-sized paper.

Receiving a Fax Automatically in the FAX Mode

The device is preset to the FAX Mode at the factory.

If you receive a fax, the device automatically goes into the FAX Mode after a specified period of time and 
receives the fax.

To change the interval at which the device goes into the FAX Mode after receiving an incoming call, refer to 
Incoming Defaults on page 168.

Receiving a Fax Manually in the TEL Mode

You can receive a fax by picking up the handset of the external telephone and then pressing the remote 
receive code (refer to Remote Receive on page 171, or by selecting [Manual Receive] in [OnHook] (you can 
hear voice or fax tones from the remote device) and then pressing the <Start> button.

The device begins receiving a fax and returns to the standby mode when the reception is completed.
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Receiving a Fax Automatically in the TEL/FAX Mode or Ans/FAX 
Mode

To use the TEL/FAX Mode or Ans/FAX Mode, you must connect an external telephone to the TEL connector 
on the rear of the device.

If the device hears a fax tone on the line, it automatically starts to receive a fax.

Note: If you have set the device to Ans/FAX Mode and if you do not answer the external telephone, 
the device will automatically go into the FAX Mode after a predefined time.

Receiving a Fax Manually Using an External Telephone

This feature works best when you are using an external telephone connected to the TEL connector on the 
rear of the device. You can receive a fax from someone you are talking to on the external telephone 
without having to go to the device.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the 
external telephone, or select [Manual Receive] in [OnHook] and then press the <Start> button.

The device receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote device, try pressing the 
two-digit keys once again.

The remote receive code is set to [Off] at the factory. You can change the two-digit number to whatever 
you choose. For details on changing the code, refer to Remote Receive on page 171.

Note: Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD Mode

The Distinctive Ring Pattern Detection (DRPD) is a telephone company service which enables a user to use 
a single telephone line to answer several different telephone numbers. The particular number someone 
uses to call you on is identified by different ringing patterns, which consist of various combinations of long 
and short ringing sounds.

Before using the DRPD option, Distinctive Ring service must be installed on your telephone line by the 
telephone company. To set up DRPD, you will need another telephone line at your location, or someone 
available to dial your fax number from outside.
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To set up the DRPD:

1. Press the <Machine Status> button.

2. Select the [Tools] tab, and then select [Admin Settings].

3. Select [Fax Settings].

4. Select [Fax Line Settings].

Services Home

Job Status

Machine Status

<Machine Status> button
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5. Select [ ] until [DRPD Pattern] appears, and then select [DRPD Pattern].

6. Select the desired pattern, and then select [OK].

7. Reboot the device by turning the power switch off and then on again.

Receiving Faxes in the Memory

Since the device is a multi-tasking device, it can receive faxes while you are making copies or printing. If 
you receive a fax while you are copying, printing, or run out of paper or toner, the device stores incoming 
faxes in the memory. Then, as soon as you finish copying, printing, or re-supply the toner cartridges, the 
device automatically prints the fax.

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on 
the secure fax mode using the [Secure Receive] option to restrict printing out all of the received faxes when 
the device is unattended. In the secure receiving mode, all incoming faxes will go in memory. When the 
mode turns off, any faxes stored will be printed.

Note: Before operation, ensure [Panel Lock] is enabled.
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To turn the secure receiving mode on:

1. Press the <Machine Status> button.

2. Select the [Tools] tab, and then select [Admin Settings].

3. Select [Fax Settings].

4. Select [Incoming Defaults].

5. Select [Secure Receive].

Services Home

Job Status

Machine Status

<Machine Status> button
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6. Select [Secure Receive Set].

7. Select [Enable], and then select [OK].

8. Enter a four-digit password using the number pad, and then select [OK].

To return to the top level of the System menu, press the <Clear All> button.

When a fax is received in the secure receiving mode, the device stores it into memory and the Active 
Jobs screen displays [Secure Receive] to let you know that there is a fax stored.

To print received documents:

1. Press the <Job Status> button.

2. Select [Secure Fax Receive].

3. Enter the passcode, and then select [OK].

The faxes stored in memory are printed.

Services Home

Job Status

Machine Status

<Job Status> button
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To turn the secure receiving mode off:

1. Access the [Secure Receive Set] menu by following steps from 1 to 6 in To turn the secure receiving 
mode on: on page 118.

2. Select [Disable], and then select [OK].

To return to the top level of the System menu, press the <Clear All> button.

Fax Activity Report
Fax Activity Report lets you check whether fax send and receive operations ended normally. For each fax 
sent or received, the reports record the sender or recipient name and the transmission result/status.

For information on how to print the Fax Activity Report, refer to Printing Reports/Lists on page 232.
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Item Description

Sent No. The serial number of each outgoing fax.

Job# A document number appended automatically when the fax job is 
received.

Remote 
Terminal

The sender's information, in the following priority order:
1. Name registered in Speed Dial number2/22/16(Only when the 

recipient has a registered Speed Dial number.)
2. Phone number used when all digits are dialed
3. Remote ID
4. Communication mode
The Remote ID is the phone number sent by the recipient.

Start Time The time at which transmission began.
For a fax broadcast, the time at which the first transmission started.

Dura. The amount of time that was required from transmission start to end. 
For a fax broadcast, this is the total transmission time for all recipients.

Pages The number of pages sent.
The number on the left of the slash (/) is the number of pages sent 
normally. The number on the right of the slash(/) is the total number of 
scanned pages.
This is left empty for fax broadcasts.

Mode The mode used for the transmission.
G3, SG3, ECM, *G3, *SG3, *ECM (The asterisks indicate that the 
transmitted data was converted to monochrome), or blank (no 
information)

Contents The transmission content.
Resend (resent fax), Broadcast (fax broadcast), Forward (forwarded fax), 
or blank (normal transmission)

Result The transmission result.
Done (normal end), Busy (recipient line was busy or the set number of 
Redials was exceeded), Auto Resend (Job is set to be resent, and the 
resending count is within the limit), Cancelled (job was cancelled), Conf. 
Partner (the destination is unable to receive the job), Send Again (the 
resending count exceeded the limit), XXX-XXX (communication error)
• "Cancelled" indicates that the user cancelled the job.
• "XXX-XXX" indicates an error code.

Total The total number of pages sent.
Xerox® DocuCentre® SC2020
User Guide

121



Fax
Received No. The serial number of each incoming fax.

Job# A document number appended automatically when the fax job is 
received.

Remote 
Terminal

The sender's information, in the following priority order:
5. Remote ID
6. Communication mode
Remote ID is the sender's phone number.

Start Time The time at which the incoming fax was received.

Dura. The amount of time that was required from transmission start to end.

Pages The number of pages received.

Mode The mode used for the transmission.
G3, SG3, ECM, *G3, *SG3, *ECM (The asterisks indicate that the 
transmitted data was converted to monochrome), or blank (no 
information)

Contents The transmission content.
Polling (incoming Remote Polling), Forward (forwarded fax), [blank] 
(normal transmission)

Result The transmission result.
Done (normal end), Print Queue (normally received job is not printed), 
Deleted (normally received job is deleted before printing), Cancelled 
(user cancelled the job), Receive Again (reception error), Fwd Wait (job is 
waiting to be forwarded), Fwd Doing (job is being forwarded), Fwd Done 
(job is completely forwarded), XXX-XXX (transmission error)
• "XXX-XXX" indicates an error code.

Total The total number of pages received.

Item Description
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Scan

This chapter describes the print function.

Scanning Procedure
This section describes the basic flow of scan operations including placing document in the device and 
making advanced settings.

Placing the Document

The following two methods are available to load documents:

• Document feeder

– Single sheet

– Multiple sheets

• Document glass

– Single sheet

– Bound documents, such as books

Document Feeder

Supported document sizes

You can place the standard size document in the document feeder.

When document is placed in the document feeder, the device detects the document size automatically. 

The following standard size documents are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 *, 

A5 , 11 × 17" , 8.5 × 14" *, 8.5 × 13" *, 8.5 × 11" , 8.5 × 11" , 8K , 16K , and 16K *.

Note: The document sizes with an asterisk can be automatically detected depending on the settings. 
You can select one of the following alternative document sizes. For more information, refer to Original 
Size Detected on page 176.

B5 (default) or 16K
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8.5 × 14" (default) or 8.5 × 13"

Notes:

• When a document containing pages of different sizes is placed in the device, the device uses 
the largest document size to scan the document.

• When using 2-sided document placed in the document feeder, make sure to set [2-Sided 
Scanning] properly. If it is not specified and the scanned orientation needs to be corrected, 
rotate it on your computer.

• For scanning to an application on the client, the document sizes are not automatically 
detected. Specify the document size manually.

Selectable document sizes in the scan driver

A3 (297 × 420 mm), A4 (210 × 297 mm), A5 (148 × 210 mm), B4 (257 × 364 mm), B5 (182 × 257 mm), 8.5 
× 11", 8.5 × 14", 11 × 17", 7.25 × 10.5", and Custom.

Supported documents types (weights)

Documents with weights from 38–128 g/m2 (50–128 g/m2 for 2-Sided documents) can be placed in the 
document feeder and scanned.

The document feeder accepts the following number of sheets

To avoid paper jams, use the document glass for mixed size, folded, wrinkled, cut-and-pasted documents, 
curled paper, or carbon-backed paper. If you can flatten the curled document, you can use the document.

Follow the steps below to place document on the document feeder.

You can place a single or multiple pages of a document.

1. Remove any paper clips or staples from document before placing it in the document feeder.

2. Place the document in the center of the document feeder, with the side to be scanned (or the front 
surface of a 2-Sided document) facing up. 

Document Type (g/m2) Number of Sheets

Lightweight (38–80 g/m2) 110 sheets

Heavyweight (81–128 g/m2) 75 sheets
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3. Align the document guides to each side of the document.

4. Open the document stopper. 

Document Glass

Document sizes supporting automatic detection

The document size is detected automatically when [Original Size] is set to [Auto].

The following document sizes are detected automatically: A3 , B4 , A4 , A4 , B5 , B5 , A5 , 11 × 

17" , 8.5 × 11" , 8K , 16K , and 16K .

Supported document sizes

You can select one of the following document sizes from [Original Size].

A3 , B4 , A4 , A4 , B5 , B5 , A5 , 11 × 17" , 8.5 × 14" , 8.5 × 13" , 8.5 × 11" , 8.5 × 11" , 

8K , 16K , and 16K .

Note: When [Original Size] is set to [Auto], an error screen appears when you place a non-standard size 
document on the document glass. In this case, select a document size manually by selecting [Original 
Size] from the menu items. Depending on the selected document size, the printout may be too large 
for the paper or may have shadows at the edges.
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Selectable document sizes in the scan driver

A3 (297 × 420 mm), A4 (210 × 297 mm), A5 (148 × 210 mm), B4 (257 × 364 mm), B5 (182 × 257 mm), 8.5 
× 11", 8.5 × 14", 11 × 17", 7.25 × 10.5", and Custom.

WARNING: Do not apply excessive force to hold thick document on the document glass. It may break the 
glass and cause injuries.

Follow the steps below to place document on the document glass.

You can place a single sheet document or bound document such as book on the document glass.

1. Open the document glass cover.

When using the document glass, make sure to close the document glass cover after finishing your 
scan job.

2. Place the document face down, and align it against the top left corner of the document glass. 

3. Close the document glass cover.
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Using the Scan Feature

You can select the scan functions from the following list.

Note: The file name of the scanned data appears in the format [YYMMDDHHMMSS.extension]. Here, 
YY = Year (4 digits), MM = Month (2 digits), DD = Day (2 digits), HH = Hour (2 digits), MM = Minutes (2 
digits), and SS = Seconds (2 digits).

Scanning to a Computer
This section describes how to scan document to a computer.

Scanning From the Control Panel - WSD Scan

If the device is connected to a computer via network using WSD (Web Services on Devices), you can use the 
WSD Scan function to send scanned images to a computer.

The following procedure uses Windows 7 as an example.

Notes:

• To use WSD Scan, you need to setup connection using WSD.

• WSD* is supported only on Windows Vista®, Windows 7, and Windows 8.

Printer Setup for WSD Scan

Setup the device and computer for connection using WSD.

Checking the Printer Setting

To use the WSD Scan function, [WSD Scan] needs to be set to [Enable]. For more information, refer to 
Protocols on page 162.

Setting Up the Computer

Note: For Windows 8, the computer automatically connects the device using WSD. There is no need to 
install the device manually.

For Windows 7:

1. Click [Start] > [Computer] > [Network].

Scan Function See Page

Scanning to a Computer Page 128

Using a Scanner on the Network Page 131

Sending an Email With the Scanned Image Page 143
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2. Right-click the icon for the device, and then click [Install].

The device is connected using WSD.

For Windows Vista:

1. Click [Start] > [Network].

2. Right-click the icon for the device, and then click [Install].

3. Click [Continue].

The device is connected using WSD.

Procedures for WSD Scan
1. Place document in the device.

2. Press the <Services Home> button.

3. Select [Scan to].

4. Select [WSD].

5. Select [ ] until the desired computer you want to send the scan job to appears, and then select that 
computer.

6. Select [Event], and specify the type of scan such as [Scan] and [Scan To Email].

7. Press the <Start> button to begin sending the scanned file.

Scanning Using the TWAIN Driver

The device supports the TWAIN driver for scanning images. The following procedure uses Windows 7 as an 
example. The procedure differs depending on the OS and Microsoft Office version.

Note: Ensure that the device is connected to the computer via the USB cable.

The following procedure to scan an image uses Clip Organizer as an example.

1. Place document in the device.

2. Click [Start] > [All Programs] > [Microsoft Office] > [Microsoft Office 2010 Tools] > [Microsoft Clip 
Organizer].

3. Click [File] > [Add Clips to Organizer] > [From Scanner or Camera].

4. In the [Insert Picture from Scanner or Camera] dialog box, under [Device], select your device.

5. Click [Custom Insert].
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6. Select your scanning preferences and click [Preview] to display the preview image.

Notes:

• [Preview] is grayed out and disabled when you select [Document Feeder] from [Scan from].

• The illustration may vary for different operating systems.

7. Select the desired properties from the [Image Quality] and [Image Options] tabs.

8. Click [Scan] to start scanning.

The scanned image file is generated.

Scanning Using the WIA Driver

The device also supports the WIA (Windows Image Acquisition) driver for scanning images. WIA is one of 
the standard components in Windows operating systems and works with digital cameras and scanners. 
Unlike the TWAIN driver, the WIA driver allows you to scan an image and easily manipulate those images 
without using additional software.

Notes:

• Ensure that the device is connected to the computer via the USB cable.

• The WIA (Windows Image Acquisition) driver is supported only on Windows.

To Scan an Image From the Drawing Software
1. Place document in the device.

2. Start the drawing software, such as Paint for Windows.

Notes:

• When you use Windows Vista, use Windows Photo Gallery instead of Paint.

• When using applications that use WIA 2.0, such as [Windows Fax and Scan] on Windows 
Vista, Windows 7, Windows 8, and Windows 10, the [Feeder (Scan both sides)] option can be 
selected for 2-sided scanning.
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3. Click [Paint] > [From scanner or camera] (Click [File] > [From Scanner or Camera] for Windows Server 
2008 and Windows Vista.

The [Scan using FX DocuCentre SC2020 (WIA - USB)] window appears..

Note: The illustration may vary for different operating systems

4. Select [Document Feeder] or [Flatbed] in [Paper source].

Note: Select [Document Feeder] when you want to scan the document loaded in the document feeder. 
Select [Flatbed] when you want to scan the document loaded on the document glass.

5. Select your scanning preferences and click [Adjust the quality of the scanned picture] to display the 
[Advanced Properties] dialog box.

6. Select the desired properties including brightness and contrast, and then click [OK].

7. Click [Scan] to start scanning.

8. Click [Save] from the [Paint] menu.

9. Enter a picture name, and select a file format and destination to save the picture.

Using a Scanner on the Network
This section describes how to use a scanner on the network.

Note: This feature does not require a network scan driver.
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Overview

The Scan to Server/Computer feature allows you to scan documents and send the scanned document to a 
network computer via the FTP or SMB protocol.

You can select the kind of server and specify a destination to store the scanned document with the 
CentreWare Internet Services or Address Book Editor.

The following items are required to use the Scan to Server/Computer feature.

• Using SMB

To transfer data via SMB, your computer must run on one of the following operating systems that 
includes folder sharing.

– For Mac OS X, a shared user account is required.

– Mac OS X 10.6–11

– Windows Server 2008

– Windows Server 2008 R2

– Windows Server 2012

– Windows Server 2012 R2

– Windows Vista

– Windows 7

– Windows 8

– Windows 10

• Using FTP

To transfer data via FTP, one of the following FTP servers and an account to the FTP server (login 
name and password) are required.

– Windows Vista 

– FTP service of Microsoft Internet Information Services 5.1

– FTP service of Microsoft Internet Information Services 6.0

– Windows Vista, Windows Server 2008

– FTP service of Microsoft Internet Information Services 7.0

Scan

Using FTP

Using SMB

FTP Server

Computer

Computer
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– Windows 7, Windows Server 2008 R2

– FTP service of Microsoft Internet Information Services 7.5

– Windows 8, Windows Server 2012

– FTP service of Microsoft Internet Information Services 8.0

– Windows 8.1, Windows Server 2012 R2

– FTP service of Microsoft Internet Information Services 10

– Windows 10

– Mac OS X 10.6–10.11

– FTP service of Mac OS X

For information on how to configure the FTP service, contact your system administrator.

Follow the procedure below to use the Scan to Server/Computer feature.

For SMB:

For FTP:

Setting a Login Name and a Password (SMB Only)

The Scan to Computer/Server feature requires a user login account with a valid and non-empty password 
for authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password on your User Login 
Account. The following uses Windows 7 as an example. The procedure differs depending on the OS.

1. Click [Start] > [Control Panel].

2. Click [User Accounts and Family Safety].

3. Click [User Accounts].

4. Click [Create a password for your account] and add in a password for your user login account.

Step Procedure See Page

1 Setting a Login Name and a Password (SMB 
Only)

Page 133

2 Creating a Shared Folder (SMB Only) Page 134

3 Setting a Destination Using an Address Book Page 135

4 Sending the Scanned File on the Network Page 141

Step Procedure See Page

1 Setting a Destination Using an Address Book Page 135

2 Sending the Scanned File on the Network Page 141
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Creating a Shared Folder (SMB Only)

Share a folder to store the scanned document using the following procedure.

The following uses Windows 7 as an example. The procedure differs depending on the OS.

1. Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2. Right-click the folder, and then select [Properties].

3. Click the [Sharing] tab, and then click [Advanced Sharing].

For Windows Vista, when the [User Account Control] dialog box appears, click [Continue].

4. Select the [Share this folder] check box.

5. Enter a shared name in the [Share name] box.

Note: Write down this shared name because you will use this name in the next setting procedure

6. Click [Add].
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7. Search user login name by clicking [Advanced], or enter the user login name in the [Enter the object 
names to select] box and click [Check Names] to confirm (Example of user login name: MySelf).

8. Click [OK].

9. Click the user login name that you have just entered. Select the [Full Control] check box. This will grant 
you permission to send the document into this folder.

Note: Do not use [Everyone] as the user login name.

10. Click [OK].

11. Click [OK] to exit the [Advanced Sharing] dialog box.

12. Click [Close].

Notes:

• To add sub-folders, create new folders in the shared folder you have created.

• Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: 
John

• You should now see MyShare\MyPic\John in your directory.

After you created a folder, go to Setting a Destination Using an Address Book on page 135.

Setting a Destination Using an Address Book

You can configure the device settings to use the Scan to Server/Computer feature with the CentreWare 
Internet Services or Address Book Editor.

The following procedure uses Windows 7 as an example. The procedure differs depending on the OS.

Before beginning to setup a destination, make sure you have the IP addresses you need such as device and 
computer.
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Using CentreWare Internet Services
1. Launch your web browser.

2. Enter the IP address of the device in the address bar, and then press the <Enter> key.

The device's web page appears.

3. Click the [Address Book] tab.

If user name and password are required, enter the correct user name and password.

Note: The default user name is "admin", and the default password is "1111".

4. Under [Network Scan (Comp./Serv.)], click [Computer/Server Address Book].

5. Select any unused number and click [Add].
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The [Add Network Scan Address] page appears.

To fill in the fields, enter the information as follows:

1 Name 
(Displayed on 
Printer)

Enter a friendly name that you want it to appear on the [Computer/Server 
Address Book].

2 Server Type Select [Computer (SMB)] if you store the document in a shared folder of 
your computer.
Select [Server (FTP)] if you use an FTP server.

3 Host Address (IP 
Address or DNS 
Name)

Enter a server name or IP address of your computer or the FTP server that 
you have shared out.
The following are examples:
• For [Computer (SMB)]:
• Server name: myhost
• IP address: 192.168.1.100
• For [Server (FTP)]:
• Server name: myhost.example.com
• (myhost: host name, example.com: domain name)
• IP address: 192.168.1.100

4 Port Number Enter the port number. If you are unsure, you can enter the default value of 
139 for SMB and 21 for FTP.

5 Login Name (if 
required by host)

Enter the user account name that has access to the shared folder on your 
computer or FTP server.

6 Login Password Enter the password corresponding to the above login name.

Note: Empty password is not valid in the Scan to Computer feature. Ensure 
that you have a valid password for the user login account. (Refer to Setting 
a Login Name and a Password (SMB Only) on page 133 for details on how 
to add a password in your user login account.)

7 Re-enter 
Password

Re-enter your password.

1

2

3

4

5

6

7

9

8
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Using Address Book Editor

The following procedure uses Windows 7 as an example.

Note: If the [Address Book Editor] window appears, go to step 4.

1. Select your printer from the list.

2. Click [OK].

8 Name of Shared 
Directory

For [Computer (SMB)] only.
On the Windows operating system, enter the share name of the folder to 
store the scanned document on the recipient computer.
On the Mac OS X, enter the folder name to store the scanned document on 
the recipient computer.

9 Subdirectory 
Path (optional)

For [Computer (SMB)]
To store the scanned document in the shared folder directly without 
creating any subfolder, leave the space blank.
To store the scanned document in the folder you created under the shared 
folder, enter the path as following.
Example: Share Folder name: "MyShare", Second-level folder name: "MyPic", 
Third-level folder name: "John"
You should now see "MyShare\Mypic\John" in your directory.

In this case, enter the following item.
Server Path: \MyPic\John
For [Server (FTP)]
Enter the server path to store the scanned document.

MyShare (Share folder)

MyPic

John
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3. Click [Tool] > [New (Printer Address Book)] > [Server].

The [Server Address] dialog box appears.

4. To fill in the fields, enter the information as follows:

1 Name Enter a friendly name that you want it to appear on the address book.

2 Server Type Select [Computer (SMB)] if you store the document in a shared folder of 
your computer.
Select [Server (FTP)] if you use an FTP server.

1

2

3

4

5

6

7

8

9

10
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3 Computer 
Settings wizard

Clicking this button opens the wizard screen which guides you through 
several steps.
When you complete the steps in the wizard, the settings for [Server Address] 
are automatically configured.

4 Server Name/IP 
Address

Enter a server name or IP address of your computer or the FTP server that 
you have shared out.
The following are examples:
• For [Computer (SMB)]:
• Server name: myhost
• IP address: 192.168.1.100
• For [Server (FTP)]:
• Server name: myhost.example.com
• (myhost: host name, example.com: domain name)
• IP address: 192.168.1.100

5 Share Name Enter the name of the shared folder on the recipient computer. For SMB 
only.

6 Path For [Computer (SMB)]
To store the scanned document in the shared folder directly without creating 
any subfolder, leave the space blank.
To store the scanned document in the folder you created under the shared 
folder, enter the path as following.
Example: Share Folder name: "MyShare", Second-level folder name: "MyPic", 
Third-level folder name: "John"
You should now see "MyShare\MyPic\John" in your directory.

In this case, enter the following item.
Path: \MyPic\John
For [Server (FTP)]
Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on your 
computer or FTP server.

8 Login Password Enter the password corresponding to the above login name.

Note: Empty password is not valid in the Scan to Computer feature. Ensure 
that you have a valid password for the user login account. (Refer to Setting a 
Login Name and a Password (SMB Only) on page 133 for details on how to 
add a password in your user login account).

9 Confirm Login 
Password

Re-enter your password.

MyShare (Share folder)

MyPic

John
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After you configured settings, go to Sending the Scanned File on the Network on page 141.

Sending the Scanned File on the Network
1. Place document in the device.

2. Press the <Services Home> button.

3. Select [Scan to].

4. Select [Network].

5. Select [ ] until the desired address appears and then select that address.

6. Select [OK].

7. Specify scan options such as [Output Color], [Resolution], [2-Sided Scanning], and [File Format] on the 
[Scan to Network], [Quality] and [Options] tabs. For more information, refer to File Format on 
page 198.

8. Press the <Start> button to begin sending the scanned file.

Sending an Email With the Scanned Image

To send an Email attached with the scanned image from the device, follow the steps below:

• Setup the Email address book through CentreWare Internet Services. For more information, refer to 
Registering a New Email Address on page 142.

EMail Settings
1. From CentreWare Internet Services, click [Properties].

10 Port Number Enter the port number. If you are unsure, you can enter the default value of 
139 for SMB and 21 for FTP.
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2. Click [Email].

3. Specify the settings for Email as follows:

[SMTP Server Address]: Enter the IP address of the Email server.

[EMail Send Authentication]: Specify [Invalid] to enable the Email server.

Note: If an error message including 016–506 or 016–764 is displayed, contact your server 
administrator for the settings for [Email Send Authentication].

4. Click [Apply].

Registering a New Email Address

The following procedure uses Windows 7 as an example.

1. Launch your web browser.

2. Enter the IP address of the device in the address bar, and then press the <Enter> key.

The device web page appears.

Note: For information on how to check the IP address of the device, refer to Checking the Device IP 
Address on page 230.

3. Click the [Address Book] tab.
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If user name and password are required, enter the correct user name and password.

Note: The default user name is "admin", and the default password is "1111".

4. Click [Email Address Book].

5. Select any unused number and click [Add].

The [Add Email Address] page appears.

6. Enter a name in the [Name] field and Email address in the [Email Address] field.

7. Click the [Apply] button.

Sending an Email With the Scanned File
1. Place document in the device.
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2. Press the <Services Home> button.

3. Select [Email].

4. Specify a recipient from the following, and then select [OK]:

[New Recipient]: Enter an email address directly.

[Address Book]: Select from the following types of address books:

• [Device Address Book - Individuals]: Select an email address registered in the address book.

• [Device Address Book - Groups]: Select a group of emails registered in the address book.

• [Search Network Address Book]: Search an email address from the LDAP server address book.

Select the recipient you specified from the [New Recipient] to remove or edit the recipient.

Select the recipient you specified from the [Address Book] to remove or see details of the recipient. 
You can also change the email to Bcc.

5. Specify scan options such as [Output Color], [Resolution], [2-Sided Scanning], and [File Format] on the 
[Quality] and [Options] tabs. For more information, refer to File Format on page 198.

Notes:

• Users need to be registered in the Email address book before you can select [Address Book] 
on the control panel.

• If you are using the LDAP server address book, [Email Server Address Book] must be set to 
[On]. For more information, refer to Email Server Address Book on page 179.

6. Press the <Start> button to send email.

Operations during Scanning

While the device is scanning document, you can cancel the currently executing job, and check or cancel the 
pending jobs.

Canceling the Current Scan Job

To cancel the currently scanning job:

On the device

Press the <Stop> button. 

On the computer

Select [Delete] on the screen that appears while scanning.

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Stop> button
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Checking Job Status

To check the status of the currently executing or the previously scanned job:

Notes:

• You can cancel the currently executing scan job.

• For more information on operation in job screen, refer to Canceling the Current Job on 
page 235.

1. Press the <Job Status> button.

2. Check the job status.

Advanced Scanner Settings

This section describes the advanced functions available for Scan feature.

For more information on the setting values, refer to Scan Defaults on page 198.

Scan to Email

Tab Setting Item Purpose
See2/22/1
6Page:

Quality Output Color To select the mode for color or black and white 
scanning.

Page 199

Resolution To adjust the resolution of the scanned image. Page 199

Lighten/Darken To adjust the contrast to make the scanned image 
lighter or darker than the original.

Page 201

Sharpness To adjust the sharpness to make the scanned image 
sharper or softer than the original.

Page 201

Contrast To adjust the amount of colors to make the contrast of 
colors darker or lighter than the original.

Page 201

Auto 
Background 
Suppression

To suppress the background of the original to enhance 
text on the scanned image.

Page 202

Services Home

Job Status

Machine Status

<Job Status> button
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Options 2-Sided 
Scanning

To scan both sides of a sheet of paper. Page 201

File Format To specify the file format. Page 198

Original Size To select the default document size. Page 199

Edge Erase To specify the top and bottom margins of the scanned 
image.

Page 202

File Name To specify the detailed setting for file name. Page 203

Tab Setting Item Purpose
See2/22/1
6Page:
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Scan To Network

Note: For more information on defaults that can be changed, and how to change them, refer to Scan 
Defaults on page 198.

Tab Setting Item Purpose
See2/22/
16Page:

Scan To 
Network

Output Color To select the mode for color or black and white scanning. Page 199

Resolution To adjust the resolution of the scanned image. Page 199

File Format To specify the file format. Page 198

2-Sided 
Scanning

To scan both sides of a sheet of paper. Page 201

Quality Lighten/Darken To adjust the contrast to make the scanned image lighter 
or darker than the original.

Page 201

Sharpness To adjust the sharpness to make the scanned image 
sharper or softer than the original.

Page 201

Contrast To adjust the amount of colors to make the contrast of 
colors darker or lighter than the original.

Page 201

Auto 
Background 
Suppression

To suppress the background of the original to enhance 
text on the scanned image.

Page 202

Options Original Size To select the default document size. Page 199

Edge Erase To specify the top and bottom margins of the scanned 
image.

Page 202

File Name To specify the detailed setting for file name. Page 203

Create Folder To specify whether to create a folder when saving 
scanned images.

Page 203
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Print

This chapter describes how to print using the print driver.

Major Print Driver Functions
This section describes the major print driver functions used for printing. The print driver must be installed 
before use.

Notes:

• For information on how to install the print driver, refer to Installing the Print Driver/Scan 
Driver on page 39.

• For information on the Print functions, click [Help] in the print driver screen to display the 
Help Information.

• There are some functions that adding the mounted component information to the print 
driver from the [Properties] screen under the [Options] tab is required to make the functions 
available. Any functions not displayed on the screen are not available.

• For information on how to set the option information, refer to Setting the Options 
Configuration on page 53.

• Multiple-Up: Prints a multiple-page document on a single page.

• 2-Sided Print: Prints on both sides of each page.

• Poster: Enlarges one page of print data to the specified size and prints it on multiple pages. Used to 
create a large poster.

• Booklet: 2-Sided printing combined with page collation to enable the creation of booklets with the 
correct page sequence.

• Watermark: Prints 'Confidential' or another preset character string on top of print data.

• Mixed Document: Prints documents containing both vertical and horizontal pages, or pages of 
different sizes.

Printing
This section describes how to print document.

The procedure used to print will vary according to the application you are using. See your application's 
manual for the specific procedure.
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The steps below are the operation used for the [DocuCentre SC2020] print driver screen.

1. Select [Print] from the application's [File] menu.

2. Select [DocuCentre SC2020 PCL 6].

3. If needed, click [Properties] to make advanced settings.

Note: For information on the Print functions, click [Help] in the print driver screen to display the Help 
Information.

4. Click [OK].

5. Click [OK] in the [Print] dialog box. 

Operations during Printing
You can cancel the currently printing job.

Stopping the Print Job

To cancel the currently printing job:

On the device
1. Press the <Stop> button, or select [Delete] on the touch screen.

Power SaverRedial/Pause

Data Error

Clear All Stop

Start

<Stop> button
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On the computer

1. Double-click the printer icon  located on the task bar in the lower right corner of the screen.

2. Select the document name that you desired to cancel, and then press the <Delete> key. 

If there is no document displayed on the window, cancel it manually on the device.
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Tools

Each function is set to the factory default (initial) settings, but you can customize these settings to match 
your operating environment. You can change the settings in [Tools].

Note: Some settings cannot be displayed on some models. An optional component is required. For 
more information, contact our Customer Support Center.

This chapter describes the functions you can make settings changes for.

Understanding the Device Menus
When the device is connected to a network and available to a number of users, the access to the [Admin 
Settings] can be limited. This prevents other users from using the control panel to inadvertently change a 
user default that has been set by the administrator. 

However, you can use your print driver to override user defaults and select settings for individual print jobs.

Report/List

Use the [Report/List] menu to print various types of reports and lists.

Note: The reports and lists with an asterisk can be printed only when the Fax Kit (optional) is installed.

System Settings

Purpose: To print a list of the current user default values, the installed options, the amount of installed print 
memory, and the status of device supplies.

Panel Settings

Purpose: To print a detailed list of all the settings on the control panel menus.

PCL Fonts List

Purpose: To print a sample of the available PCL fonts.
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Job History

Purpose: To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list 
contains the last 20 jobs.

Error History

Purpose: To print a detailed list of paper jams and fatal errors.

Printer Meter

Purpose: To print the reports for the total number of pages printed.

Demo Page

Purpose: To print a page for testing colors.

Protocol Monitor

Purpose: To print a detailed list of monitored protocols.

Fax Address Book*

Purpose: To print the list of all fax addresses stored as Fax Address Book information.

Email Address Book

Purpose: To print the list of all email addresses stored as Email Address Book information.

Server Address

Purpose: To print the list of all server addresses stored as Server Address information.

Fax Activity*

Purpose: To print the report of faxes you recently received or sent.

Fax Pending*

Purpose: To print the list of status of pending faxes.

Billing Meters

Purpose: To check the total number of printed pages (including the number of the pages of the copied 
documents and received fax documents).
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Values:

Admin Settings

Use the [Admin Settings] menu to configure a variety of device features.

Fax Address Book

Use the [Fax Address Book] menu to configure the individuals and groups settings.

Individuals

Purpose: To store up to 200 frequently dialed numbers in individuals locations.

Groups

Purpose: To create a group of fax destinations and register it under a two-digit dial code. Up to six group 
dial codes can be registered.

PCL Settings

Use the [PCL Settings] menu to change device settings that only affect jobs using the PCL emulation 
printer language.

Note: Bold values are the factory default menu settings.

Paper Tray

Purpose: To specify the default paper tray.

Values:

* [Tray2] is available only when the One Tray Module (Optional) is installed.

Meter1 Displays the total number of color prints.

Meter2 Displays the total number of monochrome prints.

Meter3 Displays the total number of large size color prints. 

Meter4 Displays the total number of color and monochrome prints (Meter 1 
+ Meter 2).

Auto

Tray5 (Bypass)

Tray1

Tray2*
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Output Size

Purpose: To specify the default paper size.

Values:

mm series

* The default for [Output Size] varies depending on region-specific factory.

inch series

 A3 (297 x 420 mm)*

 B4 (257 x 364 mm)

 A4 (210 x 297 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (195 x 270 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

Custom Size Length (x) 297 mm Specifies the 
length of the 
custom size paper.98–432 mm

Width (y) 210 mm Specifies the width 
of the custom size 
paper.89–297 mm

 Tabloid (11 x 17")*

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)
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* The default for [Output Size] varies depending on region-specific factory.

Notes:

• Selecting [Custom Size] for the paper size prompts you to enter a custom length and width.

• When using a non-standard size envelope, specify the size without the flap in [Custom Size].

Orientation

Purpose: To specify how text and graphics are oriented on the page.

Values:

2-Sided Print

Purpose: To specify whether to print on both sides of a sheet of paper.

Values:

 A4 (210 x 297 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (195 x 270 mm)

Custom Size Length (x) 11.7 inch Specifies the 
length of the 
custom size paper.3.9–17.0 inches

Width (y) 8.3 inch Specifies the width 
of the custom size 
paper.3.5–11.7 inches

Portrait Prints text and graphics parallel to the short edge of the 
paper.

Landscape Prints text and graphics parallel to the long edge of the 
paper.

1-Sided - Sets the value in increments of 
1.

2-Sided Binding Edge Long Edge Flip Prints on both sides of a sheet 
of paper to be bound by long 
edge.

Short Edge Flip Prints on both sides of a sheet 
of paper to be bound by short 
edge.
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Font

Purpose: To specify the default font from the fonts registered in the device.

Values:

CG Times LetterGothic CourierPS

CG Times It LetterGothic It CourierPS Ob

CG Times Bd LetterGothic Bd CourierPS Bd

CG Times BdIt Albertus Md CourierPS BdOb

Univers Md Albertus XBd SymbolPS

Univers MdIt Clarendon Cd Palatino Roman

Univers Bd Coronet Palatino It

Univers BdIt Marigold Palatino Bd

Univers MdCd Arial Palatino BdIt

Univers MdCdIt Arial It ITCBookman Lt

Univers BdCd Arial Bd ITCBookman LtIt

Univers BdCdIt Arial BdIt ITCBookmanDm

AntiqueOlv Times New ITCBookmanDm It

AntiqueOlv It Times New It HelveticaNr

AntiqueOlv Bd Times New Bd HelveticaNr Ob

CG Omega Times New BdIt HelveticaNr Bd

CG Omega It Symbol HelveticaNrBdOb

CG Omega Bd Wingdings N C Schbk Roman

CG Omega BdIt Line Printer N C Schbk It

GaramondAntiqua Times Roman N C Schbk Bd

Garamond Krsv Times It N C Schbk BdIt

Garamond Hlb Times Bd ITC A G Go Bk

GaramondKrsvHlb Times BdIt ITC A G Go BkOb

Courier Helvetica ITC A G Go Dm

Courier It Helvetica Ob ITC A G Go DmOb

Courier Bd Helvetica Bd ZapfC MdIt

Courier BdIt Helvetica BdOb ZapfDingbats
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Symbol Set

Purpose: To specify a symbol set for a specified font.

Values:

Font Size

Purpose: To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The 
default is 12.00.

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

Note: The [Font Size] menu is only displayed for typographic fonts.

Font Pitch

Purpose: To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The 
default is 10.00.

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscheduled 
mono spaced fonts, the pitch is displayed, but cannot be changed.

Note: The [Font Pitch] menu is only displayed for fixed or mono spaced fonts.

Form Line

Purpose: To set the number of lines in a page.

ROMAN-8 WIN L1 ISO-6

ISO L1 WIN L2 ISO-11

ISO L2 WIN L5 ISO-15

ISO L5 DESKTOP ISO-17

ISO L6 PS TEXT ISO-21

PC-8 MC TEXT ISO-60

PC-8 DN MS PUB ISO-69

PC-775 MATH-8 WIN 3.0

PC-850 PS MATH WINBALT

PC-852 PI FONT SYMBOL

PC-1004 LEGAL WINGDINGS

PC-8 TK ISO-4 DNGBTSMS
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Values:

Denotes region-specific factory default values.

The device sets the amount of space between each line (vertical line spacing) based on the [Form Line] and 
[Orientation] menu items. Select the correct [Form Line] and [Orientation] before changing [Form Line].

For more information, refer to Orientation on page 156.

Quantity

Purpose: To set the default print quantity, within the range of 1 to 999. The default is 1. (Set the number of 
copies required for a specific job from the print driver. Values selected from the print driver always override 
values selected from the control panel.)

Image Enhance

Purpose: To specify whether to enable the Image Enhance feature, which makes the boundary line 
between black and white smoother to decrease jagged edges and enhance the visual appearance.

Values:

Hex Dump

Purpose: To help isolate the source of a print job problem. With [Hex Dump] selected, all data sent to the 
device is printed in hexadecimal and character representation. Control codes are not executed.

Values:

Draft Mode

Purpose: To save toner by printing in the draft mode. The print quality is reduced when you print in the 
draft mode.

64* (mm series)/

60* (inch series)

Sets the value in increments of 1.

5–128

Off Disables the Image Enhance feature.

On Enables the Image Enhance feature.

Disable Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.
Xerox® DocuCentre® SC2020
User Guide

159



Tools
Values:

Line Termination

Purpose: To add the line termination commands.

Values:

Output Color

Purpose: To specify the color mode to Color or Black and White. This setting is used for a print job that does 
not specify a print mode.

Values:

Ignore Form Feed

Purpose: To specify whether to ignore blank pages that only contain Form Feed control codes.

Values:

Disable Does not print in the draft mode.

Enable Prints in the draft mode.

Off The line termination command is not added.
CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.
CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.
CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.
CR=CR-LF, LF=CR-LF, FF=CR-FF

Black and White Prints in the black and white mode.

Color Prints in the color mode.

Off Disables the Ignore Form Feed feature.

On Enables the Ignore Form Feed feature.
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Network Setup

Use the [Network Setup] menu to change the device settings affecting jobs sent to the device through the 
network.

Note: Bold values are the factory default menu settings.

Ethernet

Purpose: To confirm or specify network settings.

IP Mode

Purpose: To configure the IP mode.

Values:

TCP/IP

Purpose: To configure TCP/IP settings.

Values:

Dual Stack Uses both IPv4 and IPv6 to set the IP address.

IPv4 Mode Uses IPv4 to set the IP address.

IPv6 Mode Uses IPv6 to set the IP address.

Get IP Address DHCP/AutoIP Sets the IP address automatically. A random value in the 
range of "169.254.1.0" to "169.254.254.255" that is not 
currently in use on the network is set as the IP address. 
The subnet mask is set as "255.255.0.0".

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP.

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address 
manually on the control panel.

IP Address When an IP address is being set manually, the IP is 
allocated to the device using the format 
"nnn.nnn.nnn.nnn". Each octet that makes up 
"nnn.nnn.nnn.nnn" is a value in the range of "0" to "254". 
"127" and any value in the range of "224" to "254" cannot 
be specified for the first octet of a gateway address.
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IPsec

Note: IPsec feature is available only when IPsec is enabled on CentreWare Internet Services.

Purpose: Disables IPsec.

Value:

Connection Speed

Note: Connection Speed feature is available only when the device is connected using the network.

Purpose: To specify the communication speed and the duplex settings of Ethernet. The change becomes 
effective after the device is turned off and then on again.

Values:

Protocols

Purpose: To enable or disable each protocol. The change becomes effective after the device is turned off 
and then on again.

Subnet Mask When an IP address is being set manually, the subnet 
mask is specified using the format "nnn.nnn.nnn.nnn". 
Each octet that makes up "nnn.nnn.nnn.nnn" is a value in 
the range of "0" to "255". "255.255.255.255" cannot be 
specified as the subnet mask.

Gateway Address When an IP address is being set manually, the gateway 
address is specified using the format "nnn.nnn.nnn.nnn". 
Each octet that makes up "nnn.nnn.nnn.nnn" is a value in 
the range of "0" to "254. "127" and any value in the range 
of "224" to "254" cannot be specified for the first octet of 
a gateway address.

Disable Disables IPsec.

Auto Detects the Ethernet settings automatically.

10BASE-T Half Uses 10BASE-T Half-duplex.

10BASE-T Full Uses 10BASE-T Full-duplex.

100BASE-TX Half Uses 100BASE-TX Half-duplex.

100BASE-TX Full Uses 100BASE-TX Full-duplex.
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Values:

Note: [HTTP-SSL/TLS] is available only when a certificate is created using CentreWare Internet 
Services. For information on creating a certificate, refer to the online Help of CentreWare Internet 

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable Enables the LPD port.

Port9100 Disable Disables the Port9100 port.

Enable Enables the Port9100 port.

FTP Disable Disables FTP port.

Enable Enables FTP port.

IPP Disable Disables IPP port.

Enable Enables IPP port.

WSD Print Disable Disables WSD print.

Enable Enables WSD print.

WSD Scan Disable Disables WSD scan.

Enable Enables WSD scan.

SNMP UDP Disable Disables the Simple Network Management Protocol 
(SNMP) UDP port.

Enable Enables the SNMP UDP port.

StatusMessenger Disable Disables the Status Messenger feature.

Enable Enables the Status Messenger feature.

InternetServices Disable Disables an access to CentreWare Internet Services 
embedded in the device.

Enable Enables an access to CentreWare Internet Services 
embedded in the device.

Bonjour (mDNS) Disable Disables Bonjour (mDNS).

Enable Enables Bonjour (mDNS).

Telnet Disable Disables Telnet.

Enable Enables Telnet.

Update Address 
Book

Disable Disables Update Address Book.

Enable Enables Update Address Book.

HTTP-SSL/TLS* Disable Disables HTTP-SSL/TLS.

Enable Enables HTTP-SSL/TLS.
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Services.

Advanced Settings

Purpose: To specify advanced network settings.

IP Filter

Note: IP Filter feature is available only when [Protocols] is set to [LPD] or [Port9100].

Purpose: To block data received from certain IP addresses through the network. You can set up to five IP 
addresses. The change becomes effective after the device is turned off and then on again.

Values:

802.1x

Note: 802.1x feature is available only when the device is connected using LAN cable and the 802.1x 
authentication is enabled using CentreWare Internet Services. For information on setting 802.1x, refer 
to the online Help of the CentreWare Internet Services.

Purpose: To disable 802.1x authentication. The change becomes effective after the device is turned off and 
then on again.

Values:

Reset Network Setup

Purpose: To initialize network data stored in non-volatile memory (NVM). After executing this function and 
rebooting the device, all network settings are reset to their default values.

Values:

Delete All Certificates

n (n is 1–5) IP Address Sets the IP address for Filter n.

Subnet Mask Sets the address mask for Filter n.

Mode Not Active Disables the IP Filter feature for Filter 
n.

Accept Accepts an access from the specified 
IP address.

Reject Rejects an access from the specified 
IP address.

Disable Disables 802.1x.

Reset Initializes the network data stored in NVM.
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Purpose: To delete all certificates.

Fax Settings

Use the Fax Settings menu to configure the basic fax settings.

Note: Bold values are the factory default menu settings.

Fax Line Settings

Purpose: To configure basic settings for the fax line.

Fax Number

Purpose: To set the fax number of the device, which will be printed on the header of a fax message.

Region

Purpose: To select the region where the device is used.

Values:

Company Name

Purpose: To set the sender name to be printed on the header on faxes.

Line Type

Purpose: To select the default line type.

Unknown

Australia

China

Hong Kong

Indonesia

Malaysia

New Zealand

Philippines

Singapore

South Korea

Thailand

Vietnam
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Values:

Line Monitor

Purpose: To set the volume of the line monitor, which audibly monitors a transmission through the internal 
speaker until a connection is made.

Values:

• DRPD Pattern

Purpose: To provide a separate number for faxing with a distinctive ring pattern.

PSTN Uses PSTN.

PBX Uses PBX.

Off Turns off the volume of the line monitor.

Min Sets the volume of the line monitor to minimum.

Middle Sets the volume of the line monitor to middle.

Max Sets the volume of the line monitor to maximum.
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Tools
Values:

Extel Hook Threshold

Purpose: To select the external telephone hook detection threshold for the condition in which a telephone 
line is not being used.

Values:

Pattern1–7 DRPD is a service provided by some telephone companies. DRPD patterns 
are specified by your telephone company. The patterns provided with the 
device are shown below:

Ask your telephone company which pattern you need to select to use this 
service. For example, Pattern7 is the New Zealand FaxAbility distinctive 
ringing pattern: rings for 400 ms, stops for 800 ms, rings for 400 ms and 
stops for 1400 ms. This pattern is repeated over and over again. This device 
only responds to Distinctive Alert cadence(s) DA4 in New Zealand.

Lower Sets the external telephone hook detection threshold 
to Lower.

Normal Sets the external telephone hook detection threshold 
to Normal.

Higher Sets the external telephone hook detection threshold 
to Higher.

Pattern1

Pattern2

Pattern3

Pattern4

Pattern5

Pattern6

Pattern7
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Tools
Incoming Defaults

Purpose: To configure settings for incoming fax.

Receive Mode

Purpose: To select the default fax receiving mode.

Values:

Ring Tone Volume

Purpose: To set the volume of the ring tone, which indicates that an incoming call is a telephone call 
through the internal speaker when [Receive Mode] is set to [TEL/FAX Mode].

Values:

Auto Answer Setup

TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up 
the handset of the external phone and then pressing the remote receive 
code, or by selecting [Manual Receive] in [OnHook] to [On] (you can hear 
voice or fax tones from the remote device) and then pressing the <Start> 
button. For more information on [Manual Receive], refer to Receiving a 
Fax Manually in the TEL Mode on page 114.

Fax Mode Automatically receives faxes.

TEL/FAX Mode When the device receives an incoming fax, the external telephone rings 
for the time specified in [Auto Answer TEL/FAX], and then the device 
automatically receives a fax. If an incoming call is not a fax, the device 
beeps from the internal speaker indicating that the call is a telephone 
call.

Ans/FAX Mode This mode is used when this device shares a telephone line with an 
answering device for example. This device monitors fax signals and 
receives faxes, if a fax reception sound is detected. If the phone 
communication in your region is serial, this mode is not supported.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, a 
distinctive ring service must be installed on your telephone line by the 
telephone company. After the telephone company has provided a 
separate number for faxing with a distinctive ring pattern, configure the 
fax setup to monitor for that specific ring pattern.

Off Turns off the volume of the ring tone.

Min Sets the volume of the ring tone to minimum.

Middle Sets the volume of the ring tone to middle.

Max Sets the volume of the ring tone to maximum.
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Tools
Purpose: To configure settings for automatic fax reception.

Values:

Junk Fax Filter

Purpose: To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Fax 
Address Book.

Values:

Secure Receive

Note: Secure Receive feature is available only when [Panel Lock Set] is set to [Enable].

Purpose: To specify whether to require a passcode to receive faxes, and to set or change the passcode.

Values:

* This item is available only when [Secure Receive Set] is set to [Enable].

Auto Answer Fax 0 Sets the interval at which the device goes into the fax 
receive mode after receiving an incoming call. The 
value is set in increments of 1 second.0–255

Auto Answer 
TEL/FAX

6 Sets the interval at which the device goes into the fax 
receive mode after the external telephone receives an 
incoming call. The value is set in increments of 1 
second.

0–255

Auto Answer 
Ans/FAX

21 Sets the interval at which the device goes into the fax 
receive mode after the external answering device 
receives an incoming call. The value is set in 
increments of 1 second.

0–255

Off Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Secure Receive Set Disable Does not require a passcode to 
receive faxes.

Enable Requires a passcode to receive faxes.

Change Passcode* 0000–9999 Sets or changes the passcode 
required to receive faxes.
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Tools
Forward Settings

Notes:

• The [Print and Email] feature is available only when Email information and Forwarding Email 
Address are registered. For information on Email, refer to EMail Settings on page 141 and 
information on Forwarding Email Address, refer to the online Help of CentreWare Internet 
Services.

• The [Forward to Server] and [Print and Forward to Server] features are available only when 
information about shared folders and servers are registered in Forward to Server Settings. For 
more information on shared folders on servers, refer to Using a Scanner on the Network on 
page 131. For more information on Forward to Server Settings, refer to the online Help of 
CentreWare Internet Services.

Purpose: To set whether to forward incoming faxes to a specified destination.

Values:

Receive Size

Purpose: To restrict the paper size incoming faxes are printed.

Values:

Off Does not forward incoming faxes.

Forward Forwards incoming faxes to a specified destination. 
Prints incoming faxes if an error occurs during the 
transfer.

Print and Forward - Prints incoming faxes and also forwards them to a 
specified destination.

Forwarding Number Specifies the fax number of the destination to which 
incoming faxes will be forwarded.

Print and Email Prints incoming faxes and also forward them to a 
specified email address.

Forward to Server Forwards incoming faxes to a specified server.

Print and Forward to Server Prints incoming faxes and also forwards them to a 
specified server.

Auto The device prints incoming faxes by selecting the tray containing the 
paper of the correct size.

A4 The device restricts incoming faxes to A4 size (210 mm width).

A4/B4 The device restricts incoming faxes to A4 size (210 mm width) and B4 
size (257 mm width).

A4/B4/A3 The device restricts incoming faxes to A4 size (210 mm width), B4 size 
(257 mm width), and A3 size (297 mm width).
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Tools
2-Sided Print

Purpose: To set the 2-sided printing for fax.

Values:

Remote Receive

Purpose: To receive a fax by pressing a remote receive code on the external telephone after picking up the 
handset of the telephone.

Values:

Discard Size

Purpose: To set the device to discard images or any text at the bottom of a fax page when the entire page 
does not fit the output paper.

Values:

Transmission Defaults

Purpose: To configure settings for transmitting fax.

Auto Redial Setup

Purpose: To configure settings for automatic redial.

Off Does not perform 2-sided printing.

On Performs 2-sided printing.

Off Does not receive a fax by pressing a remote receive 
code on the external telephone.

On - Receives a fax by pressing a remote receive code on 
the external telephone.

Remote Receive 
Tone

Specifies the tone in two digits to start Remote 
Receive.

Off Prints excess images or text at the bottom of a fax page without 
discarding it.

On Discards any excess images or text.

Auto Reduction Automatically reduces a fax page to fit it onto the appropriate paper size.
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Tools
Values:

Dial Type

Purpose: To select the dialing type.

Values:

Prefix Dial

Purpose: To select whether to set a prefix dial number.

Values:

Fax Cover Page

Purpose: To set whether to attach a cover page to faxes.

Values:

Number of Redial 3 Sets the number of redial attempts to make when the 
destination fax number is busy. If you enter 0, the 
device will not redial. The value is set in increments of 
1.

0–9

Redial Interval 1 Sets the interval between redial attempts. The value is 
set in increments of 1 minute.

1–15

Interval Timer 8 Sets the interval between re-send attempts. The value 
is set in increments of 1 second.

3–255

PB Uses tone dialing.

DP (10PPS) Sets DP (10PPS) (Dial Pulse, 10 Pulse Per Second) as the dial type.

DP (20PPS) Sets DP (20PPS) (Dial Pulse, 20 Pulse Per Second) as the dial type.

Off - Does not set a prefix dial number.

On - Sets a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This 
number dials before any auto dial number is started. It 
is useful for accessing the Private Automatic Branch 
Exchange (PABX).

Off Does not attach a cover page to faxes.

On Attaches a cover page to faxes.
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Tools
Send Header

Purpose: To print the information of the sender on the header of the faxes.

Values:

ECM

Purpose: To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote 
devices must also support the ECM.

Values:

Modem Speed

Purpose: To adjust the fax modem speed when a fax transmission or reception error occurs.

Values:

Display Manual Fax Recipients

Purpose: To set whether to display the fax number of the recipient on the sending fax screen when 
manually sending a fax.

Values:

Fax Reports

Off Does not print the sender's information on the header 
of faxes.

On Prints the sender's information on the header of faxes.

Off Disables the ECM.

On Enables the ECM.

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps

Off Does not display the fax number when manually 
sending a fax.

On Displays the fax number when manually sending a fax.
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Purpose: To configure settings for fax reports.

Fax Activity

Purpose: To set whether to automatically print a Fax Activity Report after every 50 incoming and outgoing 
fax communications.

Values:

Fax Transmit

Purpose: To set whether to print a transmission result after a fax transmission.

Values:

Fax Broadcast

Purpose: To set whether to print a transmission result after a fax transmission to multiple destinations.

Values:

Fax Protocol

Purpose: To set whether to print the protocol monitor report, which helps you identify the cause of a 
communication problem.

Values:

Auto Print Automatically prints a Fax Activity Report after every 50 incoming and 
outgoing fax communications.

No Auto Print Does not automatically print a Fax Activity Report after every 50 
incoming and outgoing fax communications.

Print Always Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always Prints a broadcast report after every fax broadcast.

Print On Error Prints a broadcast report only when an error occurs.

Print Disable Does not print a broadcast report after a fax broadcast to multiple 
destinations.

Print Always Prints a protocol monitor report after every fax transmission.
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Tools
System Settings

Use [System Settings] to configure a variety of device features.

Note: Bold values are the factory default menu settings.

General

Purpose: To configure general settings for the device.

Power Saver

Purpose: To specify the time for transition to Power Saver mode.

Values:

When you specify 1 minutes for [Low Power Timer], the device enters Power Saver mode 1 minutes after it 
finishes a job. This uses much less energy, but requires more warm-up time for the device. Specify 1 
minutes if the device shares an electrical circuit with room lighting and you notice lights flickering.

Select a high value if the device is in constant use. In most circumstances, this keeps the device ready to 
operate with minimum warm-up time. Select a value between 1 and 60 minutes for [Low Power Timer] if 
you want a balance between energy consumption and a shorter warm-up period.

The device automatically returns to the standby mode from the Power Saver mode when it receives data 
from the computer or remote fax device, while keeping the touch screen turned off to save power. Pressing 
the <Power Saver> button on the control panel changes the status of the device to the standby mode and 
lights up the touch screen.

Date & Time

Purpose: To specify the date and time formats.

Values:

Print On Error Prints the protocol monitor report only when an error occurs.

Print Disable Does not print the protocol monitor report.

Low Power Timer 1 min Specifies the time taken by the device to enter Low 
Power mode after it finishes a job.

1–150 min

Sleep Timer 0 min Specifies the time taken by the device to enter Sleep 
mode after it has entered Low Power mode.

0–60 min

Time Zone Sets the time zone.
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Tools
Measurements

Purpose: To specify the default measurement unit displayed after the numeric value on the control panel.

Values:

Original Size Detected

Purpose: To specify the size of paper to be automatically detected when you use standard sizes of a 
document or the device is set to detect sizes of a document.

Note: The settings only affect the scanning from the document feeder.

Values:

Display Brightness

Purpose: To adjust the screen brightness of the control panel.

Date - Sets the date depending on the [Format] settings.

Format YYYY/MM/DD Sets the date format.

DD/MM/YYYY

MM/DD/YYYY

Time - Sets the time.

Format 12 Hour Sets the time in 12-hour format.

24 Hour Sets the time in 24-hour format.

Millimeters (mm) Selects millimeter as the default measurement unit.

Inches (") Selects inch as the default measurement unit.

Paper Size Settings A/B Series (8K/16K) A/B series documents are automatically detected.

Inch Series Inch series documents are automatically detected.

Switch Paper Size 1 8.5 x 13" Sets 8.5 x 13" as the alternative document size that 
can be detected automatically.

8.5 x 14" Sets 8.5 x 14" as the alternative document size that 
can be detected automatically.

Switch Paper Size 2 B5 Sets B5 as the alternative document size that can be 
detected automatically.

16K Sets 16K as the alternative document size that can be 
detected automatically.
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Tools
Values:

Audio

Purpose: To configure settings for tones emitted by the device during operation or when a warning 
message appears.

Values:

5 Sets the brightness in 10 levels, with 10 being the brightest.

1–10

Panel Select Tone Off Does not emit a tone when the control panel input is 
correct.

Soft Emits a tone when the control panel entry is correct.

Normal

Loud

Panel Alert Tone Off Does not emit a tone when the control panel entry is 
incorrect.

Soft Emits a tone when the control panel entry is incorrect.

Normal

Loud

Device Ready Tone Off Does not emit a tone when the device is ready to 
process a job.

Soft Emits a tone when the device is ready to process a 
job.

Normal

Loud

Copy Job Tone Off Does not emit a tone when a copy job is complete.

Soft Emits a tone when a copy job is complete.

Normal

Loud

Non-Copy Job Tone Off Does not emit a tone when a job other than a copy 
job is complete.

Soft Emits a tone when a job other than a copy job is 
complete.

Normal

Loud
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Tools
Low Toner Alert Message

Purpose: To specify whether to show the alert message when the toner is low.

Fault Tone Off Does not emit a tone when a job ends abnormally.

Soft Emits a tone when a job ends abnormally.

Normal

Loud

Alert Tone Off Does not emit a tone when a problem occurs.

Soft Emits a tone when a problem occurs.

Normal

Loud

Out of Paper Off Does not emit a tone when the device runs out of 
paper.

Soft Emits a tone when the device runs out of paper.

Normal

Loud

Low Toner Alert Off Does not emit a tone when a toner is low.

Soft Emits a tone when a toner is low.

Normal

Loud

Auto Clear Alert Off Does not emit a tone 5 seconds before the device 
performs auto clear.

Soft Emits a tone 5 seconds before the device performs 
auto clear.

Normal

Loud

All Tones Off Disables all the alert tones.

Soft Sets the volume of all the alert tones at once.

Normal

Loud
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Tools
Values:

OffHook Wake Up

Purpose: To specify whether to wake up from the Low Power or Sleep mode when you pick up the handset 
of the external telephone.

Values:

Auto Job History

Purpose: To automatically print a job history report after every 20 jobs.

Values:

The job history report can also be printed using the [Report/List] menu.

Fax Server Address Book

Purpose: To specify whether to search the phone numbers from the Address Book for the LDAP server.

Values:

Note: You can search the phone numbers only from the local Address Book when [Fax Server Address 
Book] is set to [Off].

Email Server Address Book

Purpose: To specify whether to search the email addresses from the Address Book for the LDAP server.

Off Does not show the alert message when the toner is low.

On Shows the alert message when the toner is low.

Off Does not wake up from the Low Power or Sleep mode when you pick up 
the handset of the external telephone.

On Wakes up from the Low Power or Sleep mode when you pick up the 
handset of the external telephone.

Off Does not automatically print a job history report.

On Automatically prints a job history report.

Off Does not search the phone numbers from the Address Book for the LDAP 
server.

On Searches the phone numbers from the Address Book for the LDAP server.
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Tools
Values:

Note: You can search the email addresses only from the Address Book that is local when [Email Server 
Address Book] is set to [Off].

Power on Wizard

Purpose: To perform initial setup for the device.

Max Email Size

Purpose: To specify the maximum email size.

Values:

Timers

Purpose: To configure timer settings.

Control Panel

Purpose: To automatically reset the settings for Copy, Scan, Fax, Email, or Print to the default settings and 
return to the standby mode after you do not specify any settings for the specified time.

Values:

Fault Timeout

Purpose: To specify the amount of time the device waits before canceling a job that stops abnormally. The 
print job is canceled if the time-out time is exceeded.

Off Does not search the email addresses from the Address Book for the LDAP 
server.

On Searches the email addresses from the Address Book for the LDAP server.

Max Email Size 2048 KB

50–16384 KB

45 Seconds

1 Minute

2 Minutes

3 Minutes

4 Minutes
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Tools
Values:

Output Settings

Purpose: To configure settings concerning output from the device.

Default Paper Size

Purpose: To specify the default paper size.

Values: 

* The default for [Default Paper Size] varies depending on region-specific factory default.

Print ID

Purpose: To specify a location where the user ID is printed.

Values: 

Note: When you print on DL size paper, a part of the user ID may not be printed correctly.

Print Text

Purpose: To specify whether the device outputs PDL data, which is not supported by the device, as text 
when the device receives it. Text data is printed on A4 or Letter size paper.

Off Disables the fault time-out.

On 60 sec Sets the amount of time the device 
waits before canceling a job that stops 
abnormally.3–300 sec

A4*

8.5 x 11*

Off Does not print the user ID.

Top Left Prints the user ID on the top left of the page.

Top Right Prints the user ID on the top right of the page.

Bottom Left Prints the user ID on the bottom left of the page.

Bottom Right Prints the user ID on the bottom right of the page.
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Tools
Values: 

Banner Sheet

Note: Banner Sheet feature is available only when the One Tray Module (optional) is installed on the 
device.

Purpose: To specify the position of banner sheet, and also specify the tray in which the banner sheet is 
loaded.

Values: 

Substitute Tray

Purpose: Specifies whether to use paper of a different size when the paper that is loaded in the specified 
tray does not match the paper size settings for the current job.

Values: 

Letterhead 2-Sided

Purpose: To specify whether to print on both sides when using letterhead.

Off Does not print the received data.

On Prints the received data as text data.

Insert Position Off Does not print the banner sheet.

Front Inserted before the first page of every copy.

Back Inserted after the last page of every copy.

Front & Back Inserted before the first page of every copy and after 
the last page of every copy.

Specify Tray Tray5 (Bypass) The banner sheet is loaded in the Tray 5 (bypass).

Tray1 The banner sheet is loaded in Tray 1.

Tray2 The banner sheet is loaded in Tray 2.

Off No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no larger paper size, 
the device substitutes paper of nearest size.

Nearest Size Substitutes paper of nearest size.

Use Tray5 (Bypass) Substitutes paper from Tray5 (Bypass).
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Tools
Values:

Report 2-Sided Print

Purpose: To specify whether to print reports on both sides of a sheet of paper.

Values:

Copy Auditron

Purpose: To specify whether to limit the copy functions that can be used per user by Auditron 
authentication.

Values:

Print Auditron

Purpose: To specify whether to limit the print functions that can be used per user by Auditron 
authentication.

Values:

No Account User Print

Purpose: To specify whether to permit the printing of data without authentication information.

Values:

Auto Color To Mono Print

Disable Does not print on both sides of letterhead.

Enable Prints on both sides of letterhead.

1-Sided Prints reports on one side of a sheet of paper.

2-Sided Prints reports on both side of a sheet of paper.

Off Does not limit functions by Auditron authentication.

On Limits functions by Auditron authentication.

Off Does not limit functions by Auditron authentication.

On Limits functions by Auditron authentication.

Off Does not permit non-account user to print the data.

On Permits non-account user to print the data.
Xerox® DocuCentre® SC2020
User Guide

183



Tools
Purpose:

To specify whether to automatically change the color of the print jobs requested to be printed in color into 
black and white.

Values:

Maintenance

Use the [Maintenance] menu to initialize the NV (non-volatile) memory, configure the plain paper quality 
adjustment settings, and configure the security settings.

Note: Bold values are the factory default menu settings.

Adjust Paper Type

Purpose: To specify paper density settings.

Values:

Adjust Transfer Belt Unit

Purpose: To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the 
previous page, or a part of the page currently printing.)

Values:

Adjust 2nd BTR

Purpose: To specify the transfer roll voltage adjustment for each paper type.

The default settings may not give the best output on all paper types. If you see mottles on the print 
output, try to increase the voltage. If you see white spots on the print output, try to decrease the voltage.

Note: The print quality changes depending on the setting values you select for this item.

Off Prints color print jobs as requested.

On Prints color print jobs in black and white.

Plain Lightweight

Heavyweight

Labels Lightweight

Heavyweight

0 If faint ghosts appear, try to decrease the value.

(Lighten) -5 to +5 
(Darken)
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Tools
Values:

Adjust Alignment

Purpose: To adjust the alignment of the printed image.

Plain (60–90 g/m2) 0

-5 to +10

Bond (90–105 g/m2) 0

-5 to +10

Recycled (60–89 g/m2) 0

-5 to +10

Heavyweight (HW)

(106–169 g/m2)

0

-5 to +10

Extra Heavyweight

(170–256 g/m2)

0

-5 to +10

Gloss (106–169 g/m2) 0

-5 to +10

Heavyweight Gloss

(170–256 g/m2)

0

-5 to +10

Labels (106–256 g/m2) 0

-5 to +10

Postcard 0

-5 to +10

Envelope 0

-5 to +10
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Tools
Values:

* [Tray 2] is available only when the One Tray Module (optional) is installed.

Auto Registration

Purpose: To perform color registration adjustment.

Quick Density Adjust

Purpose: To perform quick density adjustment.

Initialize NVM

Purpose: To initialize the non-volatile (NV) memory for system parameters, Address Book data for fax, or 
Address Book data for scan. After executing this function and rebooting the device, the menu parameters 
or data, except the parameters for the network, are reset to their factory default values.

Adjust Lead/Side 
Regi

Tray 5
(Bypass)

Lead Regi (X) 0.0 mm

-2.0 to 2.0 mm

Side Regi (Y) 0.0 mm

-2.0 to 2.0 mm

Tray 1 Lead Regi (X) 0.0 mm

-2.0 to 2.0 mm

Side Regi (Y) 0.0 mm

-2.0 to 2.0 mm

Tray 2* Lead Regi (X) 0.0 mm

-2.0 to 2.0 mm

Side Regi (Y) 0.0 mm

-2.0 to 2.0 mm

Duplex Module Lead Regi (X) 0.0 mm

-2.0 to 2.0 mm

Side Regi (Y) 0.0 mm

-2.0 to 2.0 mm

Adjust Squareness Squareness 0.0 mm

-1.0 to 1.0 mm
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Tools
Values:

Initialize Print Meter

Purpose: To initialize the print meter of the device. When the print meter is initialized, the meter count is 
reset to zero.

Value:

Non-Genuine Toner

Purpose: To use toner cartridge of another manufacturer.

Note: Using a non-Xerox toner cartridge may severely damage the device. The warranty does not 
cover damages caused by using non-Xerox toner cartridges.

Values:

Adjust Altitude

Purpose: To specify the altitude of the location where the device is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. 
Adjustments are performed by specifying the altitude of the location where the device is being used.

Note: An incorrect altitude adjustment setting leads to problems such as poor printing quality and 
incorrect indication of remaining toner.

Fax Settings Initialize Initializes the fax number entries in 
the Address Book.

Scan Settings Initialize Initializes the email and server 
address entries in the Address Book.

System Settings Initialize Initializes the system parameters.

Initialize Initializes the print meter.

Off Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.
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Tools
Values:

Clear Job History

Purpose: To clear the job history of all finished jobs.

Adjust TouchScreen

Purpose: To calibrate the control panel.

Secure Settings

Use the [Secure Settings] menu to set a passcode to limit access to the menus. This prevents items from 
being changed accidentally.

Note: Bold values are the factory default menu settings.

Panel Lock

Purpose: To set a limited access to [Admin Settings] with a passcode, and to set or change the passcode.

Note: For more information, refer to Executing Calibration on page 214.

Values:

This item is available only when [Panel Lock Set] is set to [Enable].

Service Lock

Note: Service Lock feature is available only when [Panel Lock Set] is set to [Enable]. For more 
information, refer to Limiting Access to Copy, Fax, and Scan on page 220.

Purpose: To specify whether to enable or disable each of the device services, or to require a passcode to use 
the services.

0 m Sets the altitude of the location where the device is 
installed.

1000 m

2000 m

3000 m

4000 m

5000 m

Panel Lock Set Disable Disables passcode protection for [Admin Settings].

Enable Enables passcode protection for [Admin Settings].

Change Passcode* 0000–9999 Sets or changes the passcode required to access 
[Admin Settings].
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Tools
Values:

Copy Enabled Enables the Copy service.

Password 
Locked

Enables the Copy service, but requires a passcode to use 
the service.

Color 
Password 
Locked

Enables the Copy service with a color mode, but requires a 
passcode.

Disabled Disables the Copy service.

Email Enabled Enables the Email service.

Password 
Locked

Enables the Email service, but requires a passcode to use 
the service.

Disabled Disables the Email service.

Fax Enabled Enables the Fax service.

Password 
Locked

Enables the Fax services, but requires a passcode to send 
faxes (does not require a passcode to receive incoming 
faxes).

Disabled Disables the Fax service (the device will not send or receive 
faxes).

Send via Fax Driver Enable Enables the Send via Fax Driver service.

Disable Disables the Send via Fax Driver service.

Scan To Network Enabled Enables the Scan To Network service.

Password 
Locked

Enables the Scan To Network service, but requires a 
passcode to use the service.

Disabled Disables the Scan To Network service.

Scan To WSD* Enabled Enables the Scan To WSD Scan service.

Password 
Locked

Enables the Scan To WSD Scan service, but requires a 
passcode to use the service.

Disable Disables the Scan To WSD Scan service.

PC Scan Enabled Enables the PC Scan service.

Password 
Locked

Enables the PC Scan service, but requires a passcode to 
use the service.

Disabled Disables the PC Scan service.

ID Card Copy Enable Enables the ID Card Copy service.

Disable Disables the ID Card Copy service.
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* WSD stands for Web Services on Devices.

Edit Email From Field

Purpose: To specify whether to enable editing of the transmission source when you use Scan to Email.

Values:

Confirm Recipients

Note: If [Confirm Recipients] menu is set to [Confirm Recipient], recipients can only be selected from 
the address book. You cannot directly enter an address or fax number.

Purpose: To specify whether to confirm the recipient before sending a fax or scan.

Values:

Domain Filtering

Note: Set the domains from SMTP Domain Filtering on CentreWare Internet Services.

Purpose: To specify whether to only send emails to specified domains.

Values:

Software Download

Purpose: To enable or disable download of firmware updates.

Values:

Display Network Information

Disable Disables editing of the transmission source.

Enable Enables editing of the transmission source.

No Confirmation Does not display a screen to reconfirm the recipient 
before the job is actually sent.

Confirm Recipient Displays a screen to reconfirm the recipient before the 
job is actually sent.

Disable Disables Domain Filtering.

Enable Only allows emails to be sent to specified domains.

Disable Disables firmware updates.

Enable Enables firmware updates.
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Purpose: To show or hide network information in the message field of the Services Home screen.

Value:

Login Attempts

Note: Login Attempts feature is available only when [Panel Lock Set] is set to [Enable].

Purpose: To specify the number of error entry attempts allowed when you log in as an administrator in the 
[Admin Settings] and [Report/List] menu.

Values:

Default Settings

Use the [Default Settings] menu to modify the defaults for the Copy, Scan Menu, or Fax.

Copy Defaults

Purpose: To modify the defaults for the Copy menu.

Note: Bold values are the factory default menu settings.

Output Color

Purpose: To select color or black and white copying.

Values:

Select Tray

Purpose: To specify the input tray.

Show IPv4 Address Shows the IPv4 address of the device on the <Services Home> screen.

Show Host Name Shows the host name of the device on the Services Home screen.

Hide Network 
Information

Does not show network information on the Services Home screen.

Off Does not allow an administrator to log in after one 
error entry attempt.

On 5 Sets the number of error entry attempts allowed when 
an administrator logs in.

1–10

Full Color Copies in color mode.

Black & White Copies in black and white mode.
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Values:

* [Tray2] is available only when the One Tray Module (optional) is installed.

Collation

Purpose: To sort the copy job.

Values:

Reduce/Enlarge

Purpose: To set the default copy reduction/enlargement ratio.

Values: 

mm series

Auto The paper is fed from an automatically selected tray.

Tray5 (Bypass) The paper is fed from Tray 5 (bypass).

Tray1 The paper is fed from Tray 1.

Tray2* The paper is fed from Tray 2.

Auto Automatically determines which output mode for the copy job.

Collated Sorts the copy job.

Uncollated Does not sort the copy job.

100%

Auto%

50% A3  A5

70% A3  A4, B4  B5

81% B4  A4, B5  A5

86% A3  B4, A4  B5

115% B4  A3, B5  A4

122% A4  B4, A5  B5

141% A4  A3, B5  B4

200% A5  A3
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inch series

Note: You can also use the number pad to input the desired zoom ratio from 25% to 400%, or select 

[ ] to enlarge the zoom ratio or select [ ] to reduce the zoom ratio in 1% intervals.

* This item is available only when [Pages Per Side] is set to [Off] or [Manual].

Original Size

Purpose: To specify the default document size.

Values:

mm series

100%

Auto%

64% 8.5 x 11"  5.5 x 8.5"

70% A3  A4, B4  B5

78% 8.5 x 14"  8.5 x 11"

94% A3  11 x 17", A4  8.5 × 11"

129% 8.5 x 11"  8.5 x 14"

141% A4  A3, B5  B4

180% 4 x 6"  8.5 x 11"

200% A5  A3

Auto

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

16K (270 x 195 mm)
Xerox® DocuCentre® SC2020
User Guide

193



Tools
inch series

Note: When [Auto] is selected, the device assumes that the document size is the size of the print 
media loaded in Tray 1 or Tray 5 (bypass).

Original Type

Purpose: To select the copy image quality.

 16K (195 x 270 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

Auto

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)
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Values:

Lighten/Darken

Purpose: To set the default copy density level.

Values:

Sharpness

Purpose: To set the default sharpness level.

Values:

Saturation

Purpose: To set the default color saturation level.

Values:

Auto Background Suppression

Photo & Text Suitable for documents with both text and photos/gray tones.

Text Suitable for documents with text.

Photo Suitable for documents with photos.

Darken +3 Makes the copy darker than the original. Works well with light print or 
faint pencil markings.

Darken +2

Darken +1

Normal Works well with standard typed or printed documents.

Lighten +1 Makes the copy lighter than the original. Works well with dark print.

Lighten +2

Lighten +3

Sharpen Makes the copy sharper than the original.

Normal Does not make the copy sharper or softer than the original.

Soften Makes the copy softer than the original.

Vivid Increases the color saturation to brighten the color of the copy.

Normal The color saturation is the same as the original.

Pastel Decreases the color saturation to lighten the color of the copy.
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Purpose: To suppress the background of the original to enhance text on the copy.

Values:

Auto Background Suppression Level

Purpose:

To specify the default background suppression level.

Values:

Color Balance

Purpose:

To specify the default color balance level within the range of -3 to +3.

Values:

Off Does not suppress the background.

On Suppresses the background of the original to enhance text on the copy.

Normal Sets the background suppression level to [Normal].

Higher Sets the background suppression level to [Higher].

Highest Sets the background suppression level to [Highest].

Yellow Shadows 0 Sets the color balance level of low density yellow.

-3 to +3

Midtones 0 Sets the color balance level of medium density yellow.

-3 to +3

Highlights 0 Sets the color balance level of high density yellow.

-3 to +3

Magenta Shadows 0 Sets the color balance level of low density magenta.

-3 to +3

Midtones 0 Sets the color balance level of medium density 
magenta.

-3 to +3

Highlights 0 Sets the color balance level of high density magenta.

-3 to +3
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2-Sided Copying

Purpose: To print on both sides of a sheet of paper.

Values:

Cyan Shadows 0 Sets the color balance level of low density cyan.

-3 to +3

Midtones 0 Sets the color balance level of medium density cyan.

-3 to +3

Highlights 0 Sets the color balance level of high density cyan.

-3 to +3

Black Shadows 0 Sets the color balance level of low density black.

-3 to +3

Midtones 0 Sets the color balance level of medium density black.

-3 to +3

Highlights 0 Sets the color balance level of high density black.

-3 to +3

1  1-Sided Prints on one side of a sheet of paper.

1  2-Sided - Prints one sided originals on both sides of a sheet of 
paper.

Binding of 
Output

Long Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
short edge.

2  1-Sided - Prints two sided originals on one side of a sheet of 
paper.

Binding of 
Original

Long Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
short edge.
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Pages Per Side

Purpose: To print two original pages to fit onto one sheet of paper.

Values:

Edge Erase

Purpose: To specify the value of the top and bottom margins.

Values:

Scan Defaults

To modify the defaults for the [Scan] menu and [Email] menu defaults.

Note: Bold values are the factory default menu settings.

File Format

Purpose: To specify the file format to save the scanned image.

Values:

2  2-Sided - Prints two sided originals on both sides of a sheet of 
paper.

Binding of 
Original

Long Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
long edge.

Short Edge 
Binding

Prints on both sides of a sheet of paper to be bound by 
short edge.

Off Does not perform Pages Per Side printing.

2-Up Automatically reduces the original pages to fit onto one sheet of paper.

Top/Bottom 0.1 inch (2 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0–50 mm)

Left/Right 0.1 inch (2 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0-2.0 inch (0–50 mm)

Middle 0.0 inch (0 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0–50 mm)

PDF

Multi-Page TIFF
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Output Color

Purpose:

To specify whether to scan in color, black and white, or gray scale.

Values:

Resolution

Purpose: To specify the default scan resolution.

Values:

Note: [600 dpi] cannot be selected when [Output Color] is set to [Color].

Original Size

Purpose: To specify the default document size.

Values:

mm series

TIFF (1 File per page)

JPEG (1 File per page)

XDW

Color Scans in color.

Black & White Scans in black and white.

GrayScale Scans in grayscale.

200 dpi

300 dpi

400 dpi

600 dpi

Auto

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)
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inch series

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

Auto

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)
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2-Sided Scanning

Purpose: To scan both sides of a sheet of paper.

Values:

*This item is available only when [2-Sided Scanning] is set to [2-Sided] in the [Scan Defaults] menu.

Lighten/Darken

Purpose: To set the default scan density level.

Values:

Sharpness

Purpose: To set the default sharpness level.

Values:

Contrast

 16K (195 x 270 mm)

1-Sided Scans one side of a document.

2-Sided Binding of 

Original*
Long Edge 
Binding

Scans both sides of a document to be bound by long 
edge.

Short Edge 
Binding

Scans both sides of a document to be bound by short 
edge.

Darken +3 Makes the scanned image darker than the original. Works well with light 
print or faint pencil markings.

Darken +2

Darken +1

Normal Works well with standard typed or printed documents.

Lighten +1 Makes the scanned image lighter than the original. Works well with dark 
print.

Lighten +2

Lighten +3

Sharpen Makes the scanned image sharper than the original.

Normal Does not make the scanned image sharper or softer than the original.

Soften Makes the scanned image softer than the original.
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Purpose: To adjust the amount of colors to make the contrast of colors darker or lighter than the original.

Values:

Auto Background Suppression

Purpose: To suppress the background of the original to enhance text on the scanned image.

Values:

Auto Background Suppression Level

Purpose: To specify the default background suppression level.

Values:

Edge Erase

Purpose: To specify the value of the top and bottom margins.

Values:

More Adjusts the amount of colors to make the contrast of colors darker than 
the original.

Normal Does not adjust the amount of colors to make the contrast of colors 
darker or lighter than the original.

Less Adjusts the amount of colors to make the contrast of colors lighter than 
the original.

Off Does not suppress the background.

On Suppresses the background of the original to enhance text on the 
scanned image.

Normal Sets the background suppression level to [Normal].

Higher Sets the background suppression level to [Higher].

Highest Sets the background suppression level to [Highest].

Top/Bottom 0.1 inch (2 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0–50 mm)

Left/Right 0.1 inch (2 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0–50 mm)
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TIFF File Format

Purpose: To specify the default TIFF file format.

Values:

Quality/File Size

Purpose: To specify the Quality/File Size.

Values:

File Name

Purpose: To specify whether to add a prefix or suffix to the file name.

Values:

Create Folder

Purpose: To specify whether to create a folder when saving scanned images.

Values:

Middle 0.0 inch (0 mm) Sets the value in increments of 0.1 inch (1 mm).

0.0–2.0 inch (0–50 mm)

TIFF V6 Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.

Small Sets the Quality/File Size level to [Small].

Normal Sets the Quality/File Size level to [Normal].

Large Sets the Quality/File Size level to [Large].

Auto Does not add a prefix or suffix to the file name.

Add Prefix Adds a prefix to the file name.

Add Suffix Adds a suffix to the file name.

Off Does not create a folder when saving a scanned image.

On Creates a folder when saving a scanned image.
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Fax Defaults

Purpose: To modify the defaults for the [Fax] menu.

Notes:

• The FAX service cannot be used unless you set up a region code under [Region].

• Bold values are the factory default menu settings.

Resolution

Purpose: To specify the scan resolution to improve the output quality.

Values:

Note: Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the 
receiving device.

2-Sided Scanning

Purpose: To scan both sides of a sheet of paper.

This item is available only when [2-Sided Scanning] is set to [2-Sided Printing] in the [Scan Defaults] menu.

Lighten/Darken

Purpose: To adjust the density to make the copy lighter or darker than the original.

Standard Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or 
documents printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The Super Fine 
mode is enabled only if the remote device also supports the Super Fine 
mode. See the notes below.

Photo Suitable for documents containing photographic images.

1-Sided Scans one side of a document.

2-Sided Binding of 

Original*
Long Edge 
Binding

Scans both sides of a document to be bound by long 
edge.

Short Edge 
Binding

Scans both sides of a document to be bound by short 
edge.
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Values:

• Original Size

Purpose: To specify the default document size.

Values:

mm series

inch series

Darken +3 Works well with light print or faint pencil markings.

Darken +2

Darken +1

Normal Works well with standard typed or printed documents.

Lighten +1 Works well with dark print.

Lighten +2

Lighten +3

Auto

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (210 x 297 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

Auto

 Tabloid (11 x 17")

 Legal (8.5 x 14")
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Delayed Send

Purpose: This feature enables you to set a specific time for the fax transmission to start. Once [Delayed 
Send] mode is activated, the device stores all of the documents to be faxed into its memory and sends 
them at the specified time. After faxing in the [Delayed Send] mode is complete, the data in the memory is 
cleared.

Values:

Note: A maximum of 19 delayed fax jobs can be stored in the device.

Tray Management

Use the [Tray Management] menu to define the print media loaded in Tray 1 and Tray 2.

Note: Bold values are the factory default menu settings.

Tray Settings

Purpose: To configure tray settings.

Tray 5 (Bypass)

Purpose: To specify the paper loaded in Tray 5 (bypass).

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (210 x 297 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

21:00/9:00 PM Specify the fax transmission start time when sending a fax at a specified 
time.

0:00–23:59/
1:00–12:59 AM/PM
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Values:

Display 
Tray 
Prompt

Enter a check to display a popup message that prompts to set Type and Size when 
paper is loaded in Tray 5 (bypass). The factory default is on (check).

Use Driver 
Settings for 
Print Job

Enter a check to use the Size and Type set on the print driver. The factory default is off 
(blank).

Size
(mm series)

 A3 (297 x 420 mm)*

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)

 Tabloid (11 x 17")

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

Custom Size Length(x) 210 mm Specifies the length of the custom 
size paper.

98–432 mm

Width(y) 297 mm Specifies the width of the custom 
size paper.

89–297 mm
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Size
(inch 
series)

 Tabloid (11 x 17")*

 Legal (8.5 x 14")

 Folio (8.5 x 13")

 Letter (8.5 x 11")

 Letter (8.5 x 11")

 A3 (297 x 420 mm)

 B4 (257 x 364 mm)

 A4 (297 x 210 mm)

 A4 (210 x 297 mm)

 B5 (257 x 182 mm)

 B5 (182 x 257 mm)

 A5 (148 x 210 mm)

 8K (270 x 390 mm)

 16K (270 x 195 mm)

 16K (195 x 270 mm)

Custom Size Length(x) 8.3 inches Specifies the length of the custom 
size paper.

3.9–17.0"

Width(y) 11.7 inches Specifies the width of the custom 
size paper.

3.5–11.7"
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* The default for [Size] varies depending on region-specific factory default.

Tray 1

Purpose: To specify the paper loaded in Tray 1.

Type Plain (60–90 g/m2)

Plain Reload

Bond (90–105 g/m2)

Bond Reload

Recycled (60–89 g/m2)

Recycled Reload

Punched (60–89 g/m2)

Letterhead (60–89 g/m2)

Heavyweight (HW) (106–169 g/m2)

HW Reload

Extra Heavyweight (X-HW) (170–256 g/m2)

X-HW Reload

Gloss (106–169 g/m2)

Gloss Reload

Heavyweight Gloss (170–256 g/m2)

HW Gloss Reload

Labels (106–256 g/m2)

Pre-Printed (60–89 g/m2)

Colored (60–89 g/m2)

Postcard

Postcard Reload

Envelope
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Values:

Tray 2

Note: Tray2 is available only when the One Tray Module (optional) is installed.

Purpose: To specify the paper loaded in Tray 2.

Display 
Tray 
Prompt

Enter a check to display a popup message that prompts to set Type when paper is 
loaded in Tray 1. The factory default is on (check).

Type Plain (60–90 g/m2)

Plain Reload

Recycled (60–89 g/m2)

Recycled Reload

Punched (60–89 g/m2)

Letterhead (60–89 g/m2)

Pre-Printed (60–89 g/m2)

Colored (60–89 g/m2)
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Values:

Display 
Tray 
Prompt

Enter a check to display a popup message that prompts to set Type and Size when 
paper is loaded in Tray 2. The factory default is on (check).

Size Auto Detect

Custom 
Size

Length(x) 210 mm
(8.3 inches)

Specifies the length of the custom size 
paper.

182–432 
mm
(7.2–17.0 
inches)

Width(y) 297 mm
(11.7 inches)

Specifies the width of the custom size 
paper.

140–297 
mm
(5.5–11.7 
inches)
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Note: When using a non-standard size envelope, specify the size without the flap in [Custom Size].

Tray Priority

Purpose: To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with 
the same paper size and type exists, the paper tray is selected according to this priority order.

Type Plain (60–90 g/m2)

Plain Reload

Bond (90–105 g/m2)

Bond Reload

Recycled (60–89 g/m2)

Recycled Reload

Punched (60–89 g/m2)

Letterhead (60–89 g/m2)

Heavyweight (HW) (106–169 g/m2)

HW Reload

Extra Heavyweight (X-HW) (170–256 g/m2)

X-HW Reload

Gloss (106–169 g/m2)

Gloss Reload

Heavyweight Gloss (170–256 g/m2)

HW Gloss Reload

Labels (106–256 g/m2)

Pre-Printed (60–89 g/m2)

Colored (60–89 g/m2)

Postcard

Postcard Reload
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Values:

Notes:

• [Tray2] and [3 Third] are available only when the One Tray Module (optional) is installed.

• The paper tray name is not displayed in the priority menu after once selected.

Language Settings

Panel Language

Note: Bold values are the factory default menu settings.

Purpose: To determine the language of the text on the control panel.

Values:

Keyboard Layout

Purpose: To select the keyboard layout on the control panel.

1 First Tray5 (Bypass) Sets Tray 5 (bypass) as the first priority.

Tray1 Sets Tray 1 as the first priority.

Tray2 Sets Tray 2 as the first priority.

2 Second Tray5 (Bypass) Sets Tray 5 (bypass) as second priority.

Tray1 Sets Tray 1 as the second priority.

Tray2 Sets Tray 2 as the second priority.

3 Third Tray5 (Bypass) Sets Tray 5 (bypass) as the third priority.

Tray1 Sets Tray 1 as the third priority.

Tray2 Sets Tray 2 as the third priority.

English

 (Simplified Chinese)

 (Korean)

 (Vietnamese)

 (Thai)
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Values:

Executing Calibration
The device can automatically calibrate colors using the calibration chart when the reproducibility of 
density or color in copies and prints deteriorates.

If [Output Color] is set to [Black & White] calibration will not be executed.

Notes:

• During auto calibration, the device cannot receive print jobs, cannot send or receive faxes 
and cannot transmit data via network. It also cannot shift into the Power Saver mode.

• If density or color is not calibrated well despite the periodic execution of auto calibration, 
contact our Customer Support Center.

1. Press the <Machine Status> button.

2. Select the [Tools] tab.

QWERTY

AZERTY

QWERTZ

Services Home

Job Status

Machine Status

<Machine Status> button
Xerox® DocuCentre® SC2020
User Guide

214



Tools
3. Select [Admin Settings].

4. Select [System Settings].

5. Select [Calibration].

6. Select [Calibration Target].

7. Select [Copy/Print], [Copy] or [Print], and then select [OK].

Note: Select [None] if automatic tone correction carried out in the past does not apply. Normally this 
is not used.

8. Select [Start].

9. Select [Yes, Restart].

10. Select [Select Tray].

11. Select a tray.

Note: Select a tray in which A3, A4 , 11 x 17" or 8.5 x 11"  size paper is loaded.

12. Select [Start].

Note: Calibration Chart will be printed.

13. Place the Calibration Chart following the instructions displayed on the touch screen.

Notes:

• Align the magenta patch (squares printed at the top and bottom of the Calibration Chart) of 
the printed Calibration Chart against the left side of the document glass.

• Place at least five sheets of white paper on the Calibration Chart and close the document 
cover.

14. Select [Start].

15. Select [Yes, Restart]
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Panel Lock Function
This feature prevents unauthorized personnel from changing the settings made by the administrator. 
However, you can select settings for individual print jobs using the print driver.

Note: Disabling the control panel menus does not prevent access to the [Secure Print], [Sample Print] 
and [Tray Settings] menus.

Enabling the Panel Lock
1. Press the <Machine Status> button.

2. Select the [Tools] tab.

3. Select [Admin Settings].

4. Select [Secure Settings].

Services Home

Job Status

Machine Status
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5. Select [Panel Lock].

6. Select [Panel Lock Set].

7. Select [Enable], and then select [OK].

8. Enter the new passcode, and then select [OK].

Note: The factory-default panel passcode is 0000.

– Be sure to remember the passcode. The procedure described below allows you to reset the 
passcode, but the settings for Address Book are cleared.

– Turn off the device. Then, while holding the <Machine Status> button, turn on the device.

– If you change the passcode while [Panel Lock Set] is [Enable], perform steps 1 to 3. Enter the 
current passcode, and then select [OK]. Perform steps 4 and 5. Select [Change Passcode], and 
then select [OK]. Enter the current passcode, and then select [OK]. Perform steps 8 and 9. This will 
change the passcode.
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9. Re-enter the passcode to confirm the passcode that you entered, and then select [OK].

Disabling the Panel Lock
1. Press the <Machine Status> button.

2. Select the [Tools] tab.

3. Select [Admin Settings].

Services Home

Job Status

Machine Status

<Machine Status> button
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4. Enter the passcode, and then select [OK].

Note: The factory-default panel passcode is 0000.

5. Select [Secure Settings].

6. Select [Panel Lock].

7. Select [Panel Lock Set].

8. Select [Disable], and then select [OK].
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Limiting Access to Copy, Fax, and Scan
9. Enter the current passcode, and then select [OK].

Limiting Access to Copy, 
Fax, and Scan

Enabling the Copy Lock, Fax Lock, and Scan Lock options limits access to copy, fax, and scan operations by 
requiring a passcode to be entered before copying, scanning, faxing, or printing.

Taking Fax Lock as an example, the following procedure explains how to enable or disable the option. Use 
the same procedure to enable or disable Copy Lock, or Scan Lock.

Note: The Service Lock feature cannot be used simultaneously with the Copy Auditron feature.

1. Press the <Machine Status> button.

2. Select the [Tools] tab.

Services Home

Job Status

Machine Status

<Machine Status> button
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3. Select [Admin Settings].

4. Select [Secure Settings].

5. Select [Panel Lock].

6. Select [Panel Lock Set].
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7. Select [Enable], and then select [OK].

8. Enter the new passcode using the number pad and then select [OK].

9. Re-enter the passcode and then select [OK].

Note: The default passcode is 0000.

10. Select [ ] once.

11. Select [Service Lock].
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Setting the Power Saver Option
12. Select [Fax].

• Enabled

• Password Locked

• Color Password Locked (available only for Copy Lock)

• Disabled

Setting the Power Saver 
Option

You can set the Power Saver for the device. The device switches to the Power Saver mode after the specified 
time.

Note: If [Panel Lock Set] is set to [Enable], you need to enter the four digit passcode to enter the 
[Admin Settings] menu.
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Setting the Power Saver Option
To set the Power Saver:

1. Press the <Machine Status> button.

2. Select the [Tools] tab.

3. Select [Admin Settings].

4. Select [System Settings].

5. Select [General].

Services Home

Job Status

Machine Status

<Machine Status> button
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6. Select [Power Saver].

7. Select [Low Power Timer] or [Sleep Timer].

8. Select [ ] or [ ] or enter the desired value using the number pad, and then select [OK].

You can select from 1–150 minutes for [Low Power Timer] or 0–60 minutes for [Sleep Timer].

9. To return to the previous screen, select [ ].
Xerox® DocuCentre® SC2020
User Guide

225



Setting the Power Saver Option
About the Concurrent Jobs Feature
This feature enables you to start a concurrent job while a fax job is running. This is done by temporally 
displaying the Services Home screen and switching to a different function that can be run concurrently 
such as copy or scan.

1. While the device is sending or receiving a fax, press the <Services Home> button.

2. Select [Copy] or [Scan] menu.

3. After setting the copy or scan options, press the <Start> button.

Resetting to Factory Defaults
After executing this function and rebooting the device, the address book or all the menu parameters, 
except the parameters for the network, are reset to their default values.

1. Press the <Machine Status> button.

2. Select the [Tools] tab.

Services Home

Job Status

Machine Status

<Services Home> button

Services Home

Job Status

Machine Status

<Machine Status> button
Xerox® DocuCentre® SC2020
User Guide

226



Setting the Power Saver Option
3. Select [Admin Settings].

4. Select [Maintenance].

5. Select [Initialize NVM].

6. Select the desired setting.

7. Select [Initialize].

The device restarts automatically to apply the settings.
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Machine Status

This chapter describes how to check the basic information and status of your device. 

Note: Some settings are not displayed on some models. An optional component is required. For more 
information, contact our Customer Support Center.

Checking Consumables
The Machine Status screen displays the status of consumables such as the toner cartridge and the drum 
cartridge.

Follow the steps below to check the status of consumables.

1. Press the <Machine Status> button. 

2. Select the [Supplies] tab.

3. Supplies

Shows the status of the toner cartridges and other supplies.

– [K]

Shows the percentage of the remaining black toner.

– [C]

Shows the percentage of the remaining cyan toner. 

– [M]

Shows the percentage of the remaining magenta toner.

– [Y]

Shows the percentage of the remaining yellow toner.

– [Other Supplies]

Services Home

Job Status

Machine Status

<Machine Status> button
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Shows the status of the drum cartridge, waste toner container, transfer belt, second bias transfer 
roll, fusing unit, and developer units.

Selecting Language
You can select from five languages, English, Simplified Chinese, Korean, Vietnamese, and Thai, for the user 
interface language used in the control panel display.

The default language may vary depending on the region of purchase.

Follow the steps below to select the language.

1. Press the <Machine Status> button.

2. Select the [Tools] tab.

3. Select [Language Settings].
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Machine Status
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4. Select [Panel Language].

5. Select the display language from the [Panel Language] screen.

6. Select [OK].

Checking the Device IP Address
You can display the IPv6 or IPv4 address of your device.

1. Press the <Machine Status> button.

2. Select [About This MFP].

Services Home

Job Status

Machine Status

<Machine Status> button
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3. Select the [Network] tab.

4. The IP address of your device is displayed.

Checking the Meter
The Billing Meter screen shows the total number of printed pages (including the number of the pages of 
the copied documents and received fax documents).

Item Description

Meter1 Displays the total number of color prints.

Meter2 Displays the total number of monochrome prints.

Meter3 Displays the total number of large size color prints. 

Meter4 Displays the total number of color and monochrome prints (Meter 1 + 
Meter 2).
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Follow the steps below to view information on the Billing Meter screen.

1. Press the <Machine Status> button. 

2. Select [Billing Meters].

Printing Reports/Lists
The device can print the following reports/lists. The reports and lists with an asterisk can be printed only 
when the Fax Kit (optional) is installed.

Report/List Purpose

System Settings To print a list of the current user default values, the installed options, the 
amount of installed print memory, and the status of device supplies.

Panel Settings To print a detailed list of all the settings on the control panel menus.

PCL Fonts List To print a sample of the available PCL fonts.

Job History To print a detailed list of the print, copy, fax, or scan jobs that have been 
processed. This list contains the last 20 jobs.

Error History To print a detailed list of paper jams and fatal errors.

Printer Meter To print the reports for the total number of pages printed.

Demo Page To print a page for testing colors.

Protocol Monitor To print a detailed list of monitored protocols.

Fax Address Book* To print the list of all fax addresses stored as Fax Address Book information.

Services Home

Job Status

Machine Status

<Machine Status> button
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Follow the steps below to print a report or list.

1. Press the <Machine Status> button.

2. Select [Report/List].

3. Select the report or list to print, and then select [Print].

Note: To cancel printing while a job is printing, press the <Stop> button.

Email Address Book To print the list of all email addresses stored as Email Address Book 
information.

Server Address To print the list of all server addresses stored as Server Address information.

Fax Activity* To print the report of faxes you recently received or sent.

Fax Pending* To print the list of status of pending faxes.

Report/List Purpose

Services Home

Job Status

Machine Status

<Machine Status> button
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Job Status

This chapter describes how to check the status of current or pending jobs, and how to cancel jobs.

Note: Some settings cannot be displayed when the Fax Kit (optional) is not installed. For more 
information, contact our Customer Support Center.

Checking Current/Pending Jobs
You can check the status of the following current or pending jobs:

• Current print, scan or fax job

• Pending print jobs

• Pending fax jobs to send

Note: Completed jobs are not displayed.

1. Press the <Job Status> button.

2. Used to check the jobs.

Checking Reserved Fax Jobs

If any outgoing faxes have been reserved, you can check them by selecting [Fax Job (Waiting to Send)].

1. Press the <Job Status> button.

2. Select [Fax Job (Waiting to Send)].

The list of reserved fax jobs appears.

Services Home

Job Status

Machine Status

<Job Status> button
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Canceling the Current Job
1. Press the <Job Status> button. 

2. Select the current job.

3. Select [Delete].

You may not be able to cancel a job depending on the status of the job processing. 

Note: If the device is being used as a local printer, it may take some time to cancel the job depending 
on the type of print job being executed. 

Canceling a Pending Fax Job

The only type of pending fax job that can be cancelled is a reserved fax job. 

1. Press the <Job Status> button.

2. Select [Fax Job (Waiting to Send)]. 

3. Select a reserved fax job.

4. Select [Delete].

You may not be able to cancel a job depending on the status of the job processing. 
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Maintenance

This chapter describes how to replace consumables and clean the device.

Replacing Consumables
The device is provided with the following consumables. We recommend the use of the following 
consumables as they are manufactured to meet the specifications of the device.

Note: We recommend that you always keep spare consumables/periodic replacement parts available.

• Depending on your contract, the toner to order may vary. For more information, contact your local 
Xerox representative or sales representative.

WARNINGS:

• Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge or toner 
bottle. It may catch fire by electric sparks inside a vacuum cleaner and cause explosion. Use a broom 
or a wet cloth to wipe off spill. If you spill a large volume of toner, contact your local Xerox 
representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion. If you have a used toner cartridge no longer needed, contact your 
local Xerox representative for its disposal.

Type of Consumables/2/22/16Periodic 
Replacement Parts

Product Code Quantity/Box

Toner Cartridge K CT202246 1unit/box

Toner Cartridge C CT202247 1unit/box

Toner Cartridge M CT202248 1unit/box

Toner Cartridge Y CT202249 1unit/box

Waste Toner Container CWAA0869 1unit/box

Drum Cartridge CMYK CT351053 1unit/box
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• Never throw a waste toner bottle into an open flame. Toner may catch fire and cause burn injuries or 
explosion. If you have a used waste toner bottle no longer needed, contact your local Xerox 
representative for its disposal.

CAUTIONS:

• Keep drum cartridges (or drum if not a cartridge type) and a toner cartridges out of the reach of 
children. If a child accidentally swallows toner, spit it out, rinse mouth with water, drink water and 
consult a physician immediately.

• When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not 
to spill the toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well as 
inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. If you get toner particles in 
the eyes, wash it out with plenty of water for at least 15 minutes until irritation is gone. Consult a 
physician if necessary. If you inhale toner particles, move to a fresh air location and rinse your mouth 
with water. If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and 
consult a physician immediately.

Handling consumables/periodic replacement parts
• Do not store boxes of consumables/periodic replacement parts upright.

• Do not unpack consumables/periodic replacement parts before use. Avoid storing 
consumables/periodic replacement parts in the following locations:

- In high temperature and humid locations

- Near heat-generating devices

- Areas exposed to direct sunlight

- Dusty areas

• When using consumables/periodic replacement parts, carefully read precautions for use. Precautions 
for use are instructed on their bodies or packages, or a precaution sheet is included in their packages.

• We recommend always keeping spare consumables/periodic replacement parts in stock.

• When calling our Customer Support Center to order consumables/periodical replacement parts, have 
the product codes ready.

• The use of consumables/periodic replacement parts not recommended by Xerox may impair device 
quality and performance. Use only consumables/periodic replacement parts recommended by Xerox.

• Checking the status of consumables

You can check the status of consumables on the [Supplies] screen.

Note: For more information, refer to Checking Consumables on page 228..

Replacing the Toner Cartridge
The messages below appear in the control panel's display when the remaining toner level has become low. 
Follow the instructions in the message to take the required action.
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This warning appears only when Xerox toner cartridge is used ([Non-Genuine Toner] is set to [Off]).

The remaining page yield differs depending on printing conditions, contents of the documents, and 
frequency of turning on/off the device.

When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner 
cartridge to catch any toner that may spill.

• Do not reuse old toner cartridges once you remove them from the device. Doing so can impair print 
quality.

• Do not shake or pound the used toner cartridges. The remaining toner may spill.

Note: We recommend you to use up the toner cartridges within one year after removing them from 
the packaging.

1. Ensure that the device is not operating, and open the front cover. 

Message Remaining Page Yield*2 Device Status and Action

Order Toner: XXXX*1 Accompanying cartridge: 600 
pages (K), 750 pages (Y/M/C)
Replaced cartridge: 2,700 
pages (K), 900 pages (Y/M/C)

The toner cartridge has become 
low. Prepare a new one.

Out of Toner, Open the Front 
Cover.
Then, Replace the XXXX 
Cartridge. 

The toner cartridge has become 
empty. Replace the old toner 
cartridge with a new one.

K C M Y
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2. Hold the handle of the toner cartridge and lift it up slightly.

3. Gently pull the toner cartridge out of the device.

WARNINGS:

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.

• If you have a used toner cartridge no longer needed, contact your local Xerox representative for its 
disposal.

Notes:

• Pull out the toner cartridge slowly. Otherwise, toner may spill from the cartridge.

• Return the used toner cartridges to your local Xerox representative.

4. Unpack a new toner cartridge, and shake it lightly up/down, and left/right 10 times. 

Do not touch the shutter.
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5. Orient the toner cartridge with the arrow () facing up, and insert it as far as it will go.

6. Close the front cover.

Note: If the front cover is not completely closed, an error code will appear and the device will remain 
paused.

Replacing the Waste Toner Container [R5]

The waste toner container holds used toner. The following messages are displayed on the touch screen 
according to the status of the waste toner container. Follow the messages.
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The remaining page yield differs depending on printing conditions, contents of the documents, and 
frequency of turning on/off the device.

WARNINGS:

• Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge or toner 
bottle. It may catch fire by electric sparks inside a vacuum cleaner and cause explosion. Use a broom 
or a wet cloth to wipe off spill. If you spill a large volume of toner, contact your local Xerox 
representative.

• Never throw a waste toner bottle into an open flame. Toner may catch fire and cause burn injuries or 
explosion. If you have a used waste toner bottle no longer needed, contact your local Xerox 
representative for its disposal.

Notes:

• Do not touch the five gray-colored sponge parts on the back side of the waste toner 
container. Otherwise, your hands may get dirty with toner.

• When you replace the waste toner container, toner may spill and soil the floor. We 
recommend laying paper on the floor beforehand.

• The proper disposal of used waste toner containers is required. Return the old waste toner 
container to our Customer Support Center.

• The use of waste toner containers not recommended by Xerox may degrade image quality 
and performance. Use only waste toner containers recommended by Xerox.

1. Ensure that the device is not operating, and open the front cover.

Message
Remaining Page 

Yield* Device Status and Action

Waste Toner Container Life Over
Open the Front Cover. Then, 
replace the Waste Toner 
Container [R5].

1000 pages The waste toner container is near the end 
of its life. Prepare a new one.
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2. Turn the lock lever counterclockwise.

3. Unlock the waste toner container, and then pull it out making sure to hold it upright so that the waste 
toner does not spill out.

Notes:

• Take care not to drop the waste toner container while you are removing it.

• After removing the waste toner container, do not touch the parts shown in the illustration. 
Toner can dirty or stain your hands.

Never lay the waste toner box on its side as this may cause its malfunction or toner spills.
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4. Prepare a new waste toner container.

Note: Take a new container out of the box in advance.

5. Install a new waste toner container, and then lock it.

6. Turn the lock lever clockwise, and then close the front cover.

7. Insert the used waste toner container into the supplied plastic bag.
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8. Use both hands to carefully place the used waste toner container into the empty box.

Return the old waste toner container to our Customer Support Center.

Replacing the Drum Cartridge

The messages below appear in the control panel display when the drum cartridge is near the end of its 
service life. Follow the instructions in the message to take the required action.

When replacing the drum cartridge, refer to replacement instructions provided with each new consumable 
box.

The remaining page yield differs depending on printing conditions, contents of the documents, and 
frequency of turning on/off the device.

The use of drum cartridges not recommended by Xerox may lower the device's output quality or 
performance. Always use drum cartridges recommended by Xerox in the device.

Note: Do not expose drum cartridges to direct sunlight or strong indoor fluorescent lights. Do not 
touch or scratch the drum surface. Print quality may be affected.

Message Remaining Page Yield* Device Status and Action

Reorder Drum Cartridge 
XXXX.

Black: Approx. 2,000 
pages
Other than Black: Approx. 
1,600 pages

The drum cartridge is near the end of its 
life. Prepare a new one.

Replace Drum Cartridge 
XXXX soon.

Black: Approx. 600 pages
Other than Black: Approx. 
500 pages

It is time to replace the drum cartridge 
soon.

Replace Drum Cartridge 
XXXX.

- The drum cartridge has reached the end 
of its life. Replace the old drum 
cartridge with a new one.
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Cleaning the Device
This section describes how to clean the device such as the outer casing, the document glass cover, the 
document feeder, and the document glass.

WARNINGS:

• When cleaning this product, use the designated cleaning materials exclusive to it. 

• Other cleaning materials may result in poor performance of the product. Never use aerosol cleaners to 
avoid catching fire and explosion.

CAUTION: When cleaning this product, always switch off and unplug it. Access to a live device interior 
may cause electric shock.

Cleaning the Exterior

The following describes how to clean the exterior of the device.

Do not use benzene, paint thinner, or other volatile liquids or spray insect repellent on the device as they 
may discolor, deform, or crack covers.

Note: Cleaning the device with an excessive amount of water may cause the device to malfunction or 
damage documents during copying.

1. Wipe the exterior with a firmly wrung soft cloth moistened with water.

Do not use cleaning agents other than water or neutral detergent.

Note: If you cannot remove the dirt easily, gently wipe the device with a soft cloth moistened with a 
small amount of neutral detergent.

2. Wipe off any excess water with a soft cloth.

Cleaning the Interior (LED Print Heads)

The following describes how to clean the interior (LED Print Heads) of the device.

Normally, clean the LED Print Heads when you replace the waste toner container. However, if you have 
image quality problems such as white or colored stripes appearing on copied or printed outputs, clean the 
LED Print Heads.
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Clean the LED Print Heads periodically when you replace the drum cartridge.

1. Ensure that the device is not operating, and open the front cover.

2. Turn the lock lever counterclockwise.

3. Unlock the waste toner container, and then pull it out making sure to hold it upright so that the waste 
toner does not spill out.

Notes:

• Take care not to drop the waste toner container while you are removing it.

• After removing the waste toner container, do not touch the parts shown in the illustration. 
Toner can dirty or stain your hands.
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Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

4. Remove the cleaning bar from the back side of the front cover, and then clean each of the LED Print 
Heads once with the bar.

Insert the cleaning bar into each slot until it stops, and then slowly slide the bar back out.

5. Return the cleaning bar to the back side of the front cover.

6. Install the waste toner container, and then lock it.
Xerox® DocuCentre® SC2020
User Guide

247



Maintenance
7. Turn the lock lever clockwise, and then close the front cover.

Note: If the front cover is not completely closed, an error code will appear and the device will remain 
paused.

Cleaning the Touch Screen

The following describes how to clean the touch screen.

1. Wipe only the LCD area with a soft cloth moistened with neutral detergent or alcohol.

When you moisten the cloth with neutral detergent or alcohol, do not allow the excess liquid to drip 
down from the cloth. If the cloth is moistened with the excess liquid, wring the cloth gently before 
wiping the LCD area.

Notes:

• Do not use any volatile liquids on the device such as benzene and paint thinner, or insect 
repellent as these may discolor, deform, or crack the device exterior.

• Cleaning the touch screen with an excessive force may cause the screen to be damaged. 
Wipe the screen gently.

Cleaning the Document Glass Cover and the Document Glass

If the document glass cover and the document glass become soiled, smudges may appear on copies, faxes, 
or scanned documents and the device may not detect the document sizes properly.

To ensure clean copies at all times, clean the document glass cover and the document glass about once a 
month.
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Do not use benzene, paint thinner, or other organic solvents. Doing so may damage paint or coating on 
plastic parts.

Note: Cleaning the device with an excessive amount of water may cause the device to malfunction or 
damage documents during copying, scanning, or faxing.

1. Wipe the document glass cover with a soft cloth moistened with water to remove any dirt, and then 
wipe it with a soft, dry cloth.

Do not use cleaning agents other than water or neutral detergent.

Note: If you cannot remove dirt easily, gently wipe the document glass cover with a soft cloth 
moistened with a small amount of neutral detergent.

2. Wipe the document glass with a soft cloth moistened with water to remove any dirt, and then wipe it 
with a soft, dry cloth.

Do not use cleaning agents other than water or neutral detergent.

Note: If you cannot remove dirt easily, gently wipe the document glass with a soft cloth moistened 
with a small amount of neutral detergent.

Cleaning the Document Presser and the Narrow Glass Strip

If the document presser or the narrow glass strip becomes soiled, smudges may appear on copies, faxes, or 
scanned documents and the device may not detect the document sizes properly.

To ensure clean copies at all times, clean the document presser and the narrow glass strip about once a 
month.
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Do not use benzene, paint thinner, or other organic solvents. Doing so may damage paint or coating on 
plastic parts.

Note: Cleaning the device with an excessive amount of water may cause the device to malfunction or 
damage documents during copying or scanning.

1. Wipe the document presser with a soft cloth moistened with water to remove any dirt, and then wipe 
it with a soft, dry cloth.

Do not press the film with an excessive force as it can be easily damaged.

Notes:

• Do not use cleaning agents other than water or neutral detergent.

• If you cannot remove dirt easily, gently wipe the document presser with a soft cloth 
moistened with a small amount of neutral detergent.

2. Wipe the narrow glass strip with a soft cloth moistened with water to remove any dirt, and then wipe 
it with a soft dry cloth.

Do not use cleaning agents other than water or neutral detergent.

Note: If you cannot remove dirt easily, gently wipe the narrow glass strip with a soft cloth moistened 
with a small amount of neutral detergent.

Cleaning Document Feeder Rollers

If the document feeder rollers become soiled, smudges may appear on copies, faxes or scanned documents 
and paper jams may occur.

To ensure clean copies at all times, clean the document feeder rollers about once a month.
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Do not use benzene, paint thinner, or other organic solvents. Doing so may damage paint or coating on 
plastic parts.

Note: Cleaning the device with an excessive amount of water may cause the device to malfunction or 
damage documents during copying, scanning, faxing or printing.

1. Lift the latch of the document feeder top cover until it is completely open.

Note: When you fully open the cover, it enters a fixed position. Open the cover gently.

2. While turning the rollers, wipe them with a soft cloth moistened with water.

Do not use cleaning agents other than water or neutral detergent.

Notes:

• Use a cloth firmly wrung to prevent water drops from falling into the device. If water gets 
into the device, it may cause the device to malfunction.

• If you cannot remove dirt easily, gently wipe the rollers with a soft cloth moistened with a 
small amount of neutral detergent.

3. Close the document feeder top cover until it clicks into place, and confirm that there is no space 
between the near or far side of the cover and the document feeder.

Managing the Device
This section describes how to check the device status using CentreWare Internet Services or the Status 
Messenger feature.
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Checking or Managing the Device with CentreWare Internet 
Services

When the device is installed in a TCP/IP environment, you can use CentreWare Internet Services to check 
the device status, the remaining volume of consumables, and the paper loaded in this device. You can also 
use CentreWare Internet Services to configure device settings.

Note: When using the device as a local printer, you cannot use CentreWare Internet Services.

Starting CentreWare Internet Services

Use the following procedure to start CentreWare Internet Services.

1. Launch your web browser.

2. Enter the IP address in the browser address field, and then press the Enter key.

The CentreWare Internet Services screen appears.

For more information on the items that can be set in each CentreWare Internet Services screen, click 
the [Help] button to display the online Help.

Status Messenger

When connected in a network environment where sending and receiving of email is possible, the device 
can send an email report to specified email addresses containing the following information:

• The network settings and the device status

• The error status which has occurred on the device

Setting the Email Environment

Activate CentreWare Internet Services. On the [Properties] tab, configure the following settings according 
to your email environment. After configuring the settings on each screen, always click [Apply] and then 
turn off/on the device to reboot. For information on each item, refer to the online help for CentreWare 
Internet Services.

Item Item to be configured Description

StatusMessenge
r

Recipient Email Address Set the email address where notices about 
changes in device status or errors are sent.

Notification Items Set the contents of the notices to send in the 
email.

Port Status StatusMessenger Select [Enabled].
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Checking the Device Status with Email

This section describes cautions when sending email to the device to check the device status.

• You can specify any title for the email when checking the device status or changing the device 
settings.

• Use the commands described in the next section to create the text of the email.

Commands That Can Be Used in Email Text

Use each command according to the following rules:

• Prefix all commands with “#”, and specify the #Password command at the top of the email.

• Command lines without “#” are ignored.

• Write one command on each line and separate each command and parameter with a space or a tab.

When the same command is written two or more times in one email, the second and subsequent 
commands are ignored.

Protocol 
Settings > Email

Device Email Address,
SMTP Server Address,
SMTP Server Port Number,
E-Mail Send Authentication,
Login Name,
Password,
SMTP Server Connection Status,
POP3 Server Address,
POP3 Server Port 
Number,
Login Name,
Password,
POP3 Server Check Interval,
APOP Settings,
POP3 Server Connection Status

Select appropriate settings for sending and 
receiving email.

Permitted Email Address When setting the permission for checking 
information and changing the settings for an 
email address, enter the email address that is 
permitted to receive the email. If no address is 
entered here, the device receives emails from 
all users.

StatusMessenger Password When setting the password for access to the 
device (both read only and read/write), enter 
the password in the [Password] field.

Item Item to be configured Description
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Example of Commands

When the read only password is “ronly”, and to check the device status:

#Password ronly

#Status

#NetworkInfo

Command Parameter Description

#Password Password Use this command at the top of the email when a 
password for read only is set. You can omit this command 
when the password is not set.

#NetworkInfo - Set this when you want to check information on the 
network settings list.

#Status - Set this when you want to check the device status.
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13
Problem Solving

This chapter provides possible solutions to various problems you may encounter with the device.

Troubleshooting
This section describes troubles that may occur with the device and their solutions.

Follow the troubleshooting procedure below to solve the problems.

1. There is a problem with the device operation

– Yes: Refer to Device Problems on page 256

– No: A message is displayed.

2. Message displays a paper or document jam?

– Yes: For information on paper jams, refer to Paper Jams on page 287. For information on 
document jams, refer to Document Jams on page 292.

If the message displays an error code, refer to Error Code on page 277.

– No: The image quality is poor.

3. Is the image quality poor?

– Yes: Refer to Image Quality Problems on page 260.

– No: There is a problem when using the Copy, Print, Fax, Scan, or Scan Driver or Printer Utility 
features.

4. Is there problems with Copy, Print, Fax, Scan, or Scan Driver or Printer Utility?

– Yes: Refer to the corresponding topics:

Copying Problems on page 267

Printer Problems on page 270

Fax Problems on page 271

Scan Problems on page 273

Scan Driver/Printer Utility Problems on page 276

– No: If you cannot resolve an error despite following the above procedure, contact our Customer 
Support Center.

Device Problems
Check the device's status again if you suspect a malfunction.
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Symptoms Possible Cause Remedy

The device is not 
powered on.

Is the power switched ON? Switch the power ON.
Refer to Power Source on page 45.

Is the power cord plugged 
into the power outlet?

Switch the power OFF and make sure the 
power plug is inserted securely. Then switch 
the power ON.

Is the power cord 
disconnected from the 
device?

Does the AC outlet supply 
power properly

Connect another appliance to the outlet to 
verify the power supply.

The <Error> LED is 
blinking.

The system of the device or 
the components installed 
may have a trouble.

Switch the power OFF, then ON again. If the 
problem persists, contact our Customer 
Support Center.

The <Error> LED is lit. Is paper or document 
jammed?

Remove the jammed paper or document.
Refer to Paper Jams on page 287.
Refer to Document Jams on page 292.

Is the device front cover or 
another cover open?

Follow the instructions in the displayed error 
code to take the required action.
Refer to Error Code on page 277.

The display is dark. Is the <Power Saver> 
button lit?

The device is in an Power Saver mode. Press 
the control panel's <Power Saver> button to 
turn off the Power Saver mode.

Unable to print
or copy.

Is there an error code 
displayed in the control 
panel's display?

Follow the instructions in the displayed error 
code to take the required action.
Refer to Error Code on page 277.

Is the power cord 
connected?

Switch the power OFF and make sure the 
power plug is inserted securely into the 
power outlet. Then switch the power ON.

The <Data> LED does 
not light even though 
you instructed the 
device to print.

Is the interface cable 
connected?

Check the interface cable connection.
Refer to Interface Cables on page 28

Is the computer's 
environment correctly set?

Check the computer environment such as 
print driver settings.

Is the required port status 
set to [Enabled]?

Check the status of the port to use, and then 
set the port status to [Enabled].
Refer to Activating the Communication Port 
To Use on page 36.
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Unable to print 
although a print job is 
instructed to Tray 5 
(bypass).

Is the specified paper size 
loaded in the tray?

Follow the instructions in the displayed error 
code to place paper of the correct size, and 
then try again.
Refer to Error Code on page 277.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.

The print quality is 
poor.

An image quality problem 
may have occurred.

Take the required action described in "Image 
Quality Problems".
Refer to Image Quality Problems on 
page 260.

Unable to insert or 
remove a tray.

Did you open a cover or 
switch the device off 
during printing?

Do not forcibly insert or remove the tray. 
Switch off the power. In a few seconds, 
switch on the power. When the device is 
ready to receive data, insert or remove the 
tray.

Unable to copy with the 
specified size.

Is the document glass or 
the document glass cover 
dirty?

Clean the document glass or document glass 
cover.
Refer to Cleaning the Document Glass Cover 
and the Document Glass on page 248.

Is the document a 
transparency or highly 
translucent medium?

Use the document glass to copy the 
document, placing a sheet of white paper on 
top of it.

Is the document in the 
correct position?

Place the document correctly.
Refer to Placing Document on page 68.

Is the document loaded 
correctly?

Are the document guides 
on the document feeder 
set in the correct positions?

Align the document guides correctly.
Refer to Placing Document on page 68.

Is the document folded? Smooth out the document and place it 
again correctly.
Refer to Placing Document on page 68.

Symptoms Possible Cause Remedy
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Paper is often jammed 
or wrinkled.

Is paper loaded correctly in 
the tray?

Load paper correctly.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.

Is the tray inserted 
correctly?

Correctly insert the tray by firmly pushing it 
until it stops. Refer to Loading Paper in Trays 
1 and 2 on page 61

Is the paper damp? Replace the paper with a new one.

Is the paper curled? Turn over the paper in the tray, or replace the 
paper with a new one.

Are the paper and tray 
settings correct?

Correctly set the paper settings to 
correspond to the paper loaded.
Refer to Changing the Paper Size for Trays 1 
and 2 on page 65.

Are any torn pieces of 
paper remaining or is there 
a foreign object in the 
device?

Open the cover of the device or pull out the 
tray to remove any torn pieces or foreign 
objects.
Refer to Paper Jams on page 287.

Is non-standard paper 
loaded in the tray?

Replace with paper that meets device 
specifications.
Refer to Paper Types on page 56.

Is paper exceeding the 
maximum fill line in the 
tray?

Load paper in the tray so that it does not 
exceed the maximum fill line.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.

Are the paper guides set 
correctly?

Load paper correctly, and align the paper 
guides to the paper.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.

Is the paper finely cut out? Some paper types may not be cut out finely. 
Load the paper after fanning it well.

A document is not fed 
onto document feeder.

Is the document small? The minimum size of document that can be 
loaded into the document feeder is A5 .

An error code appears 
when paper is loaded in 
Tray 5 (bypass) and the 
<Start> button is 
pressed.

Check the positions of the 
paper guides of Tray 5 
(bypass).

Adjust the paper guides to the correct 
positions.
Refer to Error Code on page 277.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.

Symptoms Possible Cause Remedy
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Image Quality Problems
If the image quality of the printout is poor, use the table below to find our most likely cause, and take the 
required action.

If the image quality remains poor after taking the required action, contact our Customer Support Center.

Documents often jam. Are suitable types of 
documents being used?

Correctly load the documents suitable for 
the document feeder.
Refer to Placing Document on page 68.Are you using the irregular 

shaped documents, 
business cards, 
transparencies, or thin 
documents?

Are there any sticky tags, 
paper clips or adhesive 
tape on the document?

Remove any sticky tags, paper clips, or 
adhesive tape from the document before 
copying.

Are the document guides 
set in the correct positions?

Adjust the document guide positions.
Refer to Placing Document on page 68.

Is a piece of torn paper 
remaining in the document 
feeder?

Open the document feeder top cover and 
check inside.
Refer to Document Jams on page 292.

An edge of the 
document is folded.

Is the document curled? Flatten the curl and load the document 
again.

Symptoms Possible Cause Remedy
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Symptoms Possible Cause Remedy

Copies are dirty. Is the document glass or the 
document glass cover dirty?

Clean the document glass or the document 
glass cover.
Refer to Cleaning the Document Glass 
Cover and the Document Glass on 
page 248.

Is the document a 
transparent type such as a 
transparency medium?

When copying highly translucent 
documents, dirt on the document glass 
cover shows up in the copy. Place a sheet of 
white paper over the document before 
copying.

Is the document on colored 
or rough paper, or a 
blueprint?

Adjust the copy density or remove the 
background paper color before copying.
Refer to Lighten/Darken on page 84.
Refer to Auto Background Suppression on 
page 202.

Is the document on glossy 
printing paper?

Glossy printing paper easily sticks to the 
document glass, and shadows can resemble 
dirt in the copy. Place a transparency or 
transparent film under the document 
before copying.

Black lines appear in 
copies.

Is the document feeder's 
narrow glass strip dirty?

Clean the narrow glass strip.
Refer to Cleaning the Document Glass 
Cover and the Document Glass on 
page 248.

Copies are too dark. Is the copy density set to a 
high value?

Adjust the copy density.
Refer to Lighten/Darken on page 84.

Copies are too light. Is the document light?

Is the copy density set to a 
low value?

The copy is slightly out 
of position.

Is the paper loaded in the 
correct position such as the 
paper's leading edge drifted 
away from the corners of 
the tray?

Load paper correctly, and align the paper 
guides to the paper.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.
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Copies are out of 
position or crooked.

Have you placed the 
document correctly?

Place the document correctly.
Refer to Placing Document on page 68.

Is the paper loaded correctly 
in the tray?

Load the paper correctly.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.

If using Tray 5 (bypass), 
have you loaded the paper 
so that the paper guides are 
in contact with it?

Load the paper correctly.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.

Are the document feeder's 
document guides 
misaligned?

Place the document correctly, moving the 
document guides into contact with the 
edges of the document.
Refer to Placing Document on page 68.

Have you mounted the tray 
securely?

Mount the tray by inserting it securely all 
the way into the device.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.

You can adjust the alignment of the printed 
image.
Refer to Adjust Alignment on page 185.

Copies have missing 
parts in them.

Is the paper damp? Damp paper creates missing parts or 
unclear copies. Replace it with paper from 
an unopened pack.

Is the paper in the tray 
creased or wrinkled?

Remove any problematic sheets, or replace 
the paper with paper from an unopened 
pack.

Are you copying a cut-and-
pasted or creased 
document?

Cut-and-pasted or creased parts of the 
document may not be making proper 
contact with the document glass. Place a 
stack of white paper on top of the 
document to bring it into proper contact 
with the document glass.

Striped patterns appear 
in copies.

Are you attempting to make 
an enlarged copy of the 
document with a too large 
enlargement factor?

When making enlarged copies, some 
enlargement factors can create striped 
patterns. Adjust the copy enlargement 
factor.
Refer to Reduce/Enlarge on page 81.

Symptoms Possible Cause Remedy
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The printout is light 
(faded, unclear). 

The paper is damp. Replace the paper with new paper.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

The toner cartridge has run 
out of toner.

Replace the toner cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

Black spots appear in 
copies.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

Black or colored lines 
appear in printouts.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

The narrow glass strip is 
dirty.

Clean the narrow glass strip.
Refer to Cleaning the Document Presser 
and the Narrow Glass Strip on page 249.
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Dirt appears at regular 
intervals in the printout.

Paper feed direction

The paper feed path is dirty. Print several sheets.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

White spots appear in 
areas of black fill.

The paper is unsuitable. Load the correct type of paper.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

The printout comes off 
on the fingers.
The toner is not fused 
to the paper.
The paper is 
contaminated with 
toner.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

Symptoms Possible Cause Remedy
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The entire printout is 
black.

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

A high-voltage power supply 
failure may have occurred.

Contact our Customer Support Center.

The printout is blank. Multiple pages were fed 
through the device at once 
(double feeding).

Riffle through the stack of paper 
thoroughly before loading it.

The toner cartridge has run 
out of toner.

Replace the toner cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

A power failure or high-
voltage power supply failure 
may have occurred.

Contact our Customer Support Center.

The printout contains 
white areas, or white or 
colored stripes.

The paper is damp. Replace the paper with new paper.

The paper is unsuitable. Load the correct type of paper.

The printout is faint 
overall.

When using the Tray 5 
(bypass) to print, the paper 
size specified in the print 
driver does not match the 
type and size of the paper 
actually loaded.

Load paper of the correct type and size in 
the Tray 5 (bypass).
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.

Multiple pages were fed 
through the device at once.

Ruffle through the stack of paper 
thoroughly before leading it.
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The paper is wrinkled. The paper is unsuitable. Replace the paper with new paper.

Paper has been added to 
the paper loaded.

The paper is damp.

Text is blurry. The paper is unsuitable. Replace the paper with new paper.

Paper has been added to 
the paper loaded.

The paper is damp.

White or color patches 
appear vertically.

Paper feed direction

The drum cartridge has 
deteriorated or been 
damaged.

Replace the drum cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

The toner cartridge has run 
out of toner.

Replace the toner cartridge with a new one.
Refer to Replacing the Drum Cartridge on 
page 244.

The printout is slanted. The paper cassette's paper 
guides are not aligned to 
the correct position.

Align the horizontal and vertical paper 
guides properly.
Refer to Loading Paper in Trays 1 and 2 on 
page 61.
Refer to Loading Paper in Tray 5 (bypass) on 
page 63.
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Copying Problems
This section provides possible solutions to various problems you may encounter when using the Copy 
features.

Unable to Copy

The table below lists possible solutions when you are unable to copy.

Copy Output Problems

The table below lists possible solutions to problems with the copy output.

The color registration is 
out of alignment.

The color registration is 
displaced by installing the 
device or replacing 
components.

Adjust the color registration.
Refer to Auto Registration on page 186.

Symptoms Possible Cause Remedy

The document is not 
fed properly through 
the document feeder.

The document size is too 
small.

The minimum size of document that can be 
loaded on the document feeder is A5 .

The document is not a 
supported type.

The document feeder does not support 
warped documents, business cards, 
transparencies, thin documents,
or documents with attached stick-on notes, 
paper clips or tape.
Refer to Paper Types on page 56.

The document guides are 
misaligned.

Align the document guides properly to 
match the document size.

There are document shreds 
stuck in the document 
feeder.

Open the document feeder top cover, and 
remove the document shreds.
Refer to Document Jams on page 292.

You have placed a 
document containing 
pages of different sizes.

You cannot place documents with different 
size pages.

Symptoms Possible Cause Remedy
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Symptoms Possible Cause Remedy

Copies are dirty. The document glass 
cover or document glass 
is dirty.

Clean the document glass cover or document 
glass.
Refer to Cleaning the Document Glass Cover 
and the Document Glass on page 248.

The document is a 
transparency or highly 
translucent medium.

When copying highly translucent documents, 
dirt on the document glass cover shows up in 
the copy. Place a sheet of white paper over the 
document before copying.

The document is on 
colored or rough paper, or 
is a blueprint.

The paper's background color is being copied. 
Adjust the copy density or image quality, or 
specify background suppression before 
copying.

The document is printed 
on glossy printing paper.

Glossy printing paper easily sticks to the 
document glass, and shadows can resemble 
dirt in the copy. Place a transparency or 
transparent film under the document before 
copying.

Copies are too dark or 
too light.

The copy density 
adjustment is not right. 

Adjust the copy density.
Refer to Lighten/Darken on page 84.

The document is light. Adjust the copy density.
Refer to Lighten/Darken on page 84.

The image quality setting 
is not correct for the 
document.

If the copy output of black text is too light, set 
[Original Type] to [Text].
Refer to Original Type on page 85.

The copy is slightly out 
of position.

The paper loaded in the 
tray is misaligned.

Align the paper stack, and load it so that the 
leading edge of the paper is aligned with the 
front corners of the tray.

Copies have missing 
parts in them.

The paper is damp. Damp paper creates missing parts or unclear 
copies. Replace it with paper from an 
unopened pack.

The paper in the tray is 
creased or wrinkled.

Remove any problematic sheets, or replace the 
paper with paper from an unopened pack.

The document has been 
cut-and-pasted, or is 
creased.

Cut-and-pasted or creased parts of the 
document may not be making proper contact 
with the document glass. Place a stack of 
white paper on top of the document to bring it 
into proper contact with the document glass.
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Striped patterns appear 
in copies.

The document's 
enlargement factor is too 
large.

When making enlarged copies, some 
enlargement factors can create striped 
patterns. Adjust the copy enlargement factor.
Refer to Reduce/Enlarge on page 81.

Copies are out of 
position or crooked

You have not placed the 
document correctly.

Place the document correctly.
Refer to Placing Document on page 68.

The document feeder's 
document guides are 
misaligned.

Place the document correctly, moving the 
document guides into contact with the edges 
of the document.

You have not mounted 
the tray securely.

Mount the tray by inserting it securely all the 
way into the device.

The paper guides of Tray 
5 (bypass) are 
misaligned.

Place the document correctly, moving the 
document guides into contact with the edges 
of the document.

The document size is not 
correct.

Check the document size set correctly.
Refer to Original Size on page 88.

The paper size is not 
correct.

Check the paper size set correctly.
Refer to Changing the Paper Settings on 
page 66.

The copy is not the 
desired size.

The document glass 
cover or document glass 
is dirty.

Clean the document glass cover or document 
glass.
Refer to Cleaning the Document Glass Cover 
and the Document Glass on page 248.

The document is a 
transparency or highly 
translucent medium.

Place a sheet of white paper over the 
document before copying.
Refer to Placing Document on page 68.

The document has 
shifted out of position.

Place the document correctly.
Refer to Placing Document on page 68.

The document feeder's 
document guides are 
misaligned.

Place the document correctly, moving the 
document guides into contact with the edges 
of the document.
Refer to Placing Document on page 68.

The document is creased. Smooth out the document and place it again 
correctly.
Refer to Placing Document on page 68.

The edges of copies are 
cut off.

The document exceeds 
the printable area.

Adjust the reduction/enlargement factor to 
reduce the copy slightly.
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Printer Problems

Unable to Print

The table below lists possible solutions when you are unable to print.

Print Output Problems

The table below lists possible solutions to print output problems.

Symptoms Possible Cause Remedy

Data remains in the 
printer icon.

The device's power is not 
ON.

Switch the device's power ON.
Refer to Power Source on page 45.

The computer's cable is 
disconnected.

Connect the computer's cable.

The device's cable is 
disconnected.

Connect the device's cable.
Refer to Interface Cables on page 28.

An error has occurred in 
the device.

Check the error information, and take the 
required action.

There is a problem in the 
network connecting the 
computer and device.

Contact your Network Administrator.

The port is not activated. Activate the port to use.
Refer to Activating the Communication Port To 
Use on page 36.

The device is connected 
to multiple computers.

Wait a while, and then try printing again.

Data has been sent to 
the device.

No paper has been 
loaded.

Load paper.

There is no paper of the 
specified size.

Load paper of the specified size.
Refer to Loading Paper on page 61.

An error has occurred in 
the device.

Check the error information, and take the 
required action.

Job execution has been 
paused.

Use the screen to select whether to cancel the 
job.
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Fax Problems
The table below lists possible solutions to fax problems.

Symptoms Possible Cause Remedy

The printout is on the 
wrong paper size.

The wrong size paper was 
loaded in the specified 
tray.

Change the size of the paper loaded in the 
tray, or change the print options to use a tray 
containing the specified paper size.

The image at the edges 
of the paper is missing.

The document exceeds 
the device printable area.

Enlarge the device print area, or reduce the 
document print area.

The settings specified 
in the printing options 
are disabled.

The print driver of 
another model device is 
in use.

Install the device print driver.

An option has not been 
mounted.

Check the options mounted in the device, and 
then reselect the items in [Items] under 
[Options] in the print driver.

Check the options 
mounted in the device, 
and then reselect the 
items in [Items] under 
[Options] in the print 
driver.

Confirm whether the 
print driver on the 
computer is the one 
supplied with the device.

On the computer, select the print driver 
supplied with the device. If the print driver is 
not listed for selection, install the print driver 
and then select it. Operation is not 
guaranteed if another company's print driver 
is used.

Symptoms Remedy

The device is not working, there is no 
display and the buttons are not working.

Unplug the power cord and plug it in again.

Ensure that there is power to the electrical receptacle.

No dial tone sounds. Check that the phone line is connected properly.

Check that the phone socket in the wall is working by 
plugging in another phone.

The numbers stored in the memory do not 
dial correctly.

Ensure that the numbers are stored in the memory 
correctly.

Print an Address Book list.

The document does not feed into the 
device.

Ensure that the document is not wrinkled and you are 
putting it in correctly. Check that the document is of the 
right size, not too thick or thin.
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Ensure that the document feeder top cover is firmly 
closed.

Faxes are not received automatically. Check that the phone line is connected properly.

The Fax mode should be selected.

Ensure that there is paper in the paper tray.

If the time interval specified for the following features is 
too long, change the time interval shorter such as 30 
seconds.

5. Auto Answer Fax

6. Auto Ans. TEL/FAX

7. Auto Ans. Ans/FAX

The device does not send faxes. [Sending Fax] should show up on the display.

Check the other fax device you are sending to, to see if 
it can receive your fax.

Check the [Dial Type] for [PB], [DP(10PPS)] or 
[DP(20PPS)].

Ensure that the document is loaded in the document 
feeder or on the document glass.

The incoming fax has blank spaces or is 
received in poor quality.

Check the device by making a copy.

The toner cartridge may be empty. Replace the toner 
cartridge.

A noisy phone line can cause line errors. Set the fax 
modem speed to a slower speed.

The fax device sending you the fax may be faulty.

Some of the words on an incoming fax are 
stretched.

The fax device sending you the fax had a temporary 
document jam.

There are lines on the documents you 
send.

Check the surface of the document glass and document 
feeder glass for marks and clean it.
Refer to Cleaning the Device on page 245.

The device dials a number, but the 
connection with another fax device fails.

The other fax device may be turned off, out of paper, or 
cannot answer incoming calls. Speak with the other 
device operator and ask her/him to sort out the 
problem.
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Scan Problems
This section provides possible solutions to various problems you may encounter when using the Scan 
feature.

The table below lists possible solutions when you are unable to scan.

Documents are not stored in the memory. There may not be enough memory to store the 
document. If the display shows a [Memory Full] 
message, delete any documents you no longer need 
from the memory and then restore the document, or 
wait for the job in progress (e.g., a fax transmission or 
reception) to complete.

Blank areas appear at the bottom of each 
page or on other pages, with a small strip 
of text at the top.

You may have chosen the wrong paper settings in the 
user option setting.
Refer to Paper Types on page 56.

The device will not send or receive faxes. Ensure that the region code is set correctly under 
<Machine Status>  [Tools]  [Admin Settings]  [Fax 
Settings]  [Fax Line Settings]  [Region].

Check the [Dial Type] for [PB], [DP(10PPS)] or 
[DP(20PPS)].

Check that the cables are connected properly.

If the telephone line cord is connected to the device via 
any device such as an answering device and a 
computer, remove the device and directly connect the 
telephone line cord to the device.

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed under <Machine Status>  
Tools  Admin Settings  Fax Settings  Transmission 
Defaults  Modem Speed.

The device receives faxes, but it does not 
print.

Check the toner level.

Ensure that there is paper in the paper tray.

Ensure that [Forward Settings] is set to [Off].

Ensure that [Junk Fax Filter] is set to [Off].

Ensure that [Secure Receive Set] is set to [Disable].

Execute [Initialize NVM].
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Symptoms Remedy

The scanner does not work. Ensure that you place the document to be scanned facing 
down from the document glass, or facing up in the 
document feeder.

There may not be enough available memory to hold the 
document you want to scan. Try the Preview function to see 
if that works. Try lowering the scan resolution rate.

Check that the USB cable or Ethernet cable is connected 
properly.

Ensure that the USB cable or Ethernet cable is not 
defective. Switch the cable or adapter with a known good 
cable or adapter. If necessary, replace it.

Check that the scanner is configured correctly. Check the 
application you want to use to make certain that the 
scanner job is being sent to the correct port.

Ensure that the scanner sharing feature is disabled when 

you use Mac OS® X before you scan documents via an ICA 
compatible application such as Image Capture. The device 
does not support the scanner sharing feature of Mac OS X. 
Select a printer which is directly connected to the computer 
via USB or wired LAN and scan documents.

The device scans very slowly. Graphics are scanned more slowly than text when you use 
the Email or Scan To Network feature.

Communication speed becomes slow in scan mode because 
of the large amount of memory required to analyze and 
reproduce the scanned image.

Scanning images at a high resolution takes more time than 
scanning at a low resolution.
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Document misfeeds or multiple feeds 
occur in the document feeder.

Check whether the document feeder roller assembly is 
installed properly.

Ensure the document's paper type meets the specifications 
for the device.

Check whether the document is properly loaded in the 
document feeder.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed 
the maximum capacity of the document feeder.

Ensure that the document is not curled.

Fan the document well before loading it in the document 
feeder.

Vertical stripes appear on the output 
when scanned using the document 
feeder.

Clean the document feeder glass.
Refer to Cleaning the Device on page 245.

Clean inside the device by using the cleaning rod.
Refer to Cleaning the Device on page 245.

A smear appears at the same location 
on the output when scanned using the 
document glass.

Clean the document glass.
Refer to Cleaning the Device on page 245.

Images are skewed. Ensure that the document is loaded straight in the 
document feeder or on the document glass.

Diagonal lines appear jagged when 
scanned using the document feeder.

If the document uses thick media, try scanning it from the 
document glass.

Message appears on your computer 
screen:
• Device can't be set to the H/W 

mode you want.
• Port is being used by another 

program.
• Port is Disabled.
• Scanner is busy receiving or 

printing data. When the current job 
is completed, try again.

• Invalid handle.
• Scanning has failed.

There may be a copying or printing job in progress. When 
the current job is complete, try the job again.

The selected port is currently being used. Restart your 
computer and try again.

Symptoms Remedy
Xerox® DocuCentre® SC2020
User Guide

275



Problem Solving
Scan Driver/Printer Utility Problems
The table below lists possible solutions to scan driver/printer utility problems.

The cable may be improperly connected or the power may 
be off.

The scan driver is not installed or an operating environment 
is not set up properly.

Ensure that the port is properly connected and the power is 
turned on. Then restart your computer.

Check that the USB cable, Ethernet cable is connected 
properly.

The device does not properly transfer 
scan data to a specified destination via 
the Scan to Email or Scan To Network 
feature.

Check if the following settings have been set correctly on 
the CentreWare Internet Services.
Scan To Network

Check the following settings under [Address Book]  
[Computer/Server Address Book]  [Edit Network Scan 
Address]:
• Server Address
• Login Name
• Login Password
• Share Name (Displays only when [Server Type] is set to 

[SMB])
• Server Path
Scan to Email

Check the following setting under [Address Book]  [Email 
Address Book]:
Address

Symptoms Remedy

Unable to retrieve the Address Book 
data from the printer on the Address 
Book Editor.

Check that the USB cable or Ethernet cable is connected 
properly.

Ensure that the device is turned on.

Ensure that the scan driver is installed on your computer. (The 
Address Book Editor retrieves the Address Book data via the 
scan driver when the device is connected using a USB cable.)
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Error Code
This section describes error codes.

An error message and error code (xxx-xxx) are displayed if printing terminated abnormally because of an 
error, or a malfunction occurred in the device.

Refer to the error codes in the following table to resolve problems.

If an error code is displayed, any print data remaining in the device and information stored in the device's 
memory is not secured.

The TWAIN driver cannot connect to 
the device.

Check that the USB cable is connected properly.

Check whether the device is on. If the device is on, reboot it 
by turning the power switch off and then on again.

If a scan application is running, close the application once, 
restart the application, and then try scanning again.

Failed to scan your document on the 
device via Express Scan Manager.

Ensure that your computer and the device is properly 
connected with the USB cable.

Check whether the device is on. If the printer is on, reboot it 
by turning the power switch off and then on again.

If a scan application is running, close the application once, 
restart the application, and then try scanning again.

Network connection cannot be used. Connect with the USB 
cable.

Uninstall Express Scan Manager on your computer and then 
re-install it.

Failed to create an image file via 
Express Scan Manager.

Ensure there is sufficient space in your hard disk.

Uninstall Express Scan Manager on your computer and then 
re-install it.

Failed to initialize Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then 
re-install it.

Failed to execute Express Scan 
Manager.

Uninstall Express Scan Manager on your computer and then 
re-install it.

An unexpected error occurred on 
Express Scan Manager.

Uninstall Express Scan Manager on your computer and then 
re-install it.
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If an error code is displayed that is not listed in the following table, or if you cannot resolve an error despite 
following the instructions described in the table, contact our Customer Support Center.

Symptoms Remedy

005-942 The original size is not detected accurately. Check the originals loaded in 
the document feeder, reload the originals, and then press the <Start> 
button.

Note: When using a non-standard size document, specify the original size 
in [Original Size]. Depending on the selected document size, the printout 
may be too large for the paper or may have shadows at the edges.

016-503 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the SMTP server and the DNS server are set correctly on 
CentreWare Internet Services.

016-504 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the POP3 server and the DNS server are set correctly on 
CentreWare Internet Services.

016-505 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the user name and password used for the POP3 server are 
set correctly on CentreWare Internet Services.

016-506 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the SMTP server or the POP3 server is set on CentreWare 
Internet Services.

016-507 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the user name and password used for the SMTP server are 
set correctly on CentreWare Internet Services.

016-520
016-521

Contact your system administrator.

016-570
016-571
016-572
016-573
016-718
016-720

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

016-737
016-741
016-742
016-743
016-744
016-745

Switch off the device power, make sure that the touch screen is blank, and 
then switch on the device power. Contact our Customer Support Center if 
this failure is repeated.
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016-746 Select [Close] to recover the device.

016-757
016-758
016-759

Contact your server administrator.

016-764
016-765
016-766

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Contact the SMTP server administrator.

016-767
016-768

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the email address, and try scanning again.

016-786
016-790

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the network cable is connected properly. If there is no 
problem with the network cable, contact your server administrator.

016-799
016-921

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

016-985
016-986

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Lower the resolution or change the file format of the scanned 
image, and retry scanning.

017-970
017-971
017-972
017-973
017-974
017-975
017-976
017-977
017-978
017-979
017-980
017-986
017-987
017-988
017-989

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

031-521 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Confirm the login-able computers with your system administrator.

031-522 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the login name (domain name and user name) and 
password are correct.
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031-523 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the share name you specified.

031-524 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the number of users who use the server at the same time is 
not exceeding the upper limit.

031-525 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the specified user can read and write a file at the storage 
location.

031-526 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the DNS connection, or check if the forwarding destination 
server is registered with DNS.

031-527 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Set the DNS address, or set the forwarding destination server 
address as an IP address.

031-528 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.
Check if the device can communicate via network with the forwarding 
destination SMB server. For example, check the following:
• Connection of the network cable
• TCP/IP settings
• Communication with Port 137 (UDP), 138 (UDP), and 139 (TCP)
For communication beyond the subnet, check the settings of the WINS 
server and if the server name can be resolved correctly.

031-529 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the password is correct.

031-530 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the storage location is correct. The storage location you 
specified is DFS setting, and check if it is linked to other server. Specify 
directly the linked server, the share name, and the storage location.

031-531 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the access right of the folder you specified.

031-532 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Shorten the name of the file or the forwarding destination folder.
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031-533 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the following:
• A file with the name you specified can be created in the storage 

location.
• The file name you specified is not used by any other user.
• Any file or folder that has the same name as the one you specified does 

not exist.

031-534 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the following:
• A file with the name you specified can be created in the storage 

location.
• Any file or folder that has the same name as the one you specified does 

not exist.

031-535
031-536

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if any other user is not operating the file in the storage 
location you specified.

031-537 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the storage location has free space.

031-539 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the server name is correct.

031-540 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the domain name is correct.

031-541 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the login name (user name) is correct.

031-542 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Wait for a while and try the same operation again. Contact our 
Customer Support Center if this failure is repeated.

031-543 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the login permitted time with your system administrator.

031-544 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the password valid period with your system administrator.

031-545 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the necessity of password change with your system 
administrator.

031-546 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the user invalid setting with your system administrator.

031-547 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the user lock-out status with your system administrator.
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031-548 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the user valid period with your system administrator.

031-549 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. On the server security settings, check the access permission of null 
password user.

031-550 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the append access right to the file. Check if the server 
supports the SMB append command.

031-551 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the rename access right to the file. Check if the server 
supports the SMB rename command.

031-552 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Set other than "Cancel" for processing in the case of file name 
duplication, or rename/delete the file whose name is the same as the one 
specified in the sending destination folder.

031-574 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the DNS connection, or check if the name of the forwarding 
destination server is registered with DNS.

031-575 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Set the DNS address, or set the forwarding destination server 
address as an IP address.

031-576 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the server's IP address is correct, or check the connection 
of the network cable.

031-578 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the login name (user name) and password are correct.

031-579 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the storage location is correct.

031-580 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the server access right.

031-581 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Shorten the name of the file or the forwarding destination folder.

031-582 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if a file with the name you specified can be created in the 
storage location. Check if the storage location has free space.

031-584 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if a folder with the name you specified can be created in the 
storage location. Check if a folder that has the same name as the one you 
specified already exists.
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031-585
031-587

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the server access rights.

031-588 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the storage location has free space.

031-590 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Set other than "Cancel" for processing in the case of file name 
duplication, or rename/delete the file whose name is the same as the one 
specified in the sending destination folder.

031-594
031-595

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Try the same operation again. Contact our Customer Support 
Center if this failure is repeated.

031-598 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the append access right to the file and if the server supports 
the FTP append command.

031-599 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the rename access right to the file. Check if the server 
supports the FTP rename command.

033-500
033-501
033-502
033-503
033-510
033-511
033-512

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

033-513 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Try the following:
• Print the received fax, or wait for a while until the fax is sent.
• Print the fax job stored using the Secure Receive feature.
For more information on the Secure Receive feature, refer to Secure Receive 
on page 169.
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033-514
033-515
033-516
033-517
033-518
033-519
033-520
033-521
033-522
033-523
033-524
033-525
033-526
033-573
033-751
033-752
033-753
033-754
033-755
033-756
033-757
033-758
033-759
033-760
033-761

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

033-762 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. The device rejected a fax from the blocked number.
For more information, refer to Junk Fax Filter on page 169.
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033-763
033-764
033-765
033-766
033-767
033-768
033-769
033-770
033-771
033-772
033-773
033-774
033-775
033-776
033-777
033-779
033-782
033-784
033-786
033-787

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

033-788 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Try the following:
• Remove the received fax, or wait for a while until the fax is sent.
• Print the fax stored using the Secure Receive feature.
For more information on the Secure Receive feature, refer to Secure Receive 
on page 169.

033-789
033-790
033-791
033-799
034-508

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

034-515 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Try the following:
• Retry the same operation.
• Check if the memory of the device or remote device is full. 
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034-791 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the following:
• If the telephone line cord is connected properly
• Tone/pulse setting
• If the remote device can receive a fax
For more information on the tone/pulse setting, refer to Dial Type on 
page 172.

034-799 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

035-701 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the following:
• Status of the remote device
• Tone/pulse setting
For more information on the tone/pulse setting, refer to Dial Type on 
page 172.

035-702
035-704
035-705
035-706

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

035-708 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Try the following:
• Retry the same operation.
• Reduce the modem speed.
For more information on the modem speed, refer to Modem Speed on 
page 173.

035-709
035-710
035-716

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

035-717 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Reduce the modem speed.
For more information on the modem speed, refer to Modem Speed on 
page 173.

035-718 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the status of the remote device.

035-720 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check the features supported by the remote device.
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Paper Jams
This section describes procedures to clear paper jams.

Carefully remove the jammed paper without tearing it. Do not leave any pieces of paper in the device.

WARNING: If you need to pull out a tray to remove paper jam, contact your local Xerox representative. Do 
not pull out a tray, otherwise it may cause injuries.

CAUTION: Do not attempt to remove a paper deeply jammed inside the product, particularly a paper 
wrapped around the fusing unit or the heat roller. Otherwise, it may cause Injuries or burns. Switch off 
the product immediately and contact your local Xerox representative.

Note: Do not attempt to clear any jams using tools or instruments. This may permanently damage the 
device.

035-728
035-729
035-730
035-737
035-739
035-740
035-742
035-746
035-779

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

035-781 Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover. Check if the remote device is busy.

035-792
035-793

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

062-956 The original size is not detected accurately. Check the originals placed on 
the document glass, reload the originals, and then press the <Start> button.

Note: When using a non-standard size document, specify the original size 
in [Original Size]. Depending on the selected document size, the printout 
may be too large for the paper or may have shadows at the edges.

116-721
116-722

Select [Close], or wait for the time set in [Fault Timeout] for the device to 
recover.

118-390 A device not supported by the device is installed. Remove the device and 
restart the device.

Symptoms Remedy
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Paper Jam in Left Side Cover [A]

Follow the steps below to clear paper jams inside the device's left side cover [A].

When removing paper, there may be an image on the device's Transfer Belt (the black film belt) inside the 
left side cover [A]. Do not touch the Transfer Belt. Image quality may be affected, or the Transfer Belt may 
be damaged and need replacement.

1. Open Tray 5 (1), and then while lifting up the release lever (2) gently open the top left cover (3).

If the paper is jammed around the fusing unit
1. Pull down the handle [A1].

2. Remove the jammed paper.

Note: Do not leave any torn pieces of paper inside the device.

3. Return the handle [A1] back to its position.
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4. Push on the center of the top left cover, close it slowly, and raise the Tray 5 (bypass).

If the paper is jammed within the left side cover [A]
1. If the paper is jammed in the location as shown in the right figure, lift the handle [A2], and then 

remove the jammed paper pulling upwards.

2. Return the handle [A2] to its position.

3. Push on the center of the left side cover [A], close it slowly, and raise the Tray 5 (bypass).
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Paper Jam in Left Side Cover [B]

Follow the steps below to clear paper jams inside the device's left side cover [B].

1. Pull the release lever, and slowly open the left side cover [B].

2. Remove the jammed paper.

Notes:

• The paper may be jammed in the upper part where it is difficult to see. Check thoroughly for 
jammed paper.

• If the paper tears, check to make sure there are no remaining shreds in the device.

3. Close the left side cover [B] gently.

Paper Jams in Trays 1 and 2

Follow the steps below to clear paper jams in Trays 1 and 2.

1. Remove the jammed paper by referring to the following:

– Tray 1: Paper Jam in Left Side Cover [A] on page 288
Xerox® DocuCentre® SC2020
User Guide

290



Problem Solving
– Tray 2 (optional): Paper Jam in Left Side Cover [B] on page 290

2. If the jammed paper cannot be removed, pull out the tray.

Pulling out a tray after a paper jam without checking where the jam is located may cause the paper to 
tear and leave shreds inside the device. To prevent equipment failure, check the location of paper jams 
on the display before attempting to clear them.

3. Remove the jammed paper.

Note: If the paper tears, check to make sure there are no remaining shreds in the device.

4. Push the tray in gently until it stops.
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Paper Jams in Tray 5 (bypass)

Follow the steps below to clear a paper jam in the Tray 5 (bypass).

1. Inspect the inside (around the paper feed entrance) of the Tray 5 (bypass), and remove the jammed 
paper.

If multiple sheets of paper were loaded, remove all the paper while you clear the jam.

Note: If the paper tears, check to make sure there are no remaining shreds in the device.

2. If multiple sheets of paper were loaded, align the corners of the removed paper.

3. Insert the paper with the side to print on facing down, aligning it so that its leading edge lightly 
contacts the paper feed entrance.

Document Jams

Follow the steps below to remove the jammed document in the document feeder.

1. Pull up the front handle of the document feeder top cover, and open the document feeder top cover 
completely.

Note: The cover will remain fixed in position when fully opened. Open the cover slowly.
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2. If the document has not yet been fed into the feeder, remove it.

3. If the displayed message tells you to turn the knob, turn the knob to feed the document to the top, 
then remove it.

If the document has been fed into the feeder, do not pull it out directly. The document may tear.

4. If the displayed message tells you to open the inner cover, lift up the handle to open the inner cover.

5. Turn the knob to feed the document to the top, then remove it.

Note: If the document has been fed into the feeder, do not pull it out directly. The document may 
tear.

6. Close the document feeder's inner cover.

Handle
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7. Close the document feeder top cover until it clicks into place, and confirm that there is no space 
between the near or far side of the cover and the document feeder.

8. If you cannot find the document, carefully lift up the document feeder. If you find the document, 
remove it, and then close the document feeder.

9. If you cannot find the document in Step 8, lift up the document feeder tray and remove the 
document.

10. Carefully move the document feeder tray back into position.

11. Ensure that the document is not torn, wrinkled, or folded, and then reload the documents to complete 
the job.

After removing the jammed document:

– Copy:

Place the unscanned document again including the jammed pages.

– Scan (Email/PC(Network)):

Place the entire document again.

If the scanned data is already sent, place the unscanned document again including the jammed 
pages.

– Scan (TWAIN/WIA(Windows Image Acquisition)):

Place the unscanned document again including the jammed pages.

– Fax:

Place the entire document again.

Note: Torn, wrinkled or folded document pages can cause document jams, or damage. Always copy 
torn, wrinkled, or folded documents by placing them directly on the document glass.
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Getting Help
Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

Control Panel Messages

The control panel provides you with information and troubleshooting help. When an error or warning 
condition occurs, the control panel displays a message informing you of the problem.

For more information, refer to Error Code on page 277.

Obtaining the Product Information

Obtaining the Latest Print Driver

The latest print driver can be obtained by downloading it from our official website.

The following procedure uses the PCL 6 driver as an example.

Note: The communication fee shall be borne by users.

1. In the print driver [Printing Preferences] dialog box, select the [Advanced] tab and then click [About].

2. Click [Xerox Web Site].

Your web browser launches and our official website is displayed.

3. Follow the instructions on the website and download an appropriate print driver.

Notes:

• To locate the print driver for this product, go to www.xerox.com/drivers.

• For the latest information about the print driver features, refer to the Help provided for the 
print driver.

Non-Genuine Mode
When toner within a toner cartridge is empty, the [Out of Toner] message appears.

When you want to use the device in Non-Genuine mode, program the mode and replace the toner 
cartridge.

If you use the device in the Non-Genuine mode, the performance of the device may not be at its optimum. 
And any problems that may arise from the use of the Non-Genuine mode are not covered by our quality 
guarantee. The continuous use of the Non-Genuine mode can also cause the device to break down, and 
any repair charges for such break down will be incurred by users.

Note: Before starting the operation described below, confirm that [Ready] is displayed on the LCD 
panel.

1. Press the <Machine Status> button.
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2. Select the [Tools] tab.

3. Select [Admin Settings].

4. Select [Maintenance].

5. Select [Non-Genuine Toner].

6. Select [On], and then select [OK].

The device switches to the Non-Genuine mode.
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Appendix

This chapter describes the device specifications, optional components, and notes and restrictions.

Specifications
This section lists the main specifications of the device. Note that the specifications and the appearance of 
the product may change without prior notice.

Basic Functions/Copy Functions

Type Desktop

Memory 512 MB

Hard Disk -

Color Capability Full Color

Scanning Resolution 600 x 600 dpi

Printing Resolution Output resolution: 1200 x 2400 dpi
Data processing resolution: 600 x 600 dpi

Halftone 256 halftones for each color (16,700,000 colors)

Warm-up Time 39 seconds or less
At room temperature, 20°C

Original Paper Size The maximum size is 297 x 432 mm (A3, 11 x 17") for both sheets and 
books.

Output Paper Size Maximum: A3, 11 x 17"
Minimum:Tray 1: A5
Tray 2 (optional): A5
Tray 5 (bypass): A5 (Non-standard size: 89 × 98 mm) 
Image loss width: 5.5 mm max. at top, bottom, right, and left.
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Output Paper Weight Tray 1: 60–90 g/m²
Tray 2 (optional): 60–256 g/m²
Tray 5 (bypass): 60–216 g/m²

Note: Use paper recommended by Xerox. Copying may not be performed 
correctly depending on the conditions.

First Copy Output Time <When the document glass is used>

Monochrome: 8.6 seconds (A4 /monochrome priority mode)

Color:                10.8 seconds (A4 /color priority mode)

Note: The values may vary depending on the device configuration.

<When the document feeder is used>

Monochrome: 10.6 seconds (A4 /monochrome priority mode)

Color:                13.6 seconds (A4 /color priority mode)

Note: The values may vary depending on the device configuration.

Reduction/Enlargemen
t

Size-for-Size  1:1 ± 0.7%
Preset %50%, 70%, 81%, 86%, 115%, 122%, 141%, 200%
Variable %25–400% (1% increments)
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Continuous Copy 
Speed

Paper Trays 1 and 2 (optional): Continuous 1-Sided copy/same 
magnification 
                                                             Monochrome                       Color

A4 :                                    20 sheets /minute         20 sheets /minute

B5 /B5 /A4 /B4/A3:         12 sheets /minute          12 sheets /minute 

Paper Trays 1 and 2 (optional): Continuous 2-Sided copy/same 
magnification
                                                             Monochrome                       Color

A4 :                                    17 pages /minute        17 pages /minute

B5 /B5 /A4 /B4/A3:         8.5 pages /minute        8.5 pages /minute 

Paper Tray 5: Continuous 1-Sided copy/same magnification
                                                             Monochrome                       Color

A4 :                                    20 sheets /minute        20 sheets /minute

B5 /B5 /A4 /B4/A3:         12 sheets /minute        12 sheets /minute 

Paper Tray 5: Continuous 2-Sided copy/same magnification
                                                             Monochrome                       Color

A4 :                                    17 pages/minute        17 pages /minute

B5 /B5 /A4 /B4/A3:         8.7 pages /minute        8.7 pages /minute 
The speed may be reduced due to image quality adjustment.

Note: These are the speeds used for Bond, Plain, and Recycled paper. Print 
performance can be varied depending on the type of paper used. 

Paper Tray Capacity Standard: 350 sheets (Tray 1 (250 sheets*1) + Tray 5 (bypass) 2/22/16                       

(100 sheets *2))

Optional:500 sheets*1 (One Tray Module) 
Maximum Paper Capacity: 850 sheets (Standard + One Tray Module)
*1: When using 80 g/m² paper

Note: *2: When using Xerox standard paper

Continuous Copy 999 sheets

Output Tray Capacity 250 sheets (A4 )
When using 80 g/m² paper

Power Supply AC 220–240 V ±10%, 5 A, 50/60 Hz ±3%

Power Consumption 220 V: 1.1 kW or less
240 V: 1.2 kW or less
Low Power mode: 46 W
Sleep mode: 1.4 W
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Print Functions

Dimensions Width 595 × Depth 586 x Height 549 mm (with platen cover)
Width 595 × Depth 586 x Height 634 mm (with document feeder)

Device Weight 43 kg (with platen cover)
49 kg (with document feeder + Duplex Output Unit)
Toner cartridge is not included.

Space Requirement Width 947 × Depth 586 mm (with platen cover)
Width 972 × Depth 586 mm (with document feeder + Duplex Output Unit)
When the Tray 5 (bypass) is fully extended.

Type Built-in

Output Paper Size Same as the Basic Functions/Copy Functions

Continuous Print Speed Same as the Basic Functions/Copy Functions
The speed may be reduced due to image quality adjustment. Print speed 
may also drop depending on the document.

Print Resolution Output resolution: 1200 x 2400 dpi
Data processing resolution: 600 x 600 dpi for Standard and High Quality

PDL PCL6/5e, HBPL

Protocol Network connection: TCP/IP (lpd, IPP/IPPS, Port9100, SMB, WSD*)
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Operating System Microsoft® Windows Vista®

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x86

Microsoft® Windows Server® 2008 x64 Edition

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x86

Microsoft® Windows® 7 x64

Microsoft® Windows® 8 x86

Microsoft® Windows® 8 x64

Microsoft® Windows Server® 2012 x64

Microsoft® Windows Server® 2012 R2 x64

Microsoft® Windows® 8.1 x86

Microsoft® Windows® 8.1 x64

Microsoft® Windows® 10 x86

Microsoft® Windows® 10 x64
Mac OS X 10.5–10.11

Note: For information about the latest supported OS, refer to our official 
website.

Fonts PCL6/5: 81 European fonts, 36 Symbol set

Connectivity Ethernet 100BASE-TX/10BASE-T, USB 2.0
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WSD stands for Web Services on Devices.

Scan Functions (Local)

Notes:

• *1 The scanning speed varies depending on documents.

• *2 WIA stands for Windows Image Acquisition.

Type Color Scanner

Original Paper Size Same as the Basic Functions/Copy Functions

Scanning Resolution TWAIN:monochrome and grayscale: 600 x 600 dpi, 400 x 400 
dpi,2/22/16300 x 300 dpi, 200 x 200 dpi, 150 x 150 dpi2/22/16color: 
400 x 400 dpi, 300 x 300 dpi, 200 x 200 dpi, 150 x 150 dpi

WIA*2: color, grayscale, and monochrome: 400 x 400 dpi, 2/22/16300 x 
300 dpi, 200 x 200 dpi, 150 x 150 dpi

Scanning Speed*1 Monochrome:24 sheets/minute
Color: 19 sheets/minute

Xerox Standard Document (A4 ), at 200 dpi

Connectivity Ethernet 100BASE-TX/10BASE-T, USB 2.0

Scan to PC 
(TWAIN/WIA
*2: USB)

Driver TWAIN/WIA*2

Operating 

System*3
Microsoft® Windows Vista®

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x86

Microsoft® Windows Server® 2008 x64 Edition

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x86

Microsoft® Windows® 7 x64

Microsoft® Windows® 8 x86

Microsoft® Windows® 8 x64

Microsoft® Windows Server® 2012 x64

Microsoft® Windows Server® 2012 R2 x64

Microsoft® Windows® 8.1 x86

Microsoft® Windows® 8.1 x64

Microsoft® Windows® 10 x86

Microsoft® Windows® 10 x64

Note: For information about the latest supported OS, refer to our official 
website.
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• *3 Please refer to our official website for the latest support operating systems.
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Scan Functions (Network)

Notes:

• *1 The scanning speed varies depending on documents.

Type Color Scanner

Original Paper Size Same as the Basic Functions/Copy Functions

Scanning Resolution monochrome and grayscale: 600 x 600 dpi, 400 x 400 dpi, 300 x 300 dpi, 
200 x 200 dpi, 150 x 150 dpi
color: 400 x 400 dpi, 300 x 300 dpi, 200 x 200 dpi, 150 x 150 dpi

Scanning Speed*1 Monochrome:24 sheets/minute
Color: 19 sheets/minute

Xerox Standard Document (A4 ), at 200 dpi

Connectivity Standard: Ethernet 100BASE-TX/10BASE-T

Scan to PC 
(Network: 
Push 
Scanning)

Protocol TCP/IP (SMB, FTP, WSD*2)

Operating 

Systems*3
Microsoft® Windows Vista®

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x86

Microsoft® Windows Server® 2008 x64 Edition

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x86

Microsoft® Windows® 7 x64

Microsoft® Windows® 8 x86

Microsoft® Windows® 8 x64

Microsoft® Windows Server® 2012 x64

Microsoft® Windows Server® 2012 R2 x64

Microsoft® Windows® 8.1 x86

Microsoft® Windows® 8.1 x64

Microsoft® Windows® 10 x86

Microsoft® Windows® 10 x64
Mac OS X 10.6–10.11

Note: For information about the latest supported OS, refer to our official 
website.

File Format Monochrome binary: TIFF/DocuWorks/PDF
Color: TIFF/JPEG/DocuWorks/PDF 

Scan to 
email

Protocol TCP/IP (SMTP Authentication)

File Format Monochrome binary: TIFF/DocuWorks/PDF
Color: TIFF/JPEG/DocuWorks/PDF 
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• *2 WSD stands for Web Services on Devices.

• *3 Please refer to our official website for the latest support operating systems.

Fax Functions (Optional)

Direct Fax Functions (Optional)

Send Document Size Maximum:A3, 11 x 17"

Recording Paper Size Maximum:A3, 11 x 17"
Minimum:A5

Transmission Time Under 3 seconds

Note: When transmitting an A4 size 700-character document in the 
standard quality (8 × 3.85 lines/mm) and high speed mode (28.8 kbps or 
above: JBIG). This is only the transmission speed for image information and 
does not include the controlling time for the communication. Note that the 
actual transmission time depends on the content of documents, the device 
that the recipient uses, and the status of the communication line.

Transmission Mode G3

Scanning Resolution Standard:  8 x 3.85 lines/mm, 200 x 100 dpi (7.9 x 3.9 dots/mm)
Fine/Photo:  8 x 7.7 lines/mm, 200 x 200 dpi (7.9 x 7.9 dots/mm)
Super-fine (400 dpi): 16 x 15.4 lines/mm, 400 x 400 dpi (15.7 x 15.7 
dots/mm)

Coding Methods MH, MR, MMR, JBIG

Transmission Speed G3: 33.6/31.2/28.8/26.4/24.0/21.6/19.2/16.8/14.4/12.0/9.6/7.2/4.8/2.4 
kbps

No. of Fax Lines Telephone subscriber line, PBX, facsimile communication network (PSTN), 
Max. 1 port (G3-1 port)

Send Document Size A3, B4, A4

Scanning Resolution Same as the Fax Functions

Transmission Speed Same as the Fax Functions

No. of Fax Lines Same as the Fax Functions
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Please refer to our official website for the latest support operating systems.

Duplex Output Unit

Duplex Automatic Document Feeder

Operating System Microsoft® Windows Vista®

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x86

Microsoft® Windows Server® 2008 x64 Edition

Microsoft® Windows Server® 2008 R2 x64

Microsoft® Windows® 7 x86

Microsoft® Windows® 7 x64

Microsoft® Windows® 8 x86

Microsoft® Windows® 8 x64

Microsoft® Windows Server® 2012 x64

Microsoft® Windows Server® 2012 R2 x64

Microsoft® Windows® 8.1 x86

Microsoft® Windows® 8.1 x64

Microsoft® Windows® 10 x86

Microsoft® Windows® 10 x64

Note: For information about the latest supported OS, refer to our official 
website.

Paper Size Same as the Basic Functions/Copy Functions

Paper Weight 60–169 g/m²

Type Duplex Automatic Document Feeder

Original Paper Size Maximum:A3, 11 x 17"
Minimum:A5 (Non-standard size: 125 × 125 mm)
38–128 g/m² (2-Sided: 50–128 g/m²)

Capacity 110 sheets

Note: When using 80 g/m² paper.

Feeding Speed Monochrome:20 sheets/minute (A4 , 1-Sided), 
13 pages/minute (A4 , 2-Sided)

Color              : 18 sheets/minute (A4 , 1-Sided), 
11 pages/minute (A4 , 2-Sided)
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One Tray Module (Optional)

Printable Area
The standard printable area is the area of the page within 5.5 mm from the top, bottom, left and right 
edges of the paper. The actual printable area may vary depending on the printer (plotter) and control 
language.

Optional Components
The following table shows the optional components available. To purchase these options, contact our 
Customer Support Center.

Dimensions Width 540 × Depth 492 × Height 119 mm

Weight 7 kg

Paper Size Same as the Basic Functions/Copy Functions

Paper Weight 60-256 g/m²

Capacity 500 sheets x 1 tray

Note: When using 80 g/m² paper.

Dimensions Width 541 × Depth 586 × Height 113 mm

Weight 11 kg

5.5 mm5.5 mm

5.5 mm

5.5 mm

Paper feed 
direction

Unprintable area

Printable area
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Notes:

• The optional components are subject to change without notice.

• For the latest information, contact our Customer Support Center.

Notes and Restrictions
This section describes the notes and restrictions to observe when using the device.

Notes and Restrictions on the Use of the Device
• Notes on Switching Off the Power

After the power is switched off, the device performs internal power off processes for a while. After 
turning the power off, turning it on again before the screen display has disappeared will not start the 
device right away. Before turning the power on, check that the operation screen display has 
disappeared.

• Installing and Moving the Device

• Contact our Customer Support Center or a Customer Engineer before moving the device.

• Do not subject the device to shocks while it is in operation.

• Take care not to get fingers caught when closing the document cover.

• Do not place any objects near the ventilation openings of the device's exhaust fan.

• Character Codes

In data transmission from a computer, if characters that the device does not support are included in 
the file names, these characters may not be displayed correctly. Only ASCII characters can be used.

• Hard Disk

You cannot install a hard disk into this product.

• Job History Report

If the output file name includes characters other than alphanumeric, it is not displayed correctly on 
the Job History Report.

• Document Feeder

The device does not detect a document placed in the document feeder during Sleep mode.

Product Name Description

Fax Kit Adds the Fax feature to the device.

One Tray Module A tray that can load 500 sheets of paper (when using 80 g/m² paper).

Stand (Cabinet) Cabinet for storage purposes. This can be added when One Tray Module is 
fitted.

Tray Lock Locks the trays on the device.
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• Paper Setting

When paper jam occurs at a tray, reduce the sheets of paper in the tray.

• Management

Auditron is effective only for copy and print jobs. It does not control scan or fax jobs.

• <Data> LED

When the device has entered the Power Saver mode, the <Data> LED is extinguished even when a 
received or pending fax job remains in the device. The <Data> LED does not light up in the Power 
Saver mode even when the device receives a print job.

• Image Quality

• When the default for [Output Color] is set to [Black & White], the color density of the first color output 
image after the device is turned on may be slightly deteriorated. Use the automatic calibration 
function.

• Right after the drum cartridge or toner cartridge is replaced, the image quality may be poor. Also, if 
the toner level is low, the output image quality may be poor.

Notes and Restrictions on the Use of the Copy Feature
• ID Card Copy

The front and back side of the placed ID card are printed on each half sheet of a paper in center 
except the following cases:

• When the size of ID card is larger than the standard printable size of the ID Card Copy feature, a part 
of the image may be cut off.

• The edges of the ID card may be cut off due to the edge erase.

• About Memory

If the device memory capacity becomes insufficient when copying using the collated feature, it 
outputs only the document data which is being scanned.

• Image quality

This device reads documents using a CIS sensor. There are some pixels that cannot be read by the CIS 
sensor for structural reasons. In the following documents, the lines in the vertical direction may appear 
spaced about 18 mm apart.

• Documents with uniform concentration

• Documents with gradation

• Documents with fine lines that repeat periodically

In this case, either [Soften] the sharpness or set the image quality of the document to [Photo] and 
then adjust the image quality.

Notes and Restrictions on the Use of the Scan Feature

This section describes notes and restrictions to observe when using the Scan feature.

For the notes and restrictions on the scan driver, see the "Readme" information on the CD-ROM for the 
Driver CD Kit that came with the device.

•  Address Book
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• When registering addresses using CentreWare Internet Services, we recommend using an Ethernet 
crossover cable to connect the device to your computer to protect your email address might be 
intercepted on the network since the device does not support SSL.

• 2-byte UTF-8 is supported for the Server Path and the Share Name of the SMB server, and names to be 
registered in the address book. However, the languages except Korean and Simplified Chinese cannot 
be displayed on the device display.

Notes and Restrictions on the Use of the Print Feature
• Meter Counts

The number of pages printed in the following cases is counted by the meter.

• When printing a 2 sided print job, depending on the application being used, blank sheets can be 
inserted automatically to adjust pages. 

• Even if the print driver is configured to skip blank pages, the blank pages with white characters, 
newline characters and space characters will be printed.

• Paper Orientation for Mac OS

When using Mac OS X, place the paper in landscape orientation in the device regardless of the 
orientation of the image on the document. 

• Image Quality

If the output image quality is poor, changing the image quality settings on the print driver can solve 
the problem.

• Consumption of color toner

• If the color mode of the print driver is set to [Color (Auto)], the color toner may be consumed even 
when printing in black and white.

• If a color image with a high overall concentration is printed out continuously, a message urging you to 
replace the toner cartridge may be displayed even if there is still toner left. In this case, open and close 
the front cover of this device and check one more time if the message is still displayed.
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Numerics
2-Sided Copying, 197
2-Sided Print, 156, 171
2-Sided Scanning, 104
802.1x, 164

A
about license, 20
Address Book Editor, 39, 138
Adjust 2nd BTR, 184
Adjust Altitude, 187
Adjust PaperType, 184
Adjust TouchScreen, 188
Adjust Transfer Belt Unit, 184
Admin Settings, 154
Advanced Scanner Settings, 145
Advanced Settings, 164
Audio, 177
Auditron, 50
Auto Answer Setup, 168
Auto Background Suppression, 195
Auto Background Suppression Level, 196
Auto Color To Mono Print, 183
Auto Job History, 179
Auto Redial Setup, 171
automatic paper selection, 61
Available characters, 52

B
Banner Sheet, 182
Billing Meters, 153
Bonjour, 36

C
C Clear button, 49
canceling a job, 144
capacity, 307, 308
CentreWare Internet Services, 136
Changing numbers, 53
changing paper size in Trays 1 and 2, 64
checking consumables, 228
checking the meter, 231
Clear All button, 49
Clear Job History, 188
coding methods, 306
Collation, 192
Color Balance, 196
Company Name, 165
Confirm Recipients, 190
Connection Speed, 162
connectivity, 302, 303, 305
continuous copy, 300
continuous copy speed, 300
continuous print speed, 301
control panel, 42, 180

D
Data LED, 49
Default Paper Size, 181
Default Settings, 191
Demo Page, 153, 232
device components, 42
device weight, 301
dimensions, 301
dimensions/weight, 308
Direct Fax, 111
Disabling the Panel Lock, 218
Discard Size, 171
Display Brightness, 176
Display Manual Fax Recipients, 173
Display Network Information, 190
document feeder, 68, 92, 124
Document feeder top cover, 45
document feeder tray, 45
document glass, 42, 70, 94, 126
document glass cover, 42
document guides, 45, 70, 94, 126
document output tray, 45
document stopper, 45, 70, 94, 126
Domain Filtering, 190
Draft Mode, 159
DRPD mode, 115
DRPD Pattern, 166
duplex automatic document feeder, 45, 307
duplex output unit, 307

E
ECM, 173
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Edge Erase, 198
Edit Email From Field, 190
Email Address Book, 153, 233
Enabling the Panel Lock, 216
Error History, 153, 232
Error LED, 49
Ethernet, 161
Ethernet Port, 43
exiting power saver mode, 48
Extel Hook Threshold, 167
extension tray, 63

F
Fault Timeout, 180
Fax Activity, 153, 174, 233
fax activity report, 120
Fax Address Book, 153, 154, 232
Fax Broadcast, 174
Fax Cover Page, 172
fax kit, 309
FAX Mode, 114
Fax Pending, 153, 233
Fax Protocol, 174
Fax Settings, 165
Fax Transmit, 174
feeding speed, 307
first copy output time, 299
Font, 157
Font Pitch, 158
Font Size, 158
Form Line, 158
Forward Settings, 170
front cover, 43
FTP, 36
fusing unit, 45

G
Groups, 154

H
halftone, 298
hard disk, 298
Hex Dump, 159

I
ID Card Copy, 75
Ignore Form Feed, 160
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Image Enhance, 159
Individuals, 154
Initialize NVM, 186
Initialize Print Meter, 187
inner cover, 45
installing the print driver, 39
installing the scan driver, 39
IP Filter, 164
IP Mode, 161
IPP, 36
IPsec, 162

J
Job History, 153, 232
Job Status button, 49, 234, 235

L
Landscape, 156
Language Settings, 213
Left side cover A, 43
Left side cover B, 43
Letterhead 2-Sided, 182
Lighten/Darken, 195
LINE 1, 44
Line Monitor, 166
Line Termination, 160
Line Type, 165
loading paper in Trays 1 and 2, 61
loading paper into the Bypass tray, 63
Login Attempts, 191
low power mode, 47
Low Toner Alert Message, 178
LPD, 36

M
Machine Status button, 49
Maintenance, 184
Managing the Machine, 251
Max Email Size, 180
maximum fill line, 63, 64
Measurements, 176
memory, 117, 298

N
narrow glass strip, 45
Network Setup, 161
No Account User Print, 183



No. of fax lines, 306
Non-Genuine Toner, 187
notes and restrictions, 309
numeric keypad, 48

O
OffHook Wake Up, 179
one tray module, 43, 308
OnHook, 103
operating system, 302
Operations during Scanning, 144
optional components, 308
original paper size, 298, 303, 305, 307
Original Size, 193
Original Type, 194
Output Color, 160, 191
output paper size, 298, 301
output paper weight, 299
Output Settings, 181
Output Size, 155
output tray capacity, 300

P
Pages Per Side, 198
Panel Language, 213
Panel Lock, 188
Panel Lock Function, 216
Panel Settings, 152, 232
paper guides, 64
paper size, 307, 308
Paper Tray, 154
paper tray capacity, 300
paper weight, 307
PCL Fonts List, 152, 232
PCL Settings, 154
PDL, 301
Port9100, 36
Portrait, 156
power consumption, 300
power cord connector, 44
Power on Wizard, 180
Power Saver, 223
Power Saver button, 49
power supply, 300
power switch, 43
Prefix Dial, 172
Print ID, 181
print resolution, 301
Print Text, 181
printable area, 308
Printer Meter, 153, 232
printing, 148
printing resolution, 298
problem solving, 256
protocol, 301
Protocol Monitor, 153, 232

Q
Quantity, 159
Quick Density Adjust, 186

R
Receive Mode, 168
Receiving a fax, 114
Receiving modes, 114
recording paper size, 306
Redial/Pause button, 49
Reduce/Enlarge, 192
reduction/enlargement, 299
Registering a new email address, 142
replacing a toner cartridge, 237
replacing consumables, 236
Report 2-Sided Print, 183
Report/List, 152
Reset Network Setup, 164
Resetting to Factory Defaults, 226
Right top tray, 43
Ring Tone Volume, 168

S
Saturation, 195
scan to email, 305
scan to PC, 303, 305
Scanning from the control panel, 128
scanning resolution, 298, 303, 305, 306
scanning speed, 303, 305
Scanning using the TWAIN driver, 129
Scanning using the WIA driver, 130
Secure Settings, 188
Select Tray, 191
semi standard paper, 58
send document size, 306
Send Header, 173
Sending a delayed fax, 109
Sending a fax from the driver (Direct Fax), 111
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Sending an email with the scanned file, 143
Sending an e-mail with the scanned image, 141
Sending the Scanned File on the Network, 141
Server Address, 153, 233
Service Lock, 188
Sharpness, 195
sleep mode, 47
SNMP, 36
SNTP, 36
Software Download, 190
space requirement, 301
Stand (Cabinet), 309
standard paper, 58
Start button, 49
Status Messenger, 36, 252
Stop button, 49
storing and handling paper, 60
Substitute Tray, 182
Supplies, 228
Symbol Set, 158
System Settings, 152, 175, 232

T
TEL, 44
TEL/FAX Mode, 115
Telnet, 36
Timers, 180
toner cartridge, 44
Touch Screen, 48
transmission mode, 306
transmission speed, 306
transmission time, 306
Tray 1, 43, 209
Tray 2, 43, 210
Tray 5 (Bypass), 43
tray lock, 309
Tray Management, 206
Tray Settings, 206
troubleshooting, 256
turning the power off, 46
turning the power on, 45
TWAIN, 129

U
unable to copy, 267
unable to print, 270
uninstalling, 40
unusable paper, 60
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Update Address Book, 36
usable paper, 59
USB Port, 43
Using a scanner on the network, 131
using the Ethernet interface, 29
Using the number pad, 52
using the USB interface, 28

W
warm-up time, 298
WSD Print, 36
WSD Scan, 36, 128
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